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Preface

Thanks for buying my book. If you're interested in developing killer formulas and
taking Excel to a new level, this book is as good as it gets. 'm confident that you’'ll
agree that your money was invested wisely.

Why 1 Wrote This Book

I approached this project with one goal in mind: To write the ultimate Excel book
that would appeal to a broad base of users. That’s a fairly ambitious goal. But based
on the feedback I received from the first edition, I think I've accomplished it.

I've been using Excel for nearly a decade and I spend a lot of time participating
in the Excel newsgroups on the Internet. As a result, 'm very familiar with the
types of questions that come up time and time again. Much of the material in this
book was inspired by questions on the Excel newsgroups. This book provides the
answers to those questions — along with answers to questions that probably never
occurred to you!

As you probably know, most bookstores offer dozens of Excel books. The vast
majority of these books are general-purpose user guides that explain how to use the
features available in Excel (often by simply rewording the text in the help files). A
few others focus on advanced issues such as macro programming or scientific
applications. None (that’s right, none!) hones in on the one fundamental compo-
nent of Excel that is critically important to every user: formulas. Fact is, formulas
are what make a spreadsheet a spreadsheet. The more you know about formulas, the
better your spreadsheets will be. It’s that simple.

Excel is the spreadsheet market leader, by a long shot. This is the case not only
because of Microsoft’s enormous marketing clout but also because it is truly the
best spreadsheet available. One area in which Excel’s superiority is most apparent is
formulas. Excel has some special tricks up its sleeve in the formulas department. As
you'll see, Excel lets you do things with formulas that are impossible with other
spreadsheets.

It’s a safe bet that only about ten percent of Excel users really understand how
to get the most out of worksheet formulas. In this book, I attempt to nudge you into
that elite group. Are you up to it?

What You Should Know

This is not a book for beginning Excel users. If you have absolutely no experience
with Excel, this may not be the best book for you—unless you're one of a rare
breed who can learn a new software product almost instantaneously.
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To get the most out of this book, you should have some background using Excel.
Specifically, I assume that you know how to
Create workbooks, insert sheets, save files, and other basic tasks
Navigate through a workbook

Use Excel’s menus, toolbars, and dialog boxes

* 6 o o

Use basic Windows features, such as file management and copy and paste
techniques

If you're an experienced spreadsheet user, but you are new to Excel, Chap-
ter 1 presents a concise overview of what this product has to offer.

What You Should Have

To make the best use of this book, you need a copy of Microsoft Excel. When I
wrote the current edition of the book, I was using Excel 2002 (which is part of
Microsoft Office XP). With a few exceptions (noted in the text), the material in this
book also applies to all earlier versions of Excel that are still in use.

To use the examples on the companion CD-ROM, you’ll need a CD-ROM drive.
Duh! The examples on the CD-ROM are discussed further in the “About the
Companion CD-ROM” section, later in this preface.

o

| use Excel for Windows exclusively, and do not own a Macintosh. Therefore,
| can't guarantee that all of the examples will work with Excel for Macintosh.

Excel’s cross-platform compatibility is pretty good, but it's definitely not
perfect.

As far as hardware goes, the faster the better. And, of course, the more memory
in your system, the happier you'll be. And, I strongly recommend using a high-
resolution video mode: at least 1024 x 768.

Conventions in This Book

Take a minute to skim this section and learn some of the typographic conventions
used throughout this book.
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Keyboard Conventions

You need to use the keyboard to enter formulas. In addition, you can work with
menus and dialog boxes directly from the keyboard — a method you may find eas-
ier if your hands are already positioned over the keys.

FORMULA LISTINGS

Formulas usually appear on a separate line in monospace font. For example, I may
list the following formula:

=VLOOKUP(StockNumber,PricelList,2,False)

Excel supports a special type of formula known as an array formula. When you
enter an array formula, press Ctrl+Shift+Enter (not just Enter). Excel encloses an
array formula in brackets in order to remind you that it’s an array formula. When I
list an array formula, I include the brackets to make it clear that it is, in fact, an
array formula. For example:

{=SUM(LEN(AL:A10))}

ol

VBA CODE LISTINGS

This book also contains examples of VBA code. Each listing appears in a mono-
space font; each line of code occupies a separate line. To make the code easier to
read, I usually use one or more tabs to create indentations. Indentation is optional,
but it does help to delineate statements that go together.

If a line of code doesn’t fit on a single line in this book, I use the standard VBA
line continuation sequence: a space followed by an underscore character. This indi-
cates that the line of code extends to the next line. For example, the following two
lines comprise a single VBA statement:

Do not type the brackets for an array formula. Excel will put them in
automatically.

If Right(cell.Value, 1) = "!I" Then cell.Value _
= Left(cell.Value, Len(cell.Value) - 1)

You can enter this code either exactly as shown on two lines, or on a single line
without the trailing underscore character.
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KEY NAMES

Names of keys on the keyboard appear in normal type, for example Alt, Home,
PgDn, and Ctrl. When you should press two keys simultaneously, the keys are con-
nected with a plus sign: “Press Ctrl+G to display the Go To dialog box.”

FUNCTIONS, PROCEDURES, AND NAMED RANGES
Excel’s worksheet functions appear in all uppercase, like so: “Use the SUM function
to add the values in column A.”

Macro and procedure names appear in normal type: “Execute the InsertTotals
procedure.” I often use mixed upper- and lowercase to make these names easier to
read. Named ranges appear in italic: “Select the InputArea range.”

Unless you're dealing with text inside of quotation marks, Excel is not sensitive
to case. In other words, both of the following formulas produce the same result:

=SUM(A1:A50)
=sum(al:a50)

Excel, however, will convert the characters in the second formula to uppercase.

Mouse Conventions

The mouse terminology in this book is all standard fare: “pointing,
“right-clicking,” “dragging,” and so on. You know the drill.

What the lcons Mean

Throughout the book, icons appear in the left margin to call your attention to
points that are particularly important.

”

clicking,”

F This icon indicates a feature new to Excel 2002.

I use Note icons to tell you that something is important — perhaps a con-

cept that may help you master the task at hand or something fundamental
for understanding subsequent material.

Tip icons indicate a more efficient way of doing something, or a technique
that may not be obvious. These will often impress your officemates.
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These icons indicate that an example file is on the companion CD-ROM.
(See the upcoming “About the Companion CD-ROM” section.)

| use Caution icons when the operation that I'm describing can cause prob-
lems if you're not careful.

| use the Cross Reference icon to refer you to other chapters that have more
to say on a particular topic.

How This Book Is Organized

There are hundreds of ways to organize this material, but I settled on a scheme that
divides the book into five main parts. In addition, I've included a few appendixes
that provide supplemental information that you may find helpful.

Part 1: Basic Information

This part is introductory in nature, and consists of Chapters 1 through 3. Chapter 1
sets the stage with a quick and dirty overview of Excel. This chapter is designed for
readers who are new to Excel, but who have used other spreadsheet products. In
Chapter 2, I cover the basics of formulas. This chapter is absolutely essential read-
ing in order to get the most out of this book. Chapter 3 deals with names. If you
thought names were just for cells and ranges, you’ll see that you're missing out on
quite a bit.

Part 11: Using Functions in Your Formulas

This part consists of Chapters 4 through 10. Chapter 4 covers the basics of using
worksheet functions in your formulas. I get more specific in subsequent chapters.
Chapter 5 deals with manipulating text, Chapter 6 covers dates and times, and
Chapter 7 explores various counting techniques. In Chapter 8, I discuss various types
of lookup formulas. Chapter 9 deals with databases and lists, and Chapter 10 covers
a variety of miscellaneous calculations such as unit conversions and rounding,.
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Part 111: Financial Formulas

Part III consists of three chapters (Chapters 11 through 13) that deal with creating
financial formulas. You'll find lots of useful formulas that you can adapt to your
needs.

ol

Part 1V: Array Formulas

This part consists of Chapters 14 and 15. The majority of Excel users know little or
nothing about array formulas —a topic that happens to be dear to me. Therefore I
devote an entire part to this little-used yet extremely powerful feature.

Most of the material in Chapters 11 through 13 was contributed by Norman
Harker. Norman is a Senior Lecturer in Real Estate at the University of
Western Sydney (Australia).

Part V: Miscellaneous Formula Techniques

This part consists of Chapters 16 through 21. They cover a variety of topics — some
of which, on the surface, may appear to have nothing to do with formulas. Chapter
16 demonstrates that a circular reference can be a good thing. In Chapter 17, you’ll
see why formulas can be important when you work with charts, and Chapter 18
covers formulas as they relate to pivot tables. Chapter 19 contains some very inter-
esting (and useful) formulas that you can use in conjunction with Excel’s condi-
tional formatting and data validation features. Chapter 20 covers a topic that I call
“megaformulas.” A megaformula is a huge formula that takes the place of several
intermediary formulas. And what do you do when your formulas don’t work cor-
rectly? Consult Chapter 21 for some debugging techniques.

Part VI: Developing Custom Worksheet Functions

This part consists of Chapters 22 through 25. This is the part that explores Visual
Basic for Applications (VBA), the key to creating custom worksheet functions.
Chapter 22 introduces VBA and the VB Editor, and Chapter 23 provides some nec-
essary background on custom worksheet functions. Chapter 24 covers program-
ming concepts, and Chapter 25 provides a slew of worksheet function examples
that you can use as-is or customize for your own needs.

Appendixes

What'’s a computer book without appendixes? This book has five appendixes. In the
appendixes, you'll find secrets about importing 1-2-3 files, a quick reference guide
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to Excel’s worksheet functions, tips on using custom number formats, and a handy
guide to Excel resources on the Internet. The final appendix describes all the files
on the CD-ROM.

How to Use This Book

You can use this book any way you please. If you choose to read it cover to cover
while lounging on a sunny beach in Maui, that’s fine with me. More likely, you’ll
want to keep it within arm’s reach while you toil away in your dimly lit cubicle.

Due to the nature of the subject matter, the chapter order is often immaterial.
Most readers will probably skip around, picking up useful tidbits here and there.
The material contains many examples, designed to help you identify a relevant for-
mula quickly. If you're faced with a challenging task, you may want to check the
index first to see whether the book specifically addresses your problem.

About the Companion CD-ROM

The inside back cover of this book contains a CD-ROM that consists of three basic
elements:

€ Example workbooks that demonstrate concepts presented in the text.
@ A trial copy of my Power Utility Pak 2000 add-in.

€ A demo copy of my Sound-Proof 2000 add-in. Sound-Proof is a handy
auditing tool that uses Microsoft Agent technology to read the contents of
cells. You may prefer this to Excel 2002’s text-to-speech feature.

The example workbook files on the companion CD-ROM are not compressed, so
you can access them directly from the CD (installation not required). Power Utility
Pak and Sound-Proof, however, do require installation. Refer to Appendix E for
details.

ol

All CD-ROM files are read-only.Therefore, if you open a file from the CD-ROM
and make any changes to it, you'll need to save it to your hard drive. Also, if
you copy a file from the CD-ROM to your hard drive, the file retains its read-
only attribute.To change this attribute after copying a file, right-click the file-

name or icon and select Properties from the shortcut menu. In the
Properties dialog box, click the General tab and remove the check mark from
the Read-only check box.
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About the Power Utility Pak Offer

Toward the back of the book, you'll find a coupon that you can redeem for a dis-
counted copy of my award-winning Power Utility Pak — a collection of useful Excel
utilities, plus many new worksheet functions. I developed this package using VBA
exclusively.

You can also use this coupon to purchase the complete VBA source code for a
nominal fee. Studying the code is an excellent way to pick up some useful pro-
gramming techniques. You can take the product for a test drive by installing the
shareware version from the companion CD-ROM.

bt

You can always download the most current version of the Power Utility Pak from
my Web site:

Power Utility Pak requires Excel 97 for Windows or later.

http://www.j-walk.com/ss

Reach Out

I'm always interested in getting feedback on my books. The best way to provide this
feedback is via email. Send your comments and suggestions to:

author@j-walk.com

Unfortunately, I'm not able to reply to specific questions. Posting your question
to one of the Excel newsgroups is, by far, the best way to get such assistance. See
Appendix D for specifics.

Also, when you're out surfing the Web, don’t overlook my Web site (“The
Spreadsheet Page”):
http://www.j-walk.com/ss/

Now, without further ado, it’s time to turn the page and expand your horizons.
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Chapter 1

Excel in a Nutshell

IN THIS CHAPTER

A brief history of Excel

The object model concept in Excel

The workings of workbooks

The user interface

The two types of cell formatting

Worksheet formulas and functions

Objects on the worksheet’s invisible drawer layer
Macros, toolbars, and add-ins for Excel customization

Analysis tools
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Protection options

MIicroSOFT EXCEL HAS BEEN REFERRED TO as “the best application ever written for
Windows.” You may or may not agree with that statement, but you can’t deny that
Excel is one of the oldest Windows products and has undergone many reincarna-
tions and face-lifts over the years. Cosmetically, the current version — Excel 2002 —
barely even resembles the original version (which, by the way, was written for the
Macintosh). However, many of Excel’s key elements have remained intact over the
years, with significant enhancements, of course.

This chapter presents a concise overview of the features available in the more
recent versions of Excel, with specific emphasis on Excel 2002. It sets the stage for
the subsequent chapters and provides a transition for those who have used other
spreadsheet products and are moving up to Excel. Hard-core Lotus 1-2-3 users, for
example, usually need some help to start thinking in Excel’s terms.

£\

If you're an old hand at Excel, you may want to ignore this chapter or just
skim through it quickly.
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The History of Excel

You probably weren’t expecting a history lesson when you bought this book, but
you may find this information interesting. At the very least, this section provides
fodder for the next office trivia match.

Spreadsheets comprise a huge business, but most of us tend to take this software
for granted. In the pre-spreadsheet days, people relied on clumsy mainframes or
calculators and spent hours doing what now takes minutes.

1t Started with VisiCalc

Dan Bricklin and Bob Frankston conjured up VisiCalc, the world’s first electronic
spreadsheet, back in the late 1970s when personal computers were unheard of in
the office environment. They wrote VisiCalc for the Apple Il computer, an interest-
ing machine that seems like a toy by today’s standards. VisiCalc caught on quickly,
and many forward-looking companies purchased the Apple II for the sole purpose
of developing their budgets with VisiCalc. Consequently, VisiCalc is often credited
for much of Apple II's initial success.

Then Came Lotus

When the IBM PC arrived on the scene in 1982, thus legitimizing personal comput-
ers, VisiCorp wasted no time porting VisiCalc to this new hardware environment.
Envious of VisiCalc’s success, a small group of computer enthusiasts at a start-up
company in Cambridge, Massachusetts, refined the spreadsheet concept. Headed by
Mitch Kapor and Jonathon Sachs, the company designed a new product and
launched the software industry’s first full-fledged marketing blitz. Released in
January 1983, Lotus Development Corporation’s 1-2-3 proved an instant success.
Despite its $495 price tag (yes, people really paid that much for software), it quickly
outsold VisiCalc and rocketed to the top of the sales charts, where it remained for
many years. Lotus 1-2-3 was, perhaps, the most popular application ever.

Microsoft Enters the Picture

Most people don’t realize that Microsoft’s experience with spreadsheets extends back
to the early 1980s. In 1982, Microsoft released its first spreadsheet —MultiPlan.
Designed for computers running the CP/M operating system, the product was subse-
quently ported to several other platforms, including Apple II, Apple III, XENIX, and
MS-DOS. MultiPlan essentially ignored existing software user-interface standards.
Difficult to learn and use, it never earned much of a following in the United States.
Not surprisingly, Lotus 1-2-3 pretty much left MultiPlan in the dust.

Excel partly evolved from MultiPlan, first surfacing in 1985 on the Macintosh. Like
all Mac applications, Excel was a graphics-based program (unlike the character-based
MultiPlan). In November 1987, Microsoft released the first version of Excel for
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Windows (labeled Excel 2 to correspond with the Macintosh version). Excel didn’t
catch on right away, but as Windows gained popularity, so did Excel. Lotus eventually
released a Windows version of 1-2-3, and Excel had additional competition from
Quattro Pro — originally a DOS program developed by Borland International, then sold
to Novell, and then sold again to Corel (its current owner).

Excel Versions

Excel 2002 is actually Excel 10 in disguise. You may think that this name represents
the tenth version of Excel. Think again. Microsoft may be a successful company,
but their version-naming techniques can prove quite confusing. As you’'ll see, Excel
2002 actually represents the eighth Windows version of Excel. In the following sec-
tions, I briefly describe the major Windows versions of Excel.

EXCEL 2

The original version of Excel for Windows, Excel 2 first appeared in late 1987. It
was labeled Version 2 to correspond to the Macintosh version (the original Excel).
Because Windows wasn’t in widespread use at the time, this version included a run-
time version of Windows — a special version with just enough features to run Excel
and nothing else. This version appears quite crude by today’s standards, as shown
in Figure 1-1.

Figure 1-1: The original Excel 2 for Windows. Excel has come a long way since its
original version. (Photo courtesy of Microsoft Corporation)
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EXCEL 3

At the end of 1990, Microsoft released Excel 3 for Windows. This version offered a
significant improvement in both appearance and features. It included toolbars,
drawing capabilities, worksheet outlining, add-in support, 3-D charts, workgroup
editing, and lots more.

EXCEL 4

Excel 4 hit the streets in the spring of 1992. This version made quite an impact on
the marketplace as Windows increased in popularity. It boasted lots of new features
and “usability” enhancements that made it easier for beginners to get up to speed
quickly.

EXCEL 5

In early 1994, Excel 5 appeared on the scene. This version introduced tons of new
features, including multisheet workbooks and the new Visual Basic for Applications
(VBA) macro language. Like its predecessor, Excel 5 took top honors in just about
every spreadsheet comparison published in the trade magazines.

EXCEL 95

Excel 95 (also known as Excel 7) shipped in the summer of 1995. On the surface, it
resembled Excel 5 (this version included only a few major new features). But Excel
95 proved to be significant because it presented the first version to use more
advanced 32-bit code. Excel 95 and Excel 5 use the same file format.

EXCEL 97

Excel 97 (also known as Excel 8) probably offered the most significant upgrade
ever. The toolbars and menus took on a great new look, online help moved a dra-
matic step forward, and the number of rows available in a worksheet quadrupled.
And if you're a macro developer, you may have noticed that Excel’s programming
environment (VBA) moved up several notches on the scale. Excel 97 also intro-
duced a new file format.

EXCEL 2000

Excel 2000 (also known as Excel 9) was released in June of 1999. Excel 2000
offered several minor enhancements, but the most significant advancement was the
ability to use HTML as an alternative file format. Excel 2000 still supported the
standard binary file format, of course, which is compatible with Excel 97.

EXCEL 2002

The most recent version, Excel 2002 (also known as Excel 10) was released in June
of 2001. It is sold as part of Microsoft Office XP. This version offers several new
features, most of which are fairly minor and are designed to appeal to novice users.
Perhaps the most significant new feature is the capability to save your work when
Excel crashes, and also recover corrupt workbook files that you may have aban-
doned long ago. Excel 2002 also adds background formula error checking and a
new formula-debugging tool; both features are relevant to this book.
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Many of these versions of Excel also included sub-versions. For example,
Microsoft released two service releases (SR-1 and SR-2) for Excel 97. These

o

The Object Model Concept

If you've dealt with computers for any length of time, you've undoubtedly heard
the term object-oriented programming. An object essentially represents a software
element that a programmer can manipulate. When using Excel, you may find it
useful to think in terms of objects, even if you have no intention of becoming a
programmer. An object-oriented approach can often help you keep the various ele-
ments in perspective.

Excel objects include the following:

service releases correct various problems with the software.

Excel itself

An Excel workbook

A worksheet in a workbook

A range in a worksheet

A Dbutton on a worksheet

A ListBox control on a UserForm (a custom dialog box)
A chart sheet

A chart on a chart sheet

® 6 6 6 6 O O 0o o

A chart series in a chart

Notice that something of an object hierarchy exists here: The Excel object con-
tains workbook objects, which contain worksheet objects, which contain range
objects. This hierarchy is called Excel’s object model. Other Microsoft Office prod-
ucts have their own object model. The object model concept proves to be vitally
important when developing VBA macros. Even if you don’t create macros, you may
find it helpful to think in terms of objects.

The Workings of Workbooks

One of the most common Excel objects is a workbook. Everything that you do in
Excel takes place in a workbook, which is stored in a file with an .xIs extension.
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Where Are the VBA Module Sheets?

In Excel 5 and Excel 95, a VBA module appeared in a workbook as a separate sheet. A
VBA module, as you may know, holds VBA code. In Excel 97 and later versions, VBA
modules still store with a workbook, but they no longer show up as a separate sheet.
Rather, you work with VBA modules in the Visual Basic Editor (VB Editor). To view or
edit a VBA module, activate the VB Editor by pressing Alt+F11. See Part VI of this book
for more information about VBA.

Beginning with Excel 2000, you can also use HTML as a “native”file format for
& Excel.Because this file must store lots of information needed to recreate the
workbook, you'll find that the HTML files generated by Excel are very

bloated. So unless you have a real need to save your work in HTML by using

this feature, you should use the normal XLS file format.

An Excel workbook can hold any number of sheets (limited only by memory).
The four types of sheets are:

¢ Worksheets

¢ Chart sheets

¢ XLM macro sheets (obsolete, but still supported)
¢ Dialog sheets (obsolete, but still supported)

You can open as many workbooks as you want (each in its own window), but
only one workbook is the active workbook at any given time. Similarly, only one
sheet in a workbook is the active sheet. To activate a different sheet, click its corre-
sponding tab at the bottom of the window, or press Ctrl+PgUp (for the next sheet)
or Ctrl+PgDn (for the previous sheet). To change a sheet’s name, double-click its
Sheet tab and enter the new text for the name. Right-clicking a tab brings up a
shortcut menu with some additional sheet-manipulation options.

You can also hide the window that contains a workbook by using the Window —
Hide command. A hidden workbook window remains open, but not visible. A sin-
gle workbook can display in multiple windows (select Window — New Window).
Each window can display a different sheet.
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Worksheets

The most common type of sheet is a worksheet — which you normally think of when
you think of a spreadsheet. Every Excel worksheet has 256 columns and 65,536
rows. And to answer a common question, the number of rows and columns is per-
manently fixed; you can’t change it. Despite what must amount to thousands of
requests from users, Microsoft refuses to increase the number of rows and columns
in a workbook. You can hide unneeded rows and columns to keep them out of view,
but you can’t increase the number of rows or columns.

ol

Having access to more cells isn’t the real value of using multiple worksheets in a
workbook. Rather, multiple worksheets are valuable because they enable you to
organize your work better. Back in the old days, when a spreadsheet file consisted
of a single worksheet, developers wasted a lot of time trying to organize the work-
sheet to hold their information efficiently. Now, you can store information on any
number of worksheets and still access it instantly.

You have complete control over the column widths and row heights and you can
even hide rows and columns (as well as entire worksheets). You can display the
contents of a cell vertically (or at an angle) and even wrap around to occupy mul-
tiple lines.

Versions prior to Excel 97 support only 16,384 rows in a worksheet.

How Big Is a Worksheet?

It's interesting to stop and think about the actual size of a worksheet. Do the
arithmetic (256 x 65,536), and you'll see that a worksheet has 16,777,216 cells.
Remember that this is in just one worksheet. A single workbook can hold more than
one worksheet.

If you're using the standard VGA video mode with the default row heights and column
widths, you can see 9 columns and 18 rows (or 162 cells) at a time. This works out to
be less than 0.001 percent of the entire worksheet. In other words, nearly 104,000
VGA screens of information reside within a single worksheet.

If you entered a single digit into each cell at the relatively rapid clip of one cell per
second, it would take you about 194 days, nonstop, to fill up a worksheet. To print the
results of your efforts would require more than 36,000 sheets of paper — a stack about
six feet high.
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By default, every new workbook starts out with three worksheets. You can
easily add a new sheet when necessary, so you really don’t need to start with

o

three sheets. You may want to change this default to a single sheet. To
change this option, use the Tools — Options command, click the General tab,
and change the setting for Sheets in new workbook.

Chart Sheets

A chart sheet normally holds a single chart. Many users ignore chart sheets, prefer-
ring to use “embedded charts,” which are stored on the worksheet’s draw layer.
Using chart sheets is optional, but they make it a bit easier to print a chart on a
page by itself, and they prove especially useful for presentations. I discuss embed-
ded charts (or floating charts on a worksheet) later in this chapter.

XLM Macro Sheets

An XLM macro sheet (also known as an MS Excel 4 macro sheet) is essentially a
worksheet, but it has some different defaults. More specifically, an XLM macro
sheet displays formulas rather than the results of formulas. Also, the default col-
umn width is larger than in a normal worksheet.

As the name suggests, an XLM macro sheet is designed to hold XLM macros. As
you may know, the XLM macro system consists of a holdover from previous ver-
sions (version 4.0 or earlier) of Excel. However, Excel 2002 continues to support
XLM macros for compatibility reasons, but it no longer provides the option of
recording an XLM macro. This book doesn’t cover the XLM macro system; instead,
it focuses on the more powerful VBA macro system.

Dialog Sheets

In Excel 5 and Excel 95, you can create a custom dialog box by inserting a special
dialog sheet. When you open a workbook that contains an Excel 5/95 dialog sheet,
the dialog sheet appears as a sheet in the workbook. Excel 97 and later versions still
support these dialog sheets, but they provide a much better alternative: UserForms.
You can work with UserForms in the VB Editor.

TIP If, for compatibility purposes, you need to insert an Excel 5/95 dialog sheet in
‘M later versions of Excel, you won't find the command to do so on the Insert
N\
]

menu. You can only add an Excel 5/95 dialog sheet by right-clicking any

Sheet tab and selecting Insert from the shortcut menu. Then, in the Insert
dialog box, click the MS Excel 5.0 Dialog icon.
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Excel’s User Interface

A user interface (UI) is the means by which an end user communicates with a com-
puter program. A Ul includes elements, such as menus, dialog boxes, toolbars, and
keystroke combinations, as well as features such as drag-and-drop. For the most
part, Excel uses the standard Windows Ul to accept commands.

Menus

Beginning with Excel 97, Excel’s UI deviates from the standard Windows UI by pro-
viding non-standard Windows menus. The menus in Excel 2000 and Excel 97 are
actually toolbars in disguise —the icons that accompany some menu items are a
dead give-away.

Excel’s menu system is relatively straightforward. Excel contains two different
menu bars —one for an active worksheet, the other for an active chart sheet or
embedded chart. Consistent with Windows conventions, inappropriate menu com-
mands are dimmed (“grayed out”) and commands that open a dialog box are fol-
lowed by an ellipsis (three dots). Where appropriate, the menus list any available
shortcut key combinations (for example, the Edit menu lists Ctrl+Z as the shortcut
key for Edit > Undo).

Several menu items are cascading menus, and as such, lead to submenus that
have additional commands ( Edit — Fill represents a cascading menu, for example).
A small arrow on the right of the menu item text indicates cascading menus.

An end user or developer can customize the entire menu system.To do so,
g“ choose the View —> Toolbars - Customize command. You must understand

e _ that menu changes made by using this technique are “permanent.” In other

words, the menu changes will remain in effect even if you close Excel and
restart it. This differs greatly from the Menu Editor found in Excel 5 and
Excel 95, which is not available in Excel 97 and later versions.

Shortcut Menus

Excel also features dozens of shortcut menus. These menus appear when the user
right-clicks after selecting one or more objects. The shortcut menus are context-
sensitive. In other words, the menu that appears depends on the location of the
mouse pointer when you right-click. You can right-click just about anything—a
cell, a row or column border, a workbook title bar, a toolbar, and so on.
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Smart Tags

A Smart Tag is a small icon that appears automatically in your worksheet. Clicking
a Smart Tag reveals several clickable options.

F Smart Tags are available only in Excel 2002.

For example, if you copy and paste a range of cells, Excel generates a Smart Tag
that appears below the pasted range (see Figure 1-2). Excel 2002 features several
other Smart Tags, and additional Smart Tags can be provided by third-party
providers.

A B C 1] E F G |
(15U 300 i) =
(2! 4@ 3.00 8.00
3| 600 400 300
4 30 = 2.0
|5 |
16|
|7 | 500 3.00 7.0
B 400 300 800
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Figure 1-2: This Smart Tag appears when you paste a copied range.

Dialog Boxes

Most of the menu commands in Excel display a dialog box, in which you can clar-
ify your intentions. These dialog boxes remain quite consistent in terms of how
they operate. Some of Excel’s dialog boxes use a notebook tab metaphor, which
makes a single dialog box function as several different dialog boxes. Tabbed dialog
boxes provide access to many options without overwhelming you. The Options dia-
log box (choose Tools — Options) presents an example of a tabbed dialog box in
Excel 2002 (see Figure 1-3).
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Figure 1-3: The Options dialog box represents a type of
tabbed dialog box.

Toolbars

Excel 2002 ships with 54 predefined toolbars (including the two toolbars that func-
tion as menus). These toolbars typically appear automatically, when appropriate.
For example, if you activate a chart, the Chart toolbar displays.

You can dock toolbars (position them along any edge of the screen) or make
them float. By default, Excel displays the Standard and Formatting toolbars directly
below the menu bar.

Drag-and-Drop

Excel’s drag-and-drop Ul feature enables you to freely drag objects that reside on
the draw layer to change their position. Pressing Ctrl while dragging duplicates the
selected objects.

Excel also permits drag-and-drop actions on cells and ranges. You can easily
drag a cell or range to a different position. And pressing Ctrl while dragging copies
the selected range.

ol

Cell drag-and-drop is optional; you can disable it in the Edit tab of the
Options dialog box.
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Keyboard Shortcuts

Excel has many keyboard shortcuts. For example, you can press Ctrl+C to copy a
selection. If you're a newcomer to Excel or if you just want to improve your effi-
ciency, then do yourself a favor and check out the online help (search for Keyboard
Shortcuts). The help file contains tables that summarize useful keyboard commands
and shortcuts.

Customized On-screen Display

Excel offers a great deal of flexibility regarding on-screen display (status bar, for-
mula bar, toolbars, and so on). For example, by choosing View — Full Screen, you
can get rid of everything except the menu bar, thereby maximizing the amount of
visible information. In addition, by using the View tab in the Options dialog box,
you can customize what displays in a worksheet window (for example, you can
hide scroll bars and grid lines).

Data Entry

Data entry in Excel is quite straightforward. Excel interprets each cell entry as one
of the following:

¢ A value (including a date or a time)
& Text

¢ A Boolean value (TRUE or FALSE).
¢ A formula

Formulas always begin with an equal sign (=). Excel accommodates habitual
1-2-3 users, however, and accepts an “at” symbol (@), a plus sign (+), or a minus
sign (-) as the first character in a formula. It automatically adjusts the entry after
you press Enter.

Object and Cell Selecting

Generally, selecting objects in Excel conforms to standard Windows practices. You
can select a range of cells by using the keyboard (using the Shift key, along with
the arrow keys), or by clicking and dragging the mouse. To select a large range,
click a cell at any corner of the range, scroll to the opposite corner of the range, and
press Shift while you click the opposite corner cell.

You can use Ctrl+* (Ctrl asterisk) to select an entire table. And when a large
range is selected, you can use Ctrl+. (Ctrl period) to move among the four corners
of the range.

Clicking an object placed on the draw layer selects the object. An exception
occurs if the object has a macro assigned to it. In such a case, clicking the object
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Data-Entry Tips

The following list of data-entry tips can help those moving up to Excel from another
spreadsheet.

€ To enter data without pressing the arrow keys, enable the Move selection
after entering an option in the Edit tab of the Options dialog box (which you
access from the Tools — Options command). You can also choose the direc-
tion that you want to go.

€ You may find it helpful to select a range of cells before entering data. If you
do so, you can use the Tab key to move only within the selected cells.

€ To enter the same data in all cells within a range, select the range, enter the
information into the active cell, and then press Ctrl+Enter.

€ To copy the contents of the active cell to all other cells in a selected range,
press F2 and then Ctrl+Enter.

@ To fill a range with increments of a single value, press Ctrl while you drag the
fill handle at the lower-right corner of the cell.

@ To create a custom AutoFill list, use the Custom Lists tab of the Options dia-
log box.

@ To copy a cell without incrementing, drag the fill handle at the lower-right
corner of the selection; or press Ctrl+D to copy down or Ctrl+R to copy to
the right.

€ To make text easier to read, you can enter carriage returns in a cell. To enter
a carriage return, press Alt+Enter. Carriage returns cause a cell's contents to
wrap within the cell.

® To enter a fraction, enter 0, a space, and then the fraction (using a slash).
Excel formats the cell using the Fraction number format.

€ To automatically format a cell with the currency format, type a dollar sign
before the value.

€ To enter a value in percent format, type a percent sign after the value. You
can also include your local thousand separator symbol to separate thousands
(for example, 123,434).

€ To insert the current date, Press Ctrl+semicolon. To enter the current time
into a cell, press Ctrl+Shift+semicolon.

@ To set up a cell or range so that it only accepts entries of a certain type (or
within a certain value range), use the Data — Validation command.
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executes the macro. To select multiple objects or noncontiguous cells, press Ctrl
while you select the objects or cells.

Cell Formatting

Excel provides two types of cell formatting —numeric formatting and stylistic
formatting.

Numeric Formatting

Numeric formatting refers to how a value appears in the cell. In addition to choos-
ing from an extensive list of predefined formats, you can create your own custom
number formats in the Number tab of the Format Cells dialog box (choose
Format — Cells).

Excel applies some numeric formatting automatically, based on the entry. For
example, if you precede a value with your local currency symbol (such as a dollar
sign), Excel applies Currency number formatting.

Refer to Appendix C for additional information about creating custom

number formats.

The number format doesn’t affect the actual value stored in the cell. For exam-
ple, suppose that a cell contains the value 3.14159. If you apply a format to display
two decimal places, the number appears as 3.14. When you use the cell in a for-
mula, however, the actual value (3.14159) — not the displayed value — is used.

Stylistic Formatting

Stylistic formatting refers to the cosmetic formatting (colors, shading, fonts, bor-
ders, and so on) that you apply in order to make your work look good. The Format
Cells dialog box (see Figure 1-4) is your one-stop shopping place for formatting
cells and ranges.

Many toolbar buttons offer direct access to common formatting options, regard-
less of whether you work with cells, drawn objects, or charts. For example, you can
use the Fill Color toolbar button to change the background color of a cell, change
the fill color of a drawn text box, or change the color of a bar in a chart. Access the
Format dialog box for the full range of formatting options.
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Figure 1-4: Use the Format Cells dialog box to apply
stylistic formatting.

Each type of object has its own Format dialog box. You can easily get to the cor-
rect dialog box and format an object by selecting the object, right-clicking, and
then choosing Format xxx (where xxx is the selected object) from the shortcut menu.
Alternatively, you can press Ctrl+1. Either of these actions leads to a tabbed dialog
box that holds all the formatting options for the selected object.

Don’t overlook Excel’s conditional formatting feature. This handy tool enables
you to specify formatting that appears only when certain conditions are met. For
example, you can make the cell’s interior red if the cell contains a negative number.

Chapter 19 describes how to create conditional formatting formulas that
greatly enhance this feature.

Worksheet Formulas and Functions

Formulas, of course, make a spreadsheet a spreadsheet. Excel’s formula-building
capability is as good as it gets. You will discover this as you explore subsequent
chapters in this book.

Worksheet functions allow you to perform calculations or operations that would
otherwise be impossible. Excel provides a huge number of built-in functions, and
you can access even more functions (many of them quite esoteric) by attaching the
Analysis ToolPak add-in.
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See Chapter 4 for more information about worksheet functions.

All spreadsheets allow you to define names for cells and ranges, but Excel han-
dles names in some unique ways. A name represents an identifier that enables you
to refer to a cell, range, value, or formula. Using names makes your formulas easier
to create and read.

| devote Chapter 3 entirely to names.

Objects on the Draw Layer

As I mentioned earlier in this chapter, each worksheet has an invisible draw layer,
which holds shapes, diagrams, charts, maps, pictures, and controls (such as buttons
and list boxes). I discuss some of these items in the following sections.

Shapes

You can insert AutoShapes from the Drawing toolbar. You can choose from a huge
assortment of shapes. After you place a shape on your worksheet, you can modify
the shape by selecting it and dragging its handles. In addition, you can apply drop
shadows, text, or 3-D effects to the shape. Also, you can group multiple shapes into
a single drawing object, which you’ll find easier to size or position.

Diagrams

The Insert > Diagram command displays the Diagram Gallery dialog box, shown in
Figure 1-5. You can choose from six diagrams, and each is highly customizable.

The Diagram Gallery is new to Excel 2002.
| ‘*‘\

&\
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Diagram Gallery EE

Select a diagram kype:
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Figure 1-5: Excel 2002 supports several types of diagrams.

Linked Picture Objects

For some reason, the designers of Excel make the linked picture object rather diffi-
cult to generate. To use this object, copy a range and then press Shift and select the
Edit > Paste Picture Link command (which appears on the Edit menu only when
you press Shift). This command originally accommodated users who wanted to
print a noncontiguous selection of ranges. Users could “take pictures” of the ranges
and then paste the pictures together in a single area, which they could then print.

Maps

If you work with geographic data, you may like the ability to insert a map into a
worksheet by using the Insert > Map command. Unfortunately, this feature was
removed from Excel 2002. Maps that were created with earlier versions still appear
in Excel 2002, but they can’t be modified.

Dialog Box Controls

Many of the controls that are used in custom dialog boxes can be placed directly on
the draw layer of a worksheet. Doing this can greatly enhance the usability of some
worksheets and eliminate the need to create custom dialog boxes. Figure 1-6 shows
a worksheet with some dialog box controls added to the draw layer.

Dialog box controls come from two sources: The Forms toolbar, or the
Control Toolbox toolbar. Controls from the Control Toolbox toolbar consist

of ActiveX controls, and are available only in Excel 97 or later.
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Figure 1-6: Excel enables you to add many controls directly to the
draw layer of a worksheet.

Charts

Excel, of course, has excellent charting capabilities. As I mentioned earlier in this
chapter, you can store charts on a chart sheet or you can float them on a worksheet.

Excel offers extensive chart customization options. If a chart is free-floating,
just click a chart element to select it (or double-click it to display its formatting dia-
log box). Right-clicking a chart element displays a shortcut menu.

You can easily create a free-floating chart by selecting the data to be charted
and then using the Chart Wizard to walk you through the steps to create a chart
that meets your needs.

Chapter 17 contains additional information about charts.

Customization in Excel

This section describes various features that enable you to customize Excel. They
include macros, toolbars, and add-in programs.

Macros

Excel’s VBA programming language provides a powerful tool that can make Excel
perform otherwise impossible feats. You can classify the procedures that you create
with VBA into two general types:
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@ Macros that automate various aspects of Excel.

# Macros that serve as custom functions that you can use in worksheet
formulas.

Part VI of this book describes how to use and create custom worksheet
functions using VBA.

Toolbars

As I noted earlier, Excel includes many toolbars. You can, if you're so inclined, cre-
ate new toolbars that contain existing toolbar buttons, or new buttons that execute
macros.

Use the View —> Toolbars — Customize command to customize toolbars or create
new ones. You can also write VBA code to manipulate toolbars.

Add-in Programs

An add-in is a program attached to Excel that gives it additional functionality. For
example, you can store custom worksheet functions in an add-in. To attach an add-
in, use the Tools > Add-Ins command.

Excel ships with quite a few add-ins (including the Analysis ToolPak). In addi-
tion to these add-ins, you can purchase or download many third-party add-ins
from online services. My Power Utility Pak represents an example of an add-in. You
can access a trial version on the CD-ROM included with this book.

Chapter 23 describes how to create your own add-ins that contain custom
worksheet functions.

Analysis Tools

Excel is certainly no slouch when it comes to analysis. After all, most people use a
spreadsheet for analysis. Many analysis tasks can be handled with formulas, but
Excel offers many other options, which I discuss in the following sections.
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Database Access

Over the years, most spreadsheets have enabled users to work with simple flat data-
base tables (even the original version of 1-2-3 contained this feature). Excel’s data-
base features fall into two main categories:

¢ Worksheet databases. The entire database stores in a worksheet, limiting
the size of the database. In Excel, a worksheet database can have no more
than 65,535 records (because there are 65,536 rows; the top row holds the
field names) and 256 fields (because there are 256 columns).

¢ External databases. The data stores in one or more disk files and you can
access it as needed.

Generally, when the cell pointer resides within a worksheet database, Excel rec-
ognizes it and displays the field names whenever possible. For example, if you
move the cell pointer within a worksheet database and choose the Data — Sort com-
mand, Excel enables you to select the sort keys by choosing field names from a
drop-down list.

A particularly useful feature, Excel’s AutoFilter, enables you to display only the
records that you want to see. When AutoFilter mode is on, you can filter the data
by selecting values from pull-down lists (which appear in place of the field names
when you choose the Data — Filter - AutoFilter command). Rows that don’t qualify
are temporarily hidden. See Figure 1-7 for an example.

A B C D E F—
| 1| SalesRep =| Region x| Month [+| Sales +| |
2 |Amy Morth (A 13040
[ 3 |amy Morth {Top 10...} 14131
= [Custom...)
| 4 |amy Morth py 14645
| 5 |Amy Marth Aug 12047
[ B |Amy Morth 14971
| 7 |amy Morth o 14218
| & |amy Morth 3l 15735 oo
| 9 |amy Morth Jun 13638
| 10 |Amy Morth My 15749
[ 11 |Amy Morth Nov 14437
[ 12 |amy Morth oct 15355
|13 |Amy Morth el 15899
|14 |Bob Morth Jan 10024
|15 |Bab Morth Feb 13822
|15 |Eiob Morth Mar 14854
117 |Bob Morth Apt 12838
118 |Biob Morth May 15320
118 |Bab Morth Jun 14733
:ﬂ« nb hn % Summary ;Dgltﬂaﬂfh ! 141 e | ﬂJJJ

Figure 1-7: Excel's AutoFilter feature makes it easy to
view only the database records that meet your criteria.

If you prefer, you can use the traditional spreadsheet database techniques that
involve criteria ranges. To do so, choose the Data— Filter > Advanced Filter
command.



Chapter 1: Excel in a Nutshell

23

Chapter 9 provides additional details regarding worksheet lists and
databases.

Excel can automatically insert (or remove) subtotal formulas in a table that is set
up as a database. It also creates an outline from the data so that you can view only
the subtotals, or any level of detail that you desire.

Outlines

A worksheet outline often serves as an excellent way to work with hierarchical
data, such as budgets. Excel can create an outline automatically by examining the
formulas in your worksheet. After you've created an outline, you can collapse or
expand the outline to display various levels of details. Figure 1-8 shows an exam-
ple of a worksheet outline.

[_]

Ei‘ : B 4 4 EE
: . . .
NEE] A [ 8 T ¢ [ o ] E | | | [ | Q |
| 1 State Jan Feb Mar Q1 Total 02 Total Q3 Total Q4 Total [

[+ | B West Total 5170 6527 5081 " 167787 182427 18314 19138

© 7 [Mew York 1479 1316 1593 4,738 4,763 3,915 4,789
B Mew Jersey 173 1408 1224 4,365 4,316 4,051 4,526  —

- | B Massachusetts 1098 1233 1010 3,442 4,155 4,882 5,376

- 10 |Florida 1705 1792 133 4,722 4,630 5,062 4,734

=/ |11 |East Total 5,968 5,747 5552 17,2677 17864 179107 18925

- 12 Kentucky 1408 1078 1,85 3,342 4,626 4,306 4,526

| 13 |Oklahoma 1308 1045 1541 3,995 5,364 4,338 4,449

|14 Miszour 1511 174 1414 4,669 4,556 4,203 4,279

|15 | llinois 1538 1493 121 4,243 3623 4,889 4,330

|16 |Kansas 1873 1EE0 1243 4,776 4,007 4,322 4,299

=/ |17 |Central Total 7441 6920 66647 176837 17580 7 17752 17,357

= | 18|Grand Total 18,579 19,194 17,297 51,728 53,656 53,976 55,420
19 =
4 4 » H]\Sheetl / 141 | I

Figure 1-8: Excel can automatically insert subtotal formulas and create outlines.

Scenario Management

Scenario management is the process of storing input values that drive a model. For
example, if you have a sales forecast, you may create scenarios such as best case,
worst case, and most likely case.

If you seek the ultimate in scenario-management features, 1-2-3’s Version
Manager is probably your best bet. Unlike Version Manager, Excel’s Scenario
Manager can only handle simple scenario-management tasks. However, it is defi-
nitely easier than trying to keep track of different scenarios manually.
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Analysis ToolPak

The Analysis ToolPak add-in provides 19 special-purpose analysis tools (primarily
statistical in nature) and many specialized worksheet functions. These tools make
Excel suitable for small- to medium-scale statistical analysis.

Pivot Tables

One of Excel’s most powerful tools is its pivot tables. A pivot table enables you to
display summarized data in just about any possible way. Data for a pivot table
comes from a worksheet database or an external database and stores in a special
cache, which enables Excel to recalculate data rapidly after a pivot table is altered.

Chapter 18 contains additional information about pivot tables.

Excel 2000 and later versions also support the pivot chart feature. Pivot charts
enable you to link a chart to a pivot table.

Auditing Capabilities

Excel also offers useful auditing capabilities that help you identify errors or track
the logic in an unfamiliar spreadsheet. To access this feature, select Tools
Formula Auditing (or Tools > Auditing, in versions prior to Excel 2002).

Excel 2002 includes background formula auditing.| cover this topic and

‘& other auditing features in Chapter 21.

Solver Add-in

For specialized linear and nonlinear problems, Excel’s Solver add-in calculates
solutions to what-if scenarios based on adjustable cells, constraint cells, and,
optionally, cells that must be maximized or minimized.
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Protection Options

Excel offers a number of different protection options. For example, you can protect
formulas from being overwritten or modified, protect a workbook’s structure, and
protect your VBA code.

Protecting Formulas from Being Overwritten

In many cases, you may want to protect your formulas from being overwritten or
modified. To do so, perform the following steps:

1.
2.

Select the cells that may be overwritten.

Select Format — Cells, and click the Protection tab of the Format Cells dia-
log box.

. In the Protection tab, remove the checkmark from the Locked check box.
. Click OK to close the Format Cells dialog box.
. Select Tools — Protection —> Protect Sheet to display the Protect Sheet dia-

log box, as shown in Figure 1-9. If you use a version prior to Excel 2002,
this dialog box looks different.

. In the Protect Sheet dialog box, specify a password if desired, and

click OK.

By default, all cells are Locked. This has no effect, however, unless you have a
protected worksheet.

F Protection options in Excel 2002 are much more flexible. When you protect a

worksheet, the Protect Sheet dialog box lets you choose which elements
won't be protected. For example, you can allow users to sort data or use

AutoFiltering on a protected sheet (tasks that weren't possible with earlier
versions).
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Protect Sheet [2]x]

[V Protect worksheet and contents of locked cells

Password ta unprotect sheet:

Allgw all users of this worksheet to:

Format rows
™ Insert columns
I Insert rovs
™ Insert hyperlinks
I Delste columns

™ Delete rows ;I

Cancl

Figure 1-9: The Protect Sheet dialog box in
Excel 2002

You can also hide your formulas so they won’t appear in Excel’s formula bar
when the cell is activated. To do so, select the formula cells and make sure that the
Hidden check box is checked in the Protection tab of the Format Cells dialog box.

Protecting a Workbook’s Structure

When you protect a workbook’s structure, you can’t add or delete sheets. Use the
Tools = Protection = Protect Workbook command to display the Protect Workbook
dialog box, as shown in Figure 1-10. Make sure that you check the Structure check
box. If you also check the Windows check box, the window can’t be moved or
resized.

Protect Workbook H
Protect workbook for
M structure
™ Windows
Password (optional):
Cence

Figure 1-10: The Protect Workbook dialog box

It's important to keep in mind that Excel is not really a secure application.
The protection features, even when used with a password, are intended to
prevent casual users from accessing various components of your workbook.
Anyone who really wants to defeat your protection can probably do so by
using readily available password-cracking utilities.
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Summary

This chapter provided a general overview of the features available in Excel, and pri-
marily focuses on newcomers to Excel. The next chapter gets into the meat of the
book and provides an introduction to Excel formulas.






Chapter 2

Basic Facts about Formulas

IN THIS CHAPTER

How to enter, edit, and paste names into formulas
The various operators used in formulas

How Excel calculates formulas

Cell and range references used in formulas

How to make an exact copy of a formula

How to convert formulas to values

How to prevent formulas from being viewed

The types of formula errors

Circular reference messages and correction techniques

® & 6 6 6 6 O O 0 o

Excel’s goal-seeking feature

THIS CHAPTER SERVES AS A BASIC INTRODUCTION to using formulas in Excel.
Although I direct its focus on newcomers to Excel, even veteran Excel users may
find some new information here.

Entering and Editing Formulas

This section describes the basic elements of a formula. It also explains various ways
of entering and editing your formulas.

Formula Elements
A formula entered into a cell can consist of five element types:
@ Operators: These include symbols such as + (for addition) and * (for
multiplication)

@ Cell references: These include named cells and ranges and can refer to
cells in the current worksheet, cells in another worksheet in the same
workbook, or even cells in a worksheet in another workbook.

29
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¢ Values or strings: Examples include 7.5 or “Year-End Results.”

¢ Worksheet functions and their arguments: These include functions such
as SUM or AVERAGE and their arguments.

¢ Parentheses: These control the order in which expressions within a for-
mula are evaluated.

Entering a Formula

When you type an equal sign into an empty cell, Excel assumes that you are enter-
ing a formula (a formula always begins with an equal sign). Excel’s accommodat-
ing nature also permits you to begin your formula with a minus sign or a plus sign.
However, Excel always inserts the leading equal sign after you enter the formula.

As a concession to former 1-2-3 users, Excel also enables you to use an “at”
symbol (@) to begin a formula that starts with a function. For example, Excel
accepts either of the following formulas:

=SUM(A1:A200)
@SUM(A1:A200)

However, after you enter the second formula, Excel replaces the at symbol with
an equal sign. You can enter a formula into a cell in one of two ways: enter it man-
ually, or enter it by pointing to cell references. I discuss each of these methods in
the following sections.

ENTERING FORMULAS MANUALLY

Entering a formula manually involves, well, entering a formula manually. You sim-
ply activate a cell and type an equal sign (=) followed by the formula. As you type,
the characters appear in the cell as well as in the formula bar. You can, of course,
use all the normal editing keys when entering a formula. After you insert the for-
mula, press Enter.

o

After you press Enter, the cell displays the result of the formula. The formula,
itself, appears in the formula bar when the cell is activated.

An exception to this is when you enter an array formula. When you enter an
array formula, press Ctrl+Shift+Enter rather than just Enter. | discuss array
formulas in Part IV.
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ENTERING FORMULAS BY POINTING

The other method of entering a formula still involves some manual typing, but you
can simply point to the cell references instead of entering them manually. For
example, to enter the formula =A1+A2 into cell A3, follow these steps:

1. Move the cell pointer to cell A3.

2. Type an equal sign (=) to begin the formula. Notice that Excel displays
Enter in the left side of the status bar.

3. Press the up arrow twice. As you press this key, notice that Excel displays
a faint moving border around the cell and that the cell reference (A1)
appears in cell A3 and in the formula bar. Also notice that Excel displays
Point in the status bar.

If you prefer, you can use your mouse and click cell Al.

4. Type a plus sign (+). The faint border disappears and Enter reappears in
the status bar.

5. Press the up arrow one more time. A2 adds to the formula.
If you prefer, you can use your mouse and click cell A2.

6. Press Enter to end the formula. As with entering the formula manually,
the cell displays the result of the formula, and the formula appears in the
formula bar when the cell is activated.

If you prefer, you can use your mouse and click the check mark icon next

to the formula bar.

Pointing to cell addresses rather than entering them manually is usually less
tedious, and almost always more accurate.

When you create a formula that refers to other cells, the cell that contains
the formula has the same number format as the first cell to which it refers.

The only exception: if the first cell reference is formatted as a percentage.

Excel 97 and Excel 2000 include the Formula Palette feature that you can use
when entering or editing formulas (see Figure 2-1). To access the Formula Palette,
click on the Edit Formula button in the edit line (it has an image of an equal sign).
The Formula Palette enables you to enter formulas manually or use the pointing
techniques described previously.
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F The Formula Palette was removed from Excel 2002.

Pasting Names

As I discuss in Chapter 3, you can assign a name to a cell or range. If your formula
uses named cells or ranges, you can type the name in place of the address or choose
the name from a list and have Excel insert the name for you automatically.

To insert a name into a formula, select the Insert > Name — Paste command (or
Press F3) to display the Paste Name dialog box. Excel displays its Paste Name dia-
log box with all the names listed, as shown in Figure 2-1. Select the name and click
OK. Or, you can double-click the name, which inserts the name into the formula
and closes the dialog box.

Paste Name

Paste name

Canel

Figure 2-1: The Paste Name dialog box
enables you to insert a name while
entering a formula.

Spaces and Line Breaks

Normally, you enter a formula without using any spaces. However, you can use
spaces (and even line breaks) within your formulas. Doing so has no effect on the
formula’s result, but may make the formula easier to read. To enter a line break in
a formula, press Alt+Enter. Figure 2-2 shows a formula that contains spaces and
line breaks.

Formula Limits

A formula can consist of up to 1,024 characters. If you need to create a formula
that exceeds this limit, you must break the formula up into multiple formulas. You
also can opt to create a custom function (using VBA).



Chapter 2: Basic Facts about Formulas

33

B Microsoft Excel

ile  Edit Wew Insert Format Tools [Data  Window Help formula o

EHSB|ERAY| L BR-|o-o-|@ -2 |l B - |E,

§[arial o -|B £ u|= o) : 2
SUMIF > X & =SUMJanuary)+

SUMIFebruar
SUMiMarch)

January 41485 49210
February 178.87 76228
March 473.31 553.58
April 56160 B67.02
May 1387 42091
June a08.31 710.82
July 937 B8 193.88
August 786588 18575
Septernber 154.44 | 996.56
October 92058 59063
Movernher  593.28 | 83663
December 431680 93557

=

)

|=SUM(January)+

SUM(February)+
SUM(March)

M 4 b M[4Sheetl

Edit [ [ |

Sample Formulas

If you follow the above instructions for entering formulas, you can create a variety
of formulas. This section provides a look at some sample formulas.

@ The following formula multiplies 150 times .01, and returns 1.5. This for-
mula uses only literal values, so it doesn’t prove very useful (you can sim-
ply enter the value 1.5 instead of the formula).

=150*.01
@ This formula adds the values in cells A1 and A2:
=A1+A2

@ The next formula subtracts the value in the cell named Expenses from the
value in the cell named Income.

=Income-Expenses
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The following formula uses the SUM function to add the values in the
range Al:A12.

=SUM(A1:A12)

The next formula compares cell A1 with cell C12 by using the = operator.
If the values in the two cells are identical, the formula returns TRUE; oth-
erwise it returns FALSE.

=A1=C12

This final formula subtracts the value in cell B3 from the value in cell B2
and then multiplies the result by the value in cell B4:

=(B2-B3)*B4

Editing Formulas

If you make changes to your worksheet, you may need to edit formulas. Or, the for-
mula may return one of the error values described later in this chapter, and you
need to edit the formula to correct the error. You can edit your formulas just as you
edit any other cell.

There are several ways to get into cell edit mode:

1.

Double-click the cell. This enables you to edit the cell contents directly
in the cell. This technique works only if the Edit directly in cell option
is in effect. You can change this option in the Edit tab of the Options
dialog box.

Press F2. This enables you to edit the cell contents directly in the cell. If
the Edit directly in cell option is not turned on, the editing will occur in
the formula bar.

. Select the formula cell that you want to edit and then click in the formula

bar. This enables you to edit the cell contents in the formula bar.

Click the Edit Formula button (it has an equal sign icon) in the edit line to
access the Formula Palette.

F Excel 2002 does not have an Edit Formula button.
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Using the Formula Bar as a Calculator

If you simply need to perform a calculation, you can use the formula bar as a
calculator. For example, enter the following formula into any cell:

=(145*1.05)/12

Because this formula always returns the same result, you might prefer to store the
formula's result rather than the formula. To do so, press F2 to edit the cell. Then press
F9 followed by Enter. Excel stores the formula's result (12.6875), rather than the
formula. This technique also works if the formula uses cell references.

You'll find that this technique is most useful when you use worksheet functions. For
example, to enter the square root of 221 into a cell, enter =SQRT(221), press F9, and
press Enter. Excel enters the result: 14.8660687473185. You also can use this
technique to evaluate just part of a formula. Consider this formula:

=(145*1.05)/A1

If you want to convert just the expression within the parentheses to a value, get into
cell edit mode and select the part that you want to evaluate. In this example, select
145%1.05. Then, press F9 followed by Enter. Excel converts the formula to the
following:

=(152.25)/A1

When you edit a formula, you can select multiple characters by dragging the
mouse over them or by holding down Shift while you use the arrow keys. You can
also press Home or End to select from the cursor position to the beginning or end
of the formula. If you use Ctrl+Shift, pressing the arrow keys allows you to select
“words” within the formula.

TIP Suppose you have a lengthy formula that contains an error, and Excel won't
$@% let you enter it because of the error. In this case, you can convert the formula
\
—

to text and tackle it again later.To convert a formula to text, just remove the

initial equal sign (=).To try the formula again, insert the initial equal sign to
convert the cell contents back to a formula.

Using Operators in Formulas

As previously discussed, an operator is the basic element of a formula. An operator
is a symbol that represents an operation. Excel supports the following operators:
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<>

Addition

Subtraction

Division

Multiplication

Percent

Text concatenation

Exponentiation

Logical comparison (equal to)

Logical comparison (greater than)

Logical comparison (less than)

Logical comparison (greater than or equal to)
Logical comparison (less than or equal to)

Logical comparison (not equal to)

You can, of course, use as many operators as you need. Formulas can prove

quite complex.

Reference Operators

Excel supports another class of operators known as reference operators. Reference
operators, described in the following list, work with cell references.

: (colon)

, (comma)

(single space)

Range operator. Produces one reference to all the cells
between two references.

Union operator. This combines multiple cell or range refer-
ences into one reference.

Intersection operator. This produces one reference to cells
common to two references.

Sample Formulas That Use Operators

These examples of formulas use various operators:

¢ The following formula joins (concatenates) the two literal text strings to
produce a new text string: Part-23A:

="Part-"&"23A"

@ The next formula concatenates the contents of cell A1 with cell A2:

=A1&A2
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Usually, concatenation is used with text, but concatenation works with
values as well. For example, if cell A1 contains 123 and cell A2 contains
456, the preceding formula would return the value 123456. Note that,
technically, the result is a text string. However, this text string functions
as a numeric value.

The following formula uses the exponentiation operator to raise 6 to the
third power, to produce a result of 216.

63

A more useful form of the above formula uses a cell reference instead of
the literal value. Note this example that raises the value in cell A1 to the
third power:

=A173
This formula returns the cube root of 216 (which is 6):
=2167(1/3)

The next formula returns TRUE if the value in cell A1 is less than the
value in cell A2. Otherwise, it returns FALSE.

=A1<A2

Logical comparison operators also work with text. If A1 contains Alpha
and A2 contains Gamma, the formula returns TRUE because Alpha comes
before Gamma in alphabetical order.

The following formula returns TRUE if the value in cell A1 is less than or
equal to the value in cell A2. Otherwise, it returns FALSE.

=A1<=A2

The next formula returns TRUE if the value in cell A1 does not equal the
value in cell A2. Otherwise, it returns FALSE.

=A1<>A2

Unlike some other spreadsheets (such as 1-2-3), Excel doesn’t have logical
AND or OR operators. Rather, you use functions to specify these types of
logical operators. For example, this formula returns TRUE if cell A1 con-
tains either 100 or 1000:

=0R(A1=100,A1=1000)

This last formula returns TRUE only if both cell A1 and cell A2 contain
values less than 100:

=AND(A1<100,A2<100)
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Operator Precedence

You can (and should) use parentheses in your formulas to control the order in
which the calculations occur. As an example, consider the following formula that
uses references to named cells.

=Income-Expenses*TaxRate

The goal is to subtract expenses from income and then multiply the result by the
tax rate. If you enter the above formula, you discover that Excel computes the
wrong answer. Rather, the formula multiplies expenses by the tax rate and then
subtracts the result from the income. The correct way to write this formula is:

=(Income-Expenses)*TaxRate

To understand how this works, you need to be familiar with a concept called
operator precedence —the set of rules that Excel uses to perform its calculations.
Table 2-1 lists Excel’s operator precedence. Operations with a lower precedence
number are performed before operations with a higher precedence number.

Use parentheses to override Excel’s built-in order of precedence. Returning to
the previous example, the formula without parentheses is evaluated using Excel’s
standard operator precedence. Because multiplication has a higher precedence, the
Expense cell multiplies by the TaxRate cell. Then, this result is subtracted from
Income — producing an incorrect calculation.

The correct formula uses parentheses to control the order of operations.
Expressions within parentheses always get evaluated first. In this case, Expenses is
subtracted from Income, and the result multiplies by TaxRate.

TasLe 2-1 OPERATOR PRECEDENCE IN EXCEL FORMULAS

Symbol Operator Precedence
- Negation 1
% Percent 2

Exponentiation

*and/ Multiplication and division 4
+and - Addition and subtraction 5
& Text concatenation 6

=, <, >, <=, >=,and <> Comparison 7
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Nested Parentheses

You can also nest parentheses in formulas. Nesting means putting parentheses
inside of parentheses. If you do so, Excel evaluates the most deeply nested expres-
sions first and works its way out. The following example of a formula uses nested
parentheses.

=((B2*C2)+(B3*C3)+(B4*C4))*B6

This formula has four sets of parentheses. Three sets are nested inside the fourth
set. Excel evaluates each nested set of parentheses and then sums the three results.
This sum is then multiplied by the value in B6.

It’s a good idea to make liberal use of parentheses in your formulas, even when
they aren’t necessary. Using parentheses clarifies the order of operations and makes
the formula easier to read. For example, if you want to add 1 to the product of two
cells, the following formula performs will do the job:

=A1*A2+1

You may find it much clearer, however, to use the following formula (with
superfluous parentheses):

=(A1*A2)+1

Every left parenthesis, of course, must have a matching right parenthesis. If you
have many levels of nested parentheses, you might find it difficult to keep them
straight. If the parentheses don’t match, Excel pops up a message telling you and
won’t permit you to enter the formula.

TIP Fortunately, Excel lends a hand in helping you match parentheses.When you
$@ enter or edit a formula that has parentheses, pay attention to the text. When
I the cursor moves over a parenthesis, Excel momentarily displays the paren-

thesis and its closing parenthesis in bold.This lasts for less than a second, so
watch carefully.

In some cases, if your formula contains mismatched parentheses, Excel may pro-
pose a correction to your formula (Excel 97 introduced this Formula AutoCorrect
feature). Figure 2-3 shows an example of Excel’s AutoCorrect feature in action.
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Don't Hard-Code Values

a formula such as:

=A1*.075

When you create a formula, think twice before using a literal value in the formula. For
example, if your formula calculates 7.5 percent sales tax, you may be tempted to enter

A better approach is to insert the sales tax rate into a cell and use the cell reference
in place of the literal value. This makes it easier to modify and maintain your
worksheet. For example, if the sales tax range changes to 7.75 percent, you need to
modify every formula that uses the old value. If the tax rate is stored in a cell, you
simply change one cell and all the formulas automatically get updated.

parentheses after January. Excel proposed this correction:

=SUM(January/SUM(Total))

In fact, the correct formula is:
=SUM(January)/SUM(Total)

Microsoft Excel

Microsoft Excel Found an error in the Formula you entered. Do you want to sccept the correction proposed below?

\E) —SUM(January(SUMCTakall)

» To accepk the correction, click es.
+ To close this message and carrect the Formula yourself, click Mo,

] w

It is tempting to simply accept the correction proposed in the dialog box,
but be careful. In many cases, the proposed formula, although syntactically
correct, isn't the formula that you want. In Figure 2-3, | omitted the closing

Figure 2-3: Excel's Formula AutoCorrect feature often suggests a
correction to an erroneous formula.

Calculating Formulas

You've probably noticed that the formulas in your worksheet get calculated imme-
diately. If you change any cells that the formula uses, the formula displays a new
result with no effort on your part. This occurs when Excel’s Calculation mode is set
to Automatic. In this mode (the default mode), Excel follows certain rules when cal-

culating your worksheet:
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¢ When you make a change (enter or edit data or formulas, for example),
Excel calculates immediately those formulas that depend on new or edited
data.

¢ If working on a lengthy calculation, Excel temporarily suspends calcula-
tion when you need to perform other worksheet tasks; it resumes when
you finish.

@ Formulas are evaluated in a natural sequence. For instance, if a formula in
cell D12 depends on the result of a formula in cell D11, cell D11 is calcu-
lated before D12.

Sometimes, however, you may want to control when Excel calculates formulas.
For example, if you create a worksheet with thousands of complex formulas, you'll
find that things can slow to a snail’s pace while Excel does its thing. In this case,
you can set Excel’s calculation mode to Manual. Do this in the Calculation panel of
the Options dialog box. (Select Tools —> Options to display this dialog box.)

When you work in Manual calculation mode, Excel displays Calculate in the sta-
tus bar when you have any uncalculated formulas. You can use the following
shortcut keys to recalculate the formulas:

¢ F9: Calculates the formulas in all open workbooks.

¢ Shift+F9: Calculates only the formulas in the active worksheet. It does not
calculate other worksheets in the same workbook.

¢ Ctrl+Alt+F9: Forces a complete recalculation of all open workbooks. Use
it if Excel (for some reason) doesn’t seem to return correct calculations.

¢ Ctrl+Shift+Alt+F9: Rechecks all of the dependent formulas, and then
forces a recalculation of all open workbooks.

F The Ctrl+Shift+Alf+F9 key sequence works only in Excel 2002.

Excel’s Calculation mode isn't specific to a particular worksheet. When you
change Excel’s Calculation mode, it affects all open workbooks — not just

the active workbook. Also, the initial Calculation mode is set by the
Calculation mode saved with the first workbook you open.
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Cell and Range References

Most formulas reference one or more cells by using the cell or range address (or
name if it has one). Cell references come in four styles; the dollar sign differentiates
them:

¢ Relative: The reference is fully relative. When the formula is copied, the
cell reference adjusts to its new location. Example: A1l

¢ Absolute: The reference is fully absolute. When the formula is copied, the
cell reference does not change. Example: $A$1

¢ Row Absolute: The reference is partially absolute. When the formula is
copied, the column part adjusts, but the row part does not change.
Example: A$1

¢ Column Absolute: The reference is partially absolute. When the formula is
copied, the row part adjusts, but the column part does not change.
Example: $A1

Creating an Absolute Reference

When you create a formula by pointing to cells, all cell and range references are
relative. To change a reference to an absolute reference, you must do so manually
by adding the dollar signs. Or, when you enter a cell or range address, you can use
the F4 key to cycle among all possible reference modes.

If you think about it, you may realize that the only reason you would ever need
to change a reference is if you plan to copy the formula. Figure 2-4 demonstrates
this. Note the formula in cell C4:

=C$3*$B4

This formula calculates the area for various widths (listed in column B) and
lengths (listed in Row 3). After you enter the formula, it can then be copied down
and across. Because the formula uses absolute references to row 3 and column B,
each copied formula produces the correct result. If the formula uses relative refer-
ences, copying the formula causes the references to adjust and produce the wrong
results.
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A1 vs. R1C1 Notation

Normally, Excel uses what is referred to as A1 notation. Each cell address consists of a
column letter and a row number. However, Excel also supports R1C1 notation. In this
system, cell A1 is referred to as cell R1C1, cell A2 as R2C1, and so on.

To change to R1C1 notation, select Tools — Options to get the Options dialog box,
click the General tab, and place a check mark next to R1C1 reference style. Now,
notice that the column letters all change to numbers. And, all of the cell and range
references in your formulas also adjust.

Look at the following examples of formulas using standard notation and R1C1
notation. The formula is assumed to be in cell B1 (also known as R1C2).

Standard R1C1

=A1+1 =RC[-1]+1

=$A$1+1 =R1C1+1

=$AT+1 =RC1+1

=A$1+1 =R1C[-1]+1
=SUM(A1:A10) =SUM(RC[-1]:R[9]C[-1])

=SUM($A$1:$A$10) =SUM(R1C1:R10C1)

If you find R1C1 notation confusing, you're not alone. R1C1 notation isn't too bad
when you're dealing with absolute references. But when relative references are
involved, the brackets can drive you nuts.

The numbers in brackets refer to the relative position of the references. For example,
R[-5]C[-3] specifies the cell that appears five rows above and three columns to the
left. Conversely, R[5]C[3] references the cell that appears five rows below and three
columns to the right. If you omit the brackets, it specifies the same row or column. For
example, R[5]C refers to the cell five rows below in the same column.

Although you probably won't use R1C1 notation as your standard system, it does have
at least one good use. R1C1 notation makes it very easy to spot an erroneous formula.
When you copy a formula, every copied formula is exactly the same in R1C1 notation.
This remains true regardless of the types of cell references you use (relative, absolute,
or mixed). Therefore, you can switch to R1C1 notation and check your copied
formulas. If one looks different from its surrounding formulas, it's probably incorrect.

Continued
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A1 vs. R1C1 Notation (Continued)

If you're using Excel 2002, however, you can take advantage of the new background
formula auditing feature. This feature can flag potentially incorrect formulas. | discuss
this feature in Chapter 21.

¥ Eookl A=
A B © 8] E F G H | J K I—
; =]
2|
i | 1.0 1.5 2.0 2.5 3.0 3.5 4.0 4.5 5.0
| 4] 1.0 1.00 1.50 2.00 250 3.00 350 4.00 4.50 £.00
| 5 | 1.5 1.50 225 3.00 375 450 525 6.00 B.75 750
| B | 2.0 2.00 3.00 4.00 5.00 B.00 7.00 8.00 5.00 10.00
[ 7| 25 250 375 5.00 B.25 7.50 875 1000 11.25 1250
| 8 | 3.0 3.00 450 6.00 780 900 10500 1200 1350) 1500
| 9 | 35 3.50 525 7.00 875 1050 1225 1400 15875 1780 T
10 4.0 4.00 B.00 800 10000 1200 1400 1600 1800 2000
[ 11] 4.5 4.50 B.75 9.00 1125 1380 1575 1800 2025 22E0
[12] 5.0 £.00 750 1000 1250 1500 1750 2000 2250 2500
13 o
44 ¥ ¥]\Sheet1 |« | le

Figure 2-4: An example of using non-relative references in a formula

Referencing Other Sheets or Workbooks

A formula can use references to cells and ranges that are in a different worksheet.
To refer to a cell in a different worksheet, precede the cell reference with the sheet
name followed by an exclamation point. Note this example of a formula that uses a
cell reference in a different worksheet (Sheet2):

=Sheet2!Al+1

You can also create link formulas that refer to a cell in a different workbook. To
do so, precede the cell reference with the workbook name (in square brackets), the
worksheet name, and an exclamation point like this:

=[Budget.x1s]JSheetl!Al+1

If the workbook name in the reference includes one or more spaces, you must
enclose it (and the sheet name) in single quotation marks. For example:

='[Budget Analysis.x1s]Sheetl'!Al+Al

If the linked workbook is closed, you must add the complete path to the work-
book reference. For example:

="C:\MSOffice\Excel\[Budget Analysis.xls]Sheetl'!Al+Al
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Although you can enter link formulas directly, you also can create the reference
by using normal pointing methods discussed earlier. To do so, make sure you have
an open source file. Normally, you can create a formula by pointing to results in
relative cell references. But, when you create a reference to a workbook by point-
ing, Excel creates absolute cell references (if you plan to copy the formula to other
cells, you must edit the formula to make the references relative).

Working with links can be tricky and may cause some unexpected problems.
For example, if you use the File > Save As command to make a backup copy

of the source workbook, you automatically change the link formulas to refer
to the new file (not usually what you want). You also can mess up your links
by renaming the source workbook file.

Making an Exact Copy of a Formula

When you copy a formula, Excel adjusts the formula’s cell references when you
paste it to a different location. This is usually exactly what you want. Sometimes,
however, you may want to make an exact copy of the formula. You can do this by
converting the cell references to absolute values, as discussed earlier — but this isn’t
always desirable.

A better approach is to select the formula while in edit mode and then copy it to
the Clipboard as text. There are several ways to do this. Here I present a step-by-
step example of how to make an exact copy of the formula in A1 and copy it to A2:

Using Links to Recover Data in a Corrupt File

At some point, you may find one of your Excel workbooks damaged or corrupt. If you
cannot load a corrupt workbook, you can write a link formula to recover all or part of
the data (but not the formulas). You can do this because you do not need to have the
source file in a link formula open. If your corrupt file is named Badfile.xls, for example,
open a blank workbook and enter the following formula into cell A1 to attempt to
recover the data from Sheet1:

=[Badfile.x1s]Sheetl!Al

Copy this formula down and to the right to recover as much information as you can.
As a better approach, however, you can maintain a backup of your important files.

If you use Excel 2002, corrupt workbooks are less of a problem because this version
can often repair such files.
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1. Double-click cell A1 to activate edit mode (or, press F2).

2. Press End, followed by Shift+Home to select all of the formula text. Or,
you can drag the mouse to select the entire formula.

3. Click the Copy button on the Standard toolbar (or, press Ctrl+C). This
copies the selected text to the Clipboard.

4. Press Enter to end edit mode.
5. Activate cell A2.

6. Click the Paste button on the Standard toolbar (or, press Ctrl+V). This
operation pastes an exact copy of the formula text into cell A2.

You also can use this technique to copy just part of a formula to use in another
formula. Just select the part of the formula that you want to copy by dragging the
mouse or by using the Shift+arrow keys. Then use any of the available techniques
to copy the selection to the Clipboard. You can then paste the text to another cell.

Formulas (or parts of formulas) copied in this manner won’t have their cell ref-
erences adjusted when you paste them to a new cell. This is because you copy the
formulas as text, not as actual formulas.

Another technique for making an exact copy of a formula is to edit the formula
and remove its initial equal sign. This converts the formula to text. Then, copy the
“non-formula” to a new location. Finally, edit both the original and the copied for-
mula by inserting the initial equal sign.

Converting Formulas to Values

If you have a range of formulas that always produce the same result (i.e., dead for-
mulas), you may want to convert them to values. You can use the Edit— Paste
Special command to do this.
Suppose that range A1:A10 contains formulas that calculate a result and that
never changes. To convert these formulas to values:
1. Select A1:A10.
2. Click the Copy button on the Standard toolbar (or, press Ctrl+C).

3. Select the Edit — Paste Special command. Excel displays its Paste Special
dialog box.

4. Select the Values option button and then click OK.

5. Press Enter or Esc to cancel paste mode.
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If you're using Excel 2002, you can take advantage of a SmartTag.In Step 3 in
& the preceding list, select Edit > Paste (or press Ctrl+V). A Smart Tag will
appear at the lower right corner of the range. Click the Smart Tag and

choose Values Only (see Figure 2-5).

B Book1 [_[O]
A 5] C D E F =
1] il =
| 2 [ 414214
| 3 b 1.732051)
| 4 2
| 5 112 256068 |
| 6 | 2.44945]
7 | 2.645751)
| & /2828427
5] 3
10 |13.162278)
11 -
12 =
13 Keep Source Formatking
| 14 | () Match Destination Formatting
15
5| [ alues oy
17 (1 Walues and Mumber Formatting
118 () Malues and Source Formatting
% (") Keep Source Column Widths
Z (1 Formatting Only
|22 () Link Cells =
|23,
2 -
i« v nhSheet2 ( sheetl / J N oIl

Figure 2-5: in Excel 2002, a Smart Tag appears
after pasting data.

This technique is very useful when you use formulas as a means to convert cells.
For example, assume you have a list of names (in uppercase) in column A. You
want to convert these names to proper case. In order to do so, you need to create
formulas in a separate column; then convert the formulas to values and replace the
original values in column A. The following steps illustrate how to do this.

1. Insert a new column after column A.
2. Insert the following formula into cell B1:
=PROPER(AL)

3. Copy the formula down column B, to accommodate the number of entries
in column A. Column B then displays the values in column A, but in
proper case.

4. Select all the names in column B.
5. Click the Copy button on the Standard toolbar.
6. Select cell Al.
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When to Use AutoFill Rather Than Formulas

Excel's AutoFill feature provides a quick way to copy a cell to adjacent cells. AutoFill
also has some other uses that may even substitute for formulas in some cases. I'm
surprised to find that many experienced Excel users don't take advantage of the
AutoFill feature, which can save a lot of time.

For example, if you need a list of values from 1 to 100 to appear in A1:A100, you can
do it with formulas. You enter 1 in cell A1, the formula =A1+1 into cell A2 and then
copy the formula to the 98 cells below.

You also can use AutoFill to create the series for you without using a formula. To do
so, enter 1 into cell AT and 2 into cell A2. Select A1:A2 and drag the fill handle down
to cell A100. (The fill handle is the small square at the lower right corner of the active
cell.) When you use AutoFill in this manner, Excel analyzes the selected cells and uses
this information to complete the series. If cell AT contains 1 and cell A2 contains 3,
Excel recognizes this pattern and fills in 5, 7, 9, and so on. This also works with
decreasing series (10, 9, 8, and so on) and dates. If there is no discernible pattern in
the selected cells, Excel performs a linear regression and fills in values on the
calculated trend line.

Excel also recognizes common series names such as months and days of the week. If
you enter Monday into a cell and then drag its fill handle, Excel fills in the successive
days of the week. You also can create custom AutoFill lists using the Custom Lists
panel of the Options dialog box. Finally, if you drag the fill handle with the right
mouse button, Excel displays a shortcut menu to enable you to select an AutoFill
option.

7. Select the Edit — Paste Special command. Excel displays its Paste Special
dialog box.

8. Select the Values option button and then click OK.
9. Press Enter or Esc to cancel paste mode.

10. Delete column B.

Hiding Formulas

In some cases, you may not want others to see your formulas. For example, you
may have a special formula you developed that performs a calculation proprietary
to your company. You can use the Format Cells dialog box to hide the formulas
contained in these cells.
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To prevent one or more formulas from being viewed:

1. Select the formula or formulas.

2. Choose Format — Cells. In the Format Cells dialog box, click the Protection
tab.

3. Place a check mark next to the Hidden check box, as shown in Figure 2-6.

4. Use the Tools —> Protection > Protect Sheet command to protect the work-
sheet. To prevent others from unprotecting the sheet, make sure you spec-
ify a password in the Protect Sheet dialog box.

By default, all cells are “locked.” Protecting a sheet prevents any locked cells
from being changed. Therefore, you should unlock any cells that require user input
before protecting your sheet.

Be aware that several password-cracking utilities are available. Therefore,
this technique of hiding your formulas does not ensure that no one can view

your formulas.

Format Cells [X]

Hurnber | Alignment I Font | Border | Patterns  Protection |

¥ Locked
I fiidden

Locking cells or hiding Formulas has no effect unless the
worksheet is protected. To protect the worksheet, choose
Protection from the Tools menu, and then choose Pratect
Sheet, & password is optional.

e

Figure 2-6: Use the Format Cells dialog box
to change the Hidden status of a cell.

Errors in Formulas

It’s not uncommon to enter a formula only to find that the formula returns an error.
Table 2-2 lists the types of error values that may appear in a cell that has a formula.
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Formulas may return an error value if a cell that they refer to has an error value.
This is known as the ripple effect: A single error value can make its way to lots of
other cells that contain formulas that depend on that cell.

TasLE 2-2 EXCEL ERROR VALUES

Error Value

#DIV/O!

#NAME?

#N/A

#NULL!

#NUM!

#REF!

#VALUE!

Explanation

The formula attempts to divide by zero (an operation not allowed on this
planet). This also occurs when the formula attempts to divide by an empty
cell.

The formula uses a name that Excel doesn't recognize. This can happen if
you delete a name used in the formula or if you misspell a function.

The formula refers (directly or indirectly) to a cell that uses the NA function
to signal unavailable data. This error also occurs if a lookup function does
not find a match.

The formula uses an intersection of two ranges that don't intersect.
(I describe this concept later in the chapter.)

A problem occurs with a value; for example, you specify a negative number
where a positive number is expected.

The formula refers to an invalid cell. This happens if the cell has been
deleted from the worksheet.

The formula includes an argument or operand of the wrong type. An
operand refers to a value or cell reference that a formula uses to calculate a
result.

o

If the entire cell fills with hash marks (########4#), this usually means that the
column isn’t wide enough to display the value.You can either widen the col-
umn or change the number format of the cell.The cell will also fill with hash
marks if it contains a formula that returns an invalid date or time.

In Excel 2002, formulas that return an error display a Smart Icon.You can click
this Smart Icon to get more information about the error or to trace the cal-
culation steps that led to the error.Refer to Chapter 21 for more information
about this feature.
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Dealing with Circular References

When you enter formulas, you may occasionally see a message from Excel like the
one shown in Figure 2-7. This indicates that the formula you just entered will result
in a circular reference.

A circular reference occurs when a formula refers to its own value, either
directly or indirectly. For example, if you enter =A1+A2+A3 into cell A3, this pro-
duces a circular reference because the formula in cell A3 refers to cell A3. Every
time the formula in A3 is calculated, it must be calculated again because A3 has
changed. The calculation would go on forever. In other words, the answer never
gets resolved.

Microsoft Excel

Microsoft Excel cannok calculate a Formula, Cell references in the Formula refer to the:
Formula's result, creating a dircular reference. Try ane of the Following:

! E + If you accidentally created the circular reference, click OK, This will display the
Zircular Reference toalbar and help For using it ko correct wour Formula,
« Faor mare information about circular references and how to wark with them, dlick Help,
» T continue leaving the Formula as it is, click Cancel.

Cancel | Help |

Figure 2-7: Excel's way of telling you that your formula
contains a circular reference

When you enter a formula that contains a circular reference, Excel displays a
dialog box with three options:

¢ C(lick OK to attempt to locate the circular reference.
¢ C(lick Cancel to enter the formula as is.

¢ C(lick Help to read more about circular references in the online help.

Normally, you'll want to correct any circular references, so you should choose
OK. When you do so, Excel displays its Circular Reference toolbar (see Figure 2-8).
On the Circular Reference toolbar, click the first cell in the Navigate Circular
Reference drop-down list box, and then examine the cell’s formula. If you cannot
determine whether the cell is the cause of the circular reference, click the next cell
in the Navigate Circular Reference drop-down list box. Continue to review the for-
mulas until the status bar no longer displays Circular.
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Figure 2-8: The Circular Reference toolbar

If you ignore the circular reference message (by clicking Cancel), Excel enables
you to enter the formula and displays a message in the status bar reminding you
that a circular reference exists. In this case, the message reads Circular: A3. If you
activate a different worksheet or workbook, the message simply displays Circular

(without the

Usually, the cause of a circular reference is quite obvious and is, therefore, easy
to identify and correct. Sometimes, however, you will encounter indirect circular
references. In other words, a formula may refer to a formula that refers to a formula
that refers back to the original formula. In some cases, it may require you to do a

There are a few situations in which you may want to use a circular reference

intentionally. Refer to Chapter 16 for some examples.

cell reference).

Excel doesn’t warn you about a circular reference if you have the Iteration
setting turned on. You can check this in the Options dialog box (in the
Calculation panel). If Iteration is on, Excel performs the circular calculation
the number of times specified in the Maximum iterations field (or until the
value changes by less than .001 — or whatever other value appears in the
Maximum change field). You should, however, keep the Iteration setting off
so that you'll be warned of circular references. Generally, a circular reference
indicates an error that you must correct.

bit of detective work to reach the problem.
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Goal Seeking

Many spreadsheets contain formulas that enable you to ask questions, such as,
“What would be the total profit if sales increase by 20 percent?” If you set up your
worksheet properly, you can change the value in one cell to see what happens to
the profit cell.

Goal seeking serves as a useful feature that works in conjunction with your for-
mulas. If you know what a formula result should be, Excel can tell you which val-
ues of one or more input cells you need to produce that result. In other words, you
can ask a question such as, “What sales increase is needed to produce a profit of
$1.2 million?”

Single-cell goal seeking (also known as backsolving) represents a rather simple
concept. Excel determines what value in an input cell produces a desired result in a
formula cell. You can best understand how this works by walking through an
example.

A Goal-Seeking Example

Figure 2-9 shows a mortgage loan worksheet that has four input cells (C4:C7) and
four formula cells (C10:C13). The formulas calculate various values using the input
cell. The formulas are:

C10: =(1-C5)*C4

C11: =PMT(C7/12,C6,-C10)

C12: =C11*Ce

C13: =C12-C10

A B C D

| 1| Mortgage Loan Worksheet

2
| 3 | Input Cells
| 4 | [Purchase Price $325,000
| 6 | [Down Payment 20%
| 6 | |Loan Term (months) 360
| 7 | [Interest Rate 8.00%
]
EN Result Cells
| 10| [Loan Amount $260,000
| 11| [Manthly Payment §1.507.79
| 12| [Total Payments $656,504
13| [Total Interest $426,6804
14

\11 4 » M[\Sheetl /

Figure 2-9: This worksheet presents a good
demonstration of goal seeking.
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Imagine that you're in the market for a new home and you know that you can
afford $1,200 per month in mortgage payments. You also know that a lender can
issue a fixed-rate mortgage loan for 8.00 percent, based on an 80 percent loan-to-
value (a 20 percent down payment). The question is, “What is the maximum pur-
chase price you can handle?” In other words, what value in cell C4 causes the
formula in cell C11 to result in $1,200? You can plug values into cell C4 until C11
displays $1,200. A more efficient approach lets Excel determine the answer.

To answer this question, select Tools = Goal Seek. Excel responds with the Goal
Seek dialog box shown in Figure 2-10. Completing this dialog box resembles form-
ing a sentence. Set cell C11 to 1200 by changing cell C4. Enter this information in
the dialog box by either typing the cell references or by pointing with the mouse.
Click OK to begin the goal-seeking process.

A B [ D E F G =
| 1| Mortgage Loan Worksheet I
2
I Input Cells
| 4 [Purchase Price $325,000
| 6 | [Down Payment 20%
| 6 | |Loan Term (months) 360 Goal Seck
| 7 | [Interest Rate 8.00% Set cel; 5511 ES
8
z Result Cells To ¥alue: 1200
|10 |Loan Armount §260 000 By changing cell: — Jecsq &
| 11| [Manthly Payment $1.907 79
| 12| |Total Payments $586 804 Cancel |
| 13| [Total Interest $426 804
14 ] 4
15
|16
17 -
4 v l\sheet1 / L | a1y

Figure 2-10: The Goal Seek dialog box

Almost immediately, Excel announces that it has found the solution and displays
the Goal Seek Status box. This box tells you the target value and what Excel came
up with. In this case, Excel found an exact value. The worksheet now displays the
found value in cell C4 ($204,425). As a result of this value, the monthly payment
amount is $1,200. Now, you have two options:

¢ C(lick OK to replace the original value with the found value.

¢ C(lick Cancel to restore your worksheet to its original form before you
chose Tools > Goal Seek.

More about Goal Seeking

If you think about it, you may realize that Excel can’t always find a value that pro-
duces the result you're looking for — sometimes a solution doesn’t exist. In such a
case, the Goal Seek Status box informs you of that fact (see Figure 2-11). Other
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times, however, Excel may report that it can’t find a solution, even though you
believe one exists. In this case, you can adjust the current value of the changing
cell to a value closer to the solution, and then reissue the command. If that fails,
double-check your logic, and make sure that the formula cell does indeed depend
on the specified changing cell.

Goal Seek Status [ 2] x]

Goal Seeking with Cell ELO
may not have found a salution.

Cancel
Target walue: -50
Current value:  #HUM! Step
Pause

Figure 2-11: The Goal Seek Status box
tells you if Excel can't find a solution
to your goal-seeking problem.

Like all computer programs, Excel has limited precision. To demonstrate this,
enter =A1"2 into cell A2. Then, select Tools > Goal Seek to find the value in cell A1
that causes the formula to return 16. Excel returns a value of 4.00002269 — close to
the square root of 16, but certainly not exact. You can adjust the precision in the
Calculation panel of the Options dialog box (make the Maximum change value
smaller).

In some cases, multiple values of the input cell produce the same desired result.
For example, the formula =A1"2 returns 16 if cell A1 contains either -4 or +4. If
you use goal seeking when two solutions exist, Excel gives you the solution that
has the same sign as the current value in the cell, or the solution that is nearest to
the current value in the cell.

Perhaps the main limitation of the Tools > Goal Seek command is that it can
find the value for only one input cell. For example, it can’t tell you what purchase
price and what down payment percent result in a particular monthly payment. If
you want to change more than one variable at a time, use Solver.

Summary

This chapter provided an introduction to Excel formulas and covered the various
elements that comprise a formula. The chapter also discussed related topics such as
relative and absolute references, converting formulas to values, formula errors, and
circular references.

The next chapter covers how to work with names in Excel.
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The secret behind names and examples of named constants and named
formulas
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Examples of advanced techniques that use names

MOST INTERMEDIATE AND ADVANCED Excel users are familiar with the concept of
named cells or ranges. Naming cells and ranges is an excellent practice and offers
several important advantages. As you’ll see in this chapter, Excel supports other
types of names — and the power of this concept may surprise you.

What’s in a Name?

You can think of a name as an identifier for something in a workbook. This “some-
thing” can consist of a cell, a range, a chart, a shape, and so on. If you provide a
name for a range, you can then use that name in your formulas. For example, sup-
pose your worksheet contains daily sales information stored in the range B2:B200.
Further, assume that cell C1 contains a sales commission rate. The following for-
mula returns the sum of the sales, multiplied by the commission rate:

=SUM(B2:B200)*C1
This formula works fine, but its purpose is not at all clear. To help clarify the for-

mula, you can define one descriptive name for the daily sales range and another
descriptive name for cell C1. For example, assume that the range B2:B200 is named

57
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DailySales and cell C1 is named CommissionRate. You can then rewrite the formula
to use the names instead of the actual range addresses:

=SUM(DailySales)*CommissionRate

As you can see, using names instead of cell references makes the formula “self-
documenting,” and much easier to understand.
Using named cells and ranges offers a number of advantages:

¢ Names make your formulas more understandable and easier to use, espe-
cially for people who didn’t create the worksheet. Obviously, a formula
such as =Income-Taxes is more intuitive than =D20-D40.

¢ When entering formulas, a descriptive range name (such as Total_Income)
is easier to remember than a cell address (such as AC21). And typing a
name is less error-prone than entering a cell or range address.

€ You can quickly move to areas of your worksheet either by using the
Name box, located at the left side of the formula bar (click the arrow for a
drop-down list of defined names) or by choosing Edit > Go To (or F5) and
specifying the range name.

¢ When you select a named cell or range, its name appears in the Name
box.

¢ You may find that creating formulas is easier if you use named cells. You
can paste a cell or range name into a formula by using the Insert —~
Name — Paste command (or F3).

€ Macros are easier to create and maintain when you use range names
rather than cell addresses.

Methods for Creating Cell
and Range Names

Excel provides several ways to create names for cells and ranges. I discuss these
methods in this section, along with other relevant information that pertains to
names.

Creating Names Using the
Define Name Dialog Box
To create a name for a cell or range, start by selecting the cell or range that you

want to name. Then select Insert > Name — Define (or press Ctrl+F3). Excel displays
the Define Name dialog box, shown in Figure 3-1.
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Define Hame [ 7]

Mames in workbook;
InputRange | 0K I

Refers bo:

[=sheet11ges1:B4e 3

Figure 3-1: Use the Define Name dialog box to create
names for cells or ranges.

Type a name in the field labeled Names in the workbook (or use the name that
Excel proposes, if any). The selected cell or range address appears in the Refers to
field. Verify that the address listed is correct and then click OK to add the name to
your worksheet and close the dialog box. Or, click the Add button to continue
adding names to your worksheet. If you do this, you must specify the Refers to
range either by typing an address (make sure to begin with an equal sign) or by
pointing to it in the worksheet.

A single cell or range can have any number of names. | can't think of a good
reason to use more than one name, but Excel does permit it.If a cell or range
has multiple names, the Name box always displays the first name when you

select the cell or range.

A name can also refer to a noncontiguous range of cells. You can select a non-
contiguous range by pressing the Ctrl key while you select various cells or ranges
with the mouse.

TIP If you try to edit the contents of the Refers to field manually, you'll find that
$M this field is in “point” mode. You can't use keys such as End and Home to edit
\
NS

the field’s contents. To switch from point mode to normal edit mode, press
F2.Then you can use the standard editing keys when the Refers to field is

activated.

Creating Names Using the Name Box

A faster way to create a name involves accessing the Name box. The Name box is
the drop-down box to the left of the formula bar. Select the cell or range to name,
and then click the Name box and type the name. Press Enter to create the name. If
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Rules for Naming Names

Although Excel is quite flexible about the names that you can define, it does have
some rules:

€ Names can't contain any spaces. You might want to use an underscore or a
period character to simulate a space (such as Annual_Total or Annual.Total).

€ You can use any combination of letters and numbers, but the name must
begin with a letter or underscore. A name can't begin with a number (such as
3rdQuarter) or look like a cell reference (such as Q3).

€ You cannot use symbols, except for underscores and periods. Although not
documented, I've found that Excel also permits a backslash (\) and question
mark (?) as long as they don't appear as the first character in a name.

4 Names are limited to 255 characters. Trust me — you should not use a name
anywhere near this length. In fact, doing so defeats the purpose of naming
ranges.

@ You can use single letters (except for R or C), but generally | do not recom-
mend this because it also defeats the purpose of using meaningful names.

4 Names are not case sensitive. The name AnnualTotal is the same as annual-
total. Excel stores the name exactly as you type it when you define it, but it
doesn't matter how you capitalize the name when you use it in a formula.

Excel also uses a few names internally for its own use. Although you can create names
that override Excel's internal names, you should avoid doing so unless you know what
you're doing. Generally, avoid using the following names:: Print_Area, Print_Titles,
Consolidate_Area, Database, Criteria, Extract, FilterDatabase, and Sheet_Title.

a name already exists, you can’t use the Name box to change the range to which
that name refers. Attempting to do so simply selects the original range. You must
use the Define Name dialog box to change the reference for a name.

When you type a name in the Name box, you must press Enter to actually
record the name. If you type a name and then click in the worksheet, Excel

won't create the name.

The Name box serves double-duty by also providing a quick way to activate a
named cell or range, as shown in Figure 3-2. To select a named cell or range, click
the Name box and choose the name. This selects the named cell or range. Oddly, the
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Name box does not have a keyboard shortcut. In other words, you can’t access the
Name box by using the keyboard; you must use a mouse. After you click the Name
box, however, you can use the direction keys and Enter to choose a name.

Bl Microsoft Excel - Book2

Ele Edt Yiew Insert Format

EHeaR SRAY &0

B 7

£ Arial =10 -

£

E
Agr A8 | © ]
Dec
Feb
Jan
Jul
Jun
|7
| 8 |
9

Figure 3-2: The Name box provides a quick way to activate
a named cell or range.

Creating Names Automatically

You may have a worksheet containing text that you want to use for names of adja-
cent cells or ranges. Figure 3-3 shows an example of such a worksheet. In this case,
you might want to use the text in column A to create names for the corresponding
values in column B. Excel makes this very easy to do.

B Book2 [_ O] ]

A B T D Bl

| 1 [Month Sales &
| 2 |Jan 25984
| 3 |Feb 28273
| 4 |Mar 21883
| 5 |Apr 32,744
| 6 |May 31,262
| 7 [Jun 27 005
| 8 |Jul 31982
| 9 |Aug 33321
| 10 |Sep 27 440
| 11 |Oct 26,123
| 12 |Mow 29831
| 13 |Dec 18,732

14 -

4 4+ H[ySheet1 JEN L”Jé

Figure 3-3: Excel makes it easy to create names by using
text in adjacent cells.

To create names by using adjacent text, start by selecting the name text and the
cells that you want to name (these can consist of individual cells or ranges of cells).
The names must be adjacent to the cells that you're naming (a multiple selection is
allowed). Then choose Insert > Name — Create (or Ctrl+Shift+F3). Excel displays the
Create Names dialog box, shown in Figure 3-4.
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The check marks in this dialog box are based on Excel’s analysis of the selected
range. For example, if Excel finds text in the first row of the selection, it proposes
that you create names based on the top row. If Excel doesn’t guess correctly, you
can change the check boxes. Click OK and Excel creates the names. Note that when
Excel creates names using text in cells, it does not include those text cells in the
named range.

[ E
A 5] C D E F G H —
| 1 Month Sales
| 2 |Jan 259584
3 |Feb 26 973
2 |Mar 21983 Create Names HE
| 6 |Apr 32,744 Create names in
| B |mday 31 852 m| i
[ 7 oun 27 008 % Left column
| G fdul 31,982 ™ Bottom rovw
| & [Aug EEE ] I Right colurn
| 10 |Sep 27 440 b
11 |Qet 26,123
— ' Ok [ |
Bl e I ==
13 |Dec 18,732
14 -
|<1 4 » ¥[\Sheetl / 1 | L“—A‘

Figure 3-4: The Create Names dialog box

If the text in a cell would result in an invalid name, Excel modifies the name to
make it valid. For example, if a cell contains the text Net Income (invalid for a
name because it contains a space), Excel converts the space to an underscore char-
acter and creates the name Net_Income. If Excel encounters a value or a formula
instead of text, however, it doesn’t convert it to a valid name. It simply doesn’t cre-
ate a name.

Double-check the names that Excel creates. Sometimes, the Insert—
Name —> Create command works counter-intuitively. Figure 3-5 shows a
small table of text and values. If you select the entire table, choose Insert —
Name — Create, and accept Excel’s suggestions (Top row and Left column
options). You'll find that the name Products doesn’t refer to A2:A6, as you
may expect, but instead refers to B2:C6. If the upper-left cell of the selection
contains text and you choose the Top row and Left column options, Excel
uses that text for the name of the entire set of data — excluding the top row
and left column. So, before you accept the names that Excel creates, take a
minute to make sure that they refer to the correct ranges.
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A B c D E =
| 1 |Products Quantity Price
| 2 |Pencils 433 0.29
| 3 |Paper 109 3.89
| 4 |Erasers 4 0.7e
| 5 |Pens 209 129
| B [Notepads =] 329
| 7 |
1 & | -
i 4 v [ Sheetl } Sheet? / 1] LlJ_J

Figure 3-5: Creating names from the data in this table may
produce unexpected results.

Naming Entire Rows and Columns

Sometimes it makes sense to name an entire row or column. Often, a worksheet is
used to store information that you enter over a period of time. The sheet in Figure
3-6 is an example of such a worksheet. If you create a name for the data in column
B, you need to modify the name’s reference each day you add new data. The solu-
tion is to name the entire column.

A B C D E F =
| 1 [Date Sales =
| 2| Jan 1 843
| 3 | Jan 2 874
| 4 | Jan 3 788
| 5 | Jan 4 872

4] Jan 5 BE5
| 7| Jan B 434
| 8 | Jan?
| 9 | Jan B
| 10 | Jan 8
| 11| Jan 10
| 12|  Jan 11
|13  Jan12 -
i 4 » iy Shestl § Shestz }Sheet3 / K1 »il

Figure 3-6: This worksheet, which tracks daily sales, uses
a named range that consists of an entire column.

For example, you might name column B DailySales. If this range were on
Sheet3, its reference would appear like this:

=Sheet3!$B:$B

After defining the name, you can use it in a formula. The following formula, for
example, returns the sum of all values in column B:

=SUM(DailySales)
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Names Created by Excel

Excel creates some names on its own. For example, if you set a print area for a
sheet, Excel creates the name Print_Area. If you set repeating rows or columns for
printing, you also have a worksheet-level name called Print_Titles. When you exe-
cute a query that returns data to a worksheet, Excel assigns a name to the data that
is returned. Also, many of the add-ins that ship with Excel create hidden names (see
the “Hidden Names” sidebar).

You can modify the reference for any of the names that Excel creates automati-
cally, but make sure that you understand the consequences.

Hidden Names

Some Excel macros and add-ins create hidden names. These names exist in a
workbook, but don't appear in the Define Name dialog box or the Name box. For
example, the Solver add-in creates a number of hidden names. Normally, you can just
ignore these hidden names. However, sometimes these hidden names create problems.
If you copy a sheet to another workbook, the hidden names are also copied, and they
may create a link that is very difficult to track down.

Excel doesn't make it very easy to work with names. For example, you have no way of
viewing a complete list of names defined in a workbook. When you use the Define
Name dialog box, it lists only the worksheet-level names in the active worksheet. And
it never displays hidden names.

If you'd like a better tool to help you work with names, you can use the Name Lister
utility, which is part of the Power Utility Pak. This utility displays a list of all names,
and you can filter the list in a number of ways — for example, you can show only
sheet-level names, or show only linked names. The utility is also useful for identifying
and deleting “bad" names — names that refer to an invalid range. | included a trial
version of the Power Utility Pak on the companion CD-ROM.

MName Lister

Mames in Bookz

(o Al names

1 workbook-level names

Erasers € shest-level names
Feb ~

Jan Hidden names

M € Linked names

Jun

Mar € Bad names

May ~

Notepads = By shest o

=Sheet31$6:46

[3)|  Delete | Goto | gnhidel gepnrtl Close |
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Creating Multisheet Names

Names can extend into the third dimension; in other words, they can extend across
multiple worksheets in a workbook. You can’t simply select the multisheet range
and enter a name in the Name box, however. You must use the Define Name dialog
box to create a multisheet name. The format for a multisheet reference looks like
this:

FirstSheet:LastSheet!RangeReference

In Figure 3-7, a multisheet name (DataCube), defined for A1:C3, extends across
Sheet1, Sheet2, and Sheet3.

B Book3 [Group] H[=] E3 1
| 1} 1 2 3 I—
| 2 | 3 4 5
3 7 g g
1
| 5 | Define Mame [x]
| & | MNames in workboaok:
% DataCube | oK |
El EN
11 i
12
B ooz |
14
15 -
16 =
7 Refers ta:
I 1g | ='Shest1:Sheet3'1$A31:5C43 j‘_] —

w0
1

4 4 » H]\Sheet1 { Sheste f Sheets K] | EIZ

Figure 3-7: Creating a multisheet name

You can, of course, simply type the multisheet range reference into the Refers to
field. But if you want to create the name by pointing to the range, you’ll find it a
bit tricky. Even if you begin by selecting a multisheet range, Excel does not use this
selected range address in the Define Name dialog box.

Follow this step-by-step procedure to create a name called DataCube that refers
to the range A1:C3 across three worksheets (Sheet1, Sheet2, and Sheet3):

1. Activate Sheet].

2. Choose Insert > Name — Define (or press Ctrl+F3) to display the Define
Name dialog box.

3. Type DataCube in the Names in workbook field.

4. Activate the Refers to field, and press Del to delete the range reference.
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5. Select the range A1:C3 in Sheet1. The following appears in the Refers to
field:

=Sheetl!$A$1:$C$3

6. Press Shift and then click the Sheet tab for Sheet3. You'll find that Excel
inexplicably changes the range reference to a single cell. At this point, the
following appears in the Refers to field:

='Sheetl:Sheet3'!$AS$1

7. Reselect the range A1:C3 in Sheet1. The following appears in the Refers to
field:

='Sheetl:Sheet3'!1$A$1:$C$3

8. Since the Refers to field now has the correct multisheet range address,
click OK to close the Define Name dialog box.

After you define the name, you can use it in your formulas. For example, the fol-
lowing formula returns the sum of the values in the range named DataCube.

=SUM(DataCube)

o

Multisheet names do not appear in the Name box or in the Go To dialog box
(which appears when you select Edit - Go To). In other words, Excel enables

you to define the name, but it doesn’t give you a way to automatically select

the cells to which the name refers.

If you insert a new worksheet into a workbook that uses multisheet names, the
multisheet names will include the new worksheet —as long as the sheet resides
between the first and last sheet in the name’s definition. In the preceding example,
a worksheet inserted between Sheet1 and Sheet2 will be included in the DataCube
range. But a worksheet inserted before Sheet1 or after Sheet 3 will not be included.

If you delete the first or last sheet included in a multisheet name, Excel changes
the name’s range in the Refers to field automatically. In the preceding example,
deleting Sheet1 causes the Refers to range of DataCube to change to:

='Sheet2:Sheet3'!$A$1:$C$3

A Name’s Scope

Normally, when you name a cell or range, you can use that name in all worksheets
in the workbook. For example, if you create a name called RegionTotal that refers
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to the cell A1 on Sheetl, you can use this name in any formula in any worksheet.
This is referred to as a workbook-level name (or a global name). By default, all cell
and range names are workbook-level names.

Creating Worksheet-Level Names

What if you have several worksheets in a workbook and you want to use the same
name (such as RegionTotal) on each sheet? In this case, you need to create worksheet-
level names (sometimes referred to as local names).

To define a worksheet-level name RegionTotal, activate the worksheet in which
you want to define the name and choose Insert > Name — Define. The Define Name
dialog box then appears. In the Names in workbook field, precede the worksheet-
level name with the worksheet name, followed by an exclamation point. For exam-
ple, to define the name RegionTotal on Sheet2, activate Sheet2 and enter the
following in the Names in workbook field of the Define Name dialog box:

Sheet2!RegionTotal

If the worksheet name contains at least one space, enclose the worksheet name
in single quotation marks, like this:

'Marketing Dept'!RegionTotal

You can also create a worksheet-level name by using the Name box. Select the
cell or range you want named, click in the Name box, and type the name. Make
sure you precede the name with the sheet’s name and an exclamation point (as
shown above). Press Enter to create the name.

When you write a formula that uses a worksheet-level name on the sheet in
which you defined it, you don’t need to include the worksheet name in the range
name (the Name box won’t display the worksheet name either). If you use the name
in a formula on a different worksheet, however, you must use the entire name (sheet
name, exclamation point, and name).

o

Combining Worksheet- and
Workbook-Level Names

Using worksheet-level names can be a bit confusing because Excel lets you define
worksheet-level names even if the workbook contains the same name as a workbook-
level name. In such a case, the worksheet-level name takes precedence over the

Only the worksheet-level names on the current sheet appear in the Name
box.Similarly, only worksheet-level names in the current sheet appear in the
list when you open the Paste Name or Define Name dialog boxes.
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workbook-level name, but only in the worksheet in which you defined the sheet-
level name.

For example, you can define a workbook-level name of Total for a cell on
Sheet1. You can also define a worksheet-level name of Sheet2!Total. When Sheet2
is active, Total refers to the worksheet-level name. When any other sheet is active,
Total refers to the workbook-level name. Confusing? Probably. To make your life
easier, I recommend that you simply avoid using the same name at the workbook
level and worksheet level.

Referencing Names from Another Workbook

Chapter 2 described how to use links to reference cells or ranges in other work-
books. The same rules apply when using names defined in another workbook.

For example, the following formula uses a range named MonthlySales, defined
in a workbook named Budget.xls (which is assumed to be open):

=AVERAGE (Budget.x1s!MonthlySales)

Working with Range and Cell Names

Once you create range or cell names, you can work with them in a variety of ways.
This section describes how to perform common operations with range and cell
names.

Creating a List of Names

If you create a large number of names, you may need to know the ranges that each
name refers to, particularly if you're trying to track down errors or document your
work.

You might want to create a list of all names (and their corresponding addresses)
in the workbook. To create a list of names, first move the cell pointer to an empty
area of your worksheet (the two-column name list, created at the active cell posi-
tion, overwrites any information at that location). Use the Insert > Name — Paste
command (or press F3). Excel displays the Paste Name dialog box (see Figure 3-8)
that lists all the defined names. To paste a list of names, click the Paste List button.

Paste Name [ 2] x]

Paste name

Paste List | (o4 I Cancel |

Figure 3-8: The Paste Name dialog box
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The list of names does not include worksheet-level names that appear in
sheets other than the active sheet.

The list of names pasted to your worksheet occupies two columns. The first col-
umn contains the names, and the second column contains the corresponding range
addresses. The range addresses in the second column consist of text strings that
look like formulas. You can convert such a string to an actual formula by editing
the cell (press F2, then press Enter). The string then converts to a formula. If the
name refers to a single cell, the formula displays the cell’s current value. If the
name refers to a range, the formula returns a #VALUE! error.

Using Names in Formulas

After you define a name for a cell or range, you can use it in a formula. If the name
is a workbook-level name (the default type), you can use the name in any sheet in
the workbook. Just enter the name in place of the cell reference. For example, the
following formula calculates the sum of the values in the range named UnitsSold:

=SUM(UnitsSold)

When you write a formula that uses a worksheet-level name on the sheet in
which it’s defined, you don’t need to include the worksheet name in the range
name. If you use the name in a formula on a different worksheet, however, you
must use the entire name (sheet name, exclamation point, and name). For example,
if the name UnitsSold represents a worksheet-level name defined on Sheetl, the
following formula (on a sheet other than Sheetl) calculates the total of the
UnitsSold range:

=SUM(Sheetl!UnitsSold)

As you type a formula, you can select Insert > Name — Paste (or simply press F3)
to display the Paste Name dialog box. Select a name from the list, click OK, and
Excel inserts that name into your formula. As I previously mentioned, the Paste
Name dialog box lists all workbook-level names, plus worksheet-level names for
the active sheet only.

If you use a nonexistent name in a formula, Excel displays a #NAME? error,
indicating that it cannot find the name you are trying to use. Often, this means that
you misspelled the name.
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Using the Intersection Operators with Names

Excel’s range intersection operator is a single space character. The following for-
mula, for example, displays the sum of the cells at the intersection of two ranges:
B1:C20 and A8:D8:

=SUM(B1:C20 A8:D8)

The intersection of these two ranges consists of two cells: B8 and C8.

The intersection operator also works with named ranges. Figure 3-9 shows a
worksheet containing named ranges that correspond to the row and column labels.
For example, the name January refers to B2:E2 and the name North refers to
B2:B13. The following formula returns the contents of the cell at the intersection of
the January range and the North range:

=January North

i Boo e |
A B c D E Ny
[ 1] North South West East Il
[ 2 |January 48 313 353 251
| 3 |February 354 181 47 190
| 4 |March 138 257 2654 a7
5 | April 244 110 308 ava
| B |May 103 407 475 253
| 7 |June 24 222 45 266
| & |July a5 196 24 457
[ 9 |August 206 i 431 125
[ 10 | Septernber 333 455 201 335 -
| 11 |October 31 a8 450 32
[ 12 |Movermber 260 328 475 358
13 |December 446 105 165 356
14 .
W 4 b »i\Sheet1 / 1] ﬂJJJ

Figure 3-9: This worksheet contains named ranges
that correspond to row and column labels.

Using a space character to separate two range references or names is known as
explicit intersection because you explicitly tell Excel to determine the intersection
of the ranges. Excel, however, can also perform implicit intersections. An implicit
intersection occurs when Excel chooses a value from a multicell range based on the
row or column of the formula that contains the reference. An example should clear
this up. Figure 3-10 shows a worksheet that contains a range (B3:B8) named
MyData. Cell D5 contains the simple formula shown here:

=MyData
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Natural Language Formulas? Just Say No!

Beginning with Excel 97, you can use worksheet labels in your formulas, even if you
haven't officially defined the names. Microsoft calls this “natural language formulas."
For example, the workbook, shown in the accompanying figure, contains no defined
names.

A B c D E F Gj
[ 1 Region 1 Region2 Region 3
| 2 |January 3436 4243 G4
| 3 |February 4718 2787 865
| 4 |March 3582 395 =%l
| 5 | April 4711 4653 2004
| B May 642 1158 4044
| 7 |June 38 779 1111
| B July 3458 1335 4072
| 8 |August 666 2114 1395
[ 10 | Septernber 337 3064 2668
| 11 October 4524 4677 2244
[ 12 |MNaovember 151 2477 2174
13 December 1237 4519 3265
14 S
W 4 b b[\Sheetl / 141 ﬂJJJ

Excel, however, can interpret the row and column labels. For example, the following
formula returns the sum of the values in the row labeled January:

=SUM(January)

You can also make use of the column labels. The following formula, for instance,
returns the sum of the values for Region 1:

=SUM(Region 1)

You can even use multiple labels in a formula. This next formula returns 2787, the
value at the intersection of February and Region 2:

=February Region 2

Using natural language formulas may seem like an easy way to get the benefits of
names without going through the trouble of defining names. However, this feature
sometimes does not work as advertised. Formulas that use these “pseudonames”
sometimes do not get calculated when the data changes. Even worse, two identical
formulas may return different results! Another problem is that, unlike a real named
range, you really have no way of determining how Excel interprets a particular label.
Finally, Excel imposes a limit of 32,764 natural language formulas; try to use more
and Excel will probably crash.

| strongly recommend that you simply ignore this feature and use real names instead.
To disable natural language formulas, select Tools — Options. In the Options dialog box
that appears, click the Calculation tab, and uncheck the Accept labels in formulas

Continued
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Natural Language Formulas? Just Say No! (Continued)

option. This setting is stored with each workbook, so if you open a file that uses
natural languages formulas, you may want to turn it off for that file. When you turn
this feature off, Excel scans your formula and converts any labels to actual cell
references.

A 5] C 8] E F 3

12
I 18]
]
24
36
48

fus) [a2]

=)

» [} Sheet IE1] | L”;J‘

Figure 3-10: Range B3:B8 in this worksheet is named MyData.
Cell D5 demonstrates an implicit intersection.

Notice that cell D5 displays the value from MyData that corresponds to the for-
mula’s row. Similarly, if you enter the same formula into any other cell in rows 3
through 8, the formula displays the corresponding value from MyData. Excel per-
forms an implicit intersection using the MyData range and the row that contains
the formula. It’s as if the following formula is being evaluated:

=MyData 5:5

If you enter the formula in a row not occupied by MyData, the formula returns
an error because the implicit intersection returns nothing,.

By the way, implicit intersections are not limited to named ranges. In the pre-
ceding example, you get the same result if cell D5 contains the following formula
(which doesn’t use a named range):

=$B$2:$B$8

Using the Range Operator with Names

You can also use the range operator, which is a colon (:), to work with named
ranges. Refer back to Figure 3-9. For example, this formula returns the sum of the
values for North through West for January through March (nine cells):

=SUM((North January):(West March))
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Referencing a Single Cell in
a Multicell Named Range

You can use Excel’s INDEX function to return a single value from a multicell range.
Assume that range A1:A50 is named DataRange. The following formula displays
the second value (the value in A2) in DataRange:

=INDEX(DataRange,?2)

The second and third arguments for the INDEX function are optional, although
at least one of them must always be specified. The second argument (used in the
preceding formula) is used to specify the row offset within the DataRange range.

If DataRange consists of multiple cells in a single row, use a formula like the fol-
lowing one. This formula omits the second argument for the INDEX function, but
uses the third argument that specifies the column offset with the DataRange range:

=INDEX(DataRange,,?)

If the range consists of multiple rows and columns, use both the second and
third arguments for the INDEX function. For example, this formula returns the
value in the fourth row and fifth column of a range named DataRange:

=INDEX(DataRange,4,5)

Applying Names to Existing Formulas

When you create a name for a cell or range, Excel does not scan your formulas
automatically and replace the cell references with your new name. You can, how-
ever, tell Excel to “apply” names to a range of formulas.

Select the range that contains the formulas that you want to convert. Then
choose Insert > Name —> Apply. The Apply Names dialog box will appear, as shown
in Figure 3-11. In the Apply Names dialog box, select which names you want
applied to the formulas. Only those names that you select will be applied to the
formulas.

Apply Mames [ 7]

Apply names:

=] oK |
Cancel
Cptions =5

¥ lanare Relative/Absalute
¥ Use row and column names

Figure 3-11: The Apply Names dialog box
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TIP To apply names to all the formulas in the worksheet, select a single cell
‘&% before you choose Insert - Name — Apply.
\

v

The Ignore Relative/Absolute check box controls how Excel substitutes the range
name for the actual address. A cell or range name is usually defined as an absolute
reference. If the Ignore Relative/Absolute check box is checked, Excel applies the
name only if the reference in the formula matches exactly. In most cases, you will
want to ignore the type of cell reference when applying names.

If the Use row and column names check box is checked, Excel takes advantage
of the intersection operator when applying names. Excel uses the names of row and
column ranges that refer to the cells if it cannot find the exact names for the cells.
Excel uses the intersection operator to join the names. Clicking the Options button
displays some additional options that are available only when you have the Use
row and column names check box checked.

Applying Names Automatically
when Creating a Formula

When you insert a cell or range reference into a formula by pointing, Excel auto-
matically substitutes the cell or range name if it has one.

ol

In some cases, this feature can be very useful. In other cases, it can be annoying;
you may prefer to use an actual cell or range reference instead of the name.
Unfortunately, you cannot turn off this feature. If you prefer to use a regular cell or
range address, you need to type the cell or range reference manually (don’t use the
pointing technique).

This behavior occurs only in Excel 97 and later.

Unapplying Names

Excel does not provide a direct method for unapplying names. In other words, you
cannot replace a name in a formula with the name’s actual cell reference automat-
ically. However, you can take advantage of a trick described here. You need to
change Excel’s Transition formula entry option so it emulates 1-2-3. Select Tools —
Options, and click the Transition tab in the Options dialog box. Place a check mark
next to Transition formula entry, and click OK.
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Next, press F2 to edit a formula that contains one or more cell or range names.
The formula displays the actual range references instead of the names (the formula
bar, however, continues to show the range names). Press Enter to end cell editing.
Next, go back to the Options dialog box and remove the check mark from the
Transition formula entry check box. You'll find that the edited cell no longer uses
names.

The Power Utility Pak includes a utility that enables you to unapply names in
selected formulas. The companion CD-ROM contains a trial version of the
Power Utility Pak.

Deleting Names

If you no longer need a defined name, you can delete it. Deleting a range name
deletes the name only. It does not delete the contents of the range. Choose Insert —
Name — Define to display the Define Name dialog box. Choose the name that you
want to delete from the list and then click the Delete button.

Be extra careful when deleting names. If the name is used in a formula, delet-
ing the name causes the formula to become invalid (it will display #fNAME?).

It would be very helpful if Excel simply replaced all references to the name
with the actual cell or range reference of the deleted name — but it doesn't.
However, you can undo the act of deleting a name, so if you find that formu-
las return #NAME? after you delete a name, select Edit —> Undo to get the
name back.

Deleting Named Cells or Ranges

If you delete the rows or columns that contain named cells or ranges, the names
will not be deleted (as you might expect). Rather, each name will contain an invalid
reference. For example, if cell A1 on Sheet1 is named Interest and you delete row 1
or column A, Interest then refers to =Sheet1!#REF! (i.e., an erroneous reference). If
you use Interest in a formula, the formula displays #REF.

In order to get rid of this erroneous name, you must delete the name manually
using the Insert > Name — Define command. Or, you can redefine the name so it
refers to a valid cell or range.
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Redefining Names

After you define a name, you may want to change the cell or range to which it
refers. Select Insert -~ Name — Define to display the Define Name dialog box. Select
the name that you want to change, and then edit the cell or range address in the
Refers to field. If you prefer, you can click the Refers to field and select a new cell
or range by pointing in the worksheet.

Changing Names

Excel doesn’t provide a simple way to change a name once you create one. If you
create a name and then realize that you prefer a different name — or, perhaps, that
you spelled it incorrectly — you must create the new name and then delete the old
name. In the Define Name dialog box, select the old name in the list of names,
change the text in the Names in workbook field to the new name, and click the Add
button. Then select the old name again and click the Delete button.

When you change a name, Excel does not automatically adjust formulas that use
the name. You can, however, use the Edit > Replace command to find and replace
occurrences of the old name with the new name.

Viewing Named Ranges

When you zoom a worksheet to 39 percent or lower, you see a border around the
named ranges with the name displayed in blue letters, as shown in Figure 3-12. The
border and name do not print; they simply help you visualize the named ranges on
your sheet.

O
r
8| O
en

Caleylatidns

T T T O T A T T T OO A T T T

o !Eheetz‘ sheetl — JEN | | LULJ
Figure 3-12: Excel displays range names when you
zoom a sheet to 39 percent or less.
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This feature is available only in Excel 97 or later.

o

Using Names in Charts

When you create a chart, each data series has an associated SERIES formula. The
SERIES formula contains references to the ranges used in the chart. If you have a
defined range name, you can edit a SERIES formula and replace the range reference
with the name.

Refer to Chapter 17 for additional information about charts.

How Excel Maintains Cell
and Range Names

Once you create a name for a cell or range, Excel automatically maintains the name
as you edit or modify the worksheet. The following examples assume that Sheet1
contains a workbook-level name (MyRange) that refers to =Sheet1!$C$3:$E$5 (a
nine-cell range).

Inserting a Row or Column

When you insert a row above the named range or insert a column to the left of the
named range, Excel changes the range reference to reflect its new address. For
example, if you insert a new row 1, MyRange then refers to =Sheet1!$C$4:$E$6.

If you insert a new row or column within the named range, the named range
expands to include the new row or column. For example, if you insert a new col-
umn to the left of column E, MyRange then refers to =Sheet1!$C$3:$F$5.

Deleting a Row or Column

When you delete a row above the named range or delete a column to the left of the
named range, Excel adjusts the range reference to reflect its new address. For
example, if you delete row 1, MyRange refers to =Sheet1!$B$3:$D$5.

If you delete a row or column within the named range, the name range adjusts
accordingly. For example, if you delete column D, MyRange then refers to
=Sheet1!$C$3:$D$5.
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If you delete all rows or all columns that make up a named range, the named
range continues to exist, but it contains an error reference. For example, if you
delete columns C, D, and E, MyRange then refers to =Sheet1!#REF!. Any formulas
that use the name also return errors.

Cutting and Pasting

When you cut and paste an entire named range, Excel changes the reference
accordingly. For example, if you move MyRange to a new location beginning at cell
A1, Excel MyRange then refers to =Sheet1!$A$1:$C$3. Cutting and pasting only a
part of a named range does not affect the name’s reference.

Potential Problems with Names

Names are great, but they can also cause some problems. This section contains
information that you should remember when you use names in a workbook.

Name Problems When Copying Sheets

Excel, as you know, lets you copy a worksheet within the same workbook, or to a
different workbook. Let’s focus first on copying a sheet within the same workbook.
If the copied sheet contains worksheet-level names, those names will also be pre-
sent on the copy of the sheet, adjusted to use the new sheet name. Usually, this is
exactly what you want to happen. But if the workbook contains a workbook-level
name that refers to a cell or range on the sheet that’s copied, that name will also be
present on the copied sheet. However, it will be converted to a worksheet-level
name! That is usually not what you want to happen.

Consider a workbook that contains one sheet (Sheetl). This workbook has a
workbook-level name (called BookName) for cell A1, and a worksheet-level name
(called Sheet1!LocalName) for cell A2. If you make a copy of Sheetl within the
workbook, the new sheet is named Sheet1 (2). You'll find that, after copying the
sheet, the workbook contains four names, listed and described in Table 3-1.

TasLeE 3-1 NAMES IN A WORKBOOK AFTER COPYING A SHEET

Name Refers To Type

BookName =Sheet1!$A$1 Workbook-level
Sheet1!LocalName =Sheet1!$A$2 Worksheet-level
Sheet1 (2)'!BookName ='Sheet1 (2)'I$A$1 Worksheet-level

Sheet1 (2)'!LocalName ='Sheet1 (2)'I$A$2 Worksheet-level
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This proliferation of names when copying a sheet is not only confusing, but can
result in errors that can be very difficult to identify. In this case, typing the follow-
ing formula on the copied sheet displays the contents of cell A1 in the copied sheet:

=BookName

In other words, the newly created worksheet-level name (not the original
workbook-level name) is being used.

If you copy the worksheet from a workbook containing a name that refers to a
multisheet range, you also copy this name. A #REF! error appears in its Refers to
definition.

When you copy a sheet to a new workbook, all of the names in the original
workbook that refer to cells on the copied sheet are also copied to the new work-
book. This includes both workbook-level and worksheet-level names.

Copying and pasting cells from one sheet to another does not copy names,
even if the copied range contains named cells.

Bottom line? You must use caution when copying sheets from a workbook that
uses names. After copying the sheet, check the names and delete those that you
didn’t intend to be copied.

Name Problems when Deleting Sheets

When you delete a worksheet that contains cells used in a workbook-level name,
you'll find that the name is not deleted. The name remains with the workbook, but
it contains an erroneous reference in its Refers to definition.

Figure 3-13 shows the Define Name dialog box that displays an erroneous name.
The workbook originally contained a sheet named Sheetl, which had a named
range (a workbook-level name, MyRange) for A1:F12. After deleting Sheetl1, the
name MyRange still exists in the workbook, but the Refers to field in the Define
Name dialog box displays the following:

=ffREFI$A$1:$F$12
As far as I can tell, keeping erroneous names in a workbook doesn’t cause any

harm, but it’s still a good practice to delete all names that contain an erroneous
reference.
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Naming Charts and Objects

When you add a chart or any other type of object to a worksheet, the object has a
default name. For example, the first chart on a worksheet is named Chart 7. When you
add a shape (such as a Rectangle or TextBox), the name reflects the type of object (for
example, Rectangle 3).

To change the name of an object, select it, type the new name in the Name box, and
press Enter. Naming charts is an exception. To rename a chart, you must first select
the entire chart object (the container for the chart). To do so, press Ctrl while you click
the chart.

Excel is a bit inconsistent with regard to the Name box. Although you can use the
Name box to rename an object, the Name box does not display a list of objects. To
select an object using the Name box, you must type the exact name of the object.
Also, you'll find that the Define Name dialog box does not list the names of objects.

Define Name [ 7]

Mames in workbook:
IMyRange

Ok |
= Close:
Add
Delete

|
Refers ko:

[=#reFipasiigcss 5=

Figure 3-13: Deleting the sheet that contains the cell for
MyRange causes an erroneous reference.

The Secret to Understanding Names

Excel users often refer to named ranges and named cells. In fact, ['ve used these
terms frequently throughout this chapter. Actually, this terminology is not quite
accurate.

Here’s the secret to understanding names:

When you create a name, you're actually creating a named formula. Unlike a
normal formula, a named formula doesn’t exist in a cell. Rather, it exists in Excel’s

memory.

This is not exactly an earth-shaking revelation, but keeping this “secret” in mind
will help you understand the advanced naming techniques that follow.

When you work with the Define Name dialog box, the Refers to field contains
the formula, and the Names in workbook field contains the formula’s name. You'll
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find that the contents of the Refers to field always begin with an equal sign, which
makes it a formula.

As you can see in Figure 3-14, the workbook contains a name (InterestRate) for
cell B1 on Sheet1. The Refers to field lists the following formula:

=Sheet1!$B$1

Define Mame
Mames in workbook:
IIntsrestRate 0K I
-
Close I
Add
Delete I
Refers ba:
[=sheet11ges1 o

Figure 3-14: Technically, the name InterestRate is a named
formula, not a named cell.

Whenever you use the name InterestRate, Excel actually evaluates the formula
with that name and returns the result. For example, you might type this formula
into a cell:

=InterestRate*1.05

When Excel evaluates this formula, it first evaluates the formula named
InterestRate (which exists only in memory, not in a cell). It then multiplies the
result of this named formula by 1.05 and displays the result. This cell formula, of
course, is equivalent to the following formula, which uses the actual cell reference
instead of the name:

=Sheet1!$B$1*1.05

At this point, you may be wondering if it’s possible to create a named formula
that doesn’t contain any cell references. The answer comes in the next section.

Naming Constants

Consider a worksheet that generates an invoice and calculates sales tax for a sales
amount. The common approach is to insert the sales tax rate value into a cell, and
then use this cell reference in your formulas. To make things easier, you probably
would name this cell something like SalesTa.x.

You can do this another way. Figure 3-15 demonstrates the following steps:
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Name dialog box.

Define Name

Mames in workbook:

. Click OK to close the dialog box.

. Choose Insert > Name — Define (or press Ctrl+F3) to bring up the Define

. Enter the name (in this case, SalesTax) into the Names in workbook field.

. Click the Refers to box, delete its contents, and replace it with a simple
formula, such as =.075

SalesTax

QK

Refers to:

;I Close

=

Delete

add

|=.07s]

|

Figure 3-15: Defining a name that refers to a constant

The preceding steps create a named formula that doesn’t use any cell references.
To try it out, enter the following formula into any cell:

=SalesTax

This simple formula returns .075, the result of the formula named SalesTax. Since
this named formula always returns the same result, you can think of it as a named
constant. And you can use this constant in a more complex formula, such as:

=Al*SalesTax

SalesTax is a workbook-level name, so you can use it in any worksheet in the
workbook.

Naming Text Constants

In the preceding example, the constant consisted of a numeric value. A constant
can also consist of text. For example, you can define a constant for a company’s
name. You can use the Define Name dialog box to create the following formula
named MS:

="Microsoft Corporation"
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Then you can use a cell formula such as:
="Annual Report: "&MS
This formula returns the text Annual Report: Microsoft Corporation.

Names that do not refer to ranges do not appear in the Name box or in the
Go To dialog box (which appears when you press F5). This makes sense,

because these constants don't reside anywhere tangible. They do appear in
the Paste Names dialog box, however, which does make sense, because you'll
use these names in formulas.

As you might expect, you can change the value of the constant at any time by
accessing the Define Name dialog box and simply changing the value in the Refers
to box. When you close the dialog box, Excel uses the new value to recalculate the
formulas that use this name.

Although this technique is useful in many situations, changing the value takes
some time. Having a constant located in a cell makes it much easier to modify. If
the value is truly a “constant,” however, you won’t need to change it.

Using Worksheet Functions in Named Formulas

Figure 3-16 shows another example of a named formula. In this case, the formula
is named ThisMonth, and the actual formula is:

=MONTH(TODAY ())

Define Name H

NMames in workboaok:

Refers to:
[=monTHiToDAY ) =2

Figure 3-16: Defining a named formula that uses
worksheet functions

The formula in Figure 3-16 uses two worksheet functions. The TODAY function
returns the current date and the MONTH function returns the month number of its
date argument. Therefore, you can enter a formula such as the following into a cell
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and it will return the number of the current month. For example, if the current
month is April, the formula returns 4.

=ThisMonth

A more useful named formula would return the actual month name, as text. To
do so, create a formula named MonthName, defined as:

=TEXT(TODAY (), "mmmm")

Now enter the following formula into a cell and it returns the current month
name, as text. In the month of April, the formula returns the text April.

=MonthName

Using Cell and Range References
in Named Formulas

Figure 3-17 shows yet another example of creating a named formula, this time with
a cell reference. This formula, named FirstChar, returns the first character of the
contents of cell A1 on Sheetl. The named formula is:

=LEFT(Sheetl!$A$1,1)

Define Name HE

Marnes in waorkbook:

Refers to:
|=LEFTisheet1 1551, 1) ==

Figure 3-17: Defining a named formula that uses a cell reference

After creating this named formula, you can enter the following formula into a
cell. The formula always returns the first character of cell A1 on Sheet1.

=FirstChar

The next example uses a range reference in a named formula. Figure 3-18 shows
the Define Name dialog box when defining the following named formula (named
Total).

=SUM(Sheetl!$A$1:$D$4)
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Define Hame [ 7]

Mames in workbook;
ITota\

oK |

- Clase I
Add I

Delete |

-
Refers bo:

[=sumishestt as1 504 &l

Figure 3-18: Defining a named formula that uses a range reference

After creating this named formula, you can enter the following formula into any
cell on any sheet. The formula returns the sum of the values in A1:D4 on Sheet1.

=Total

Notice that the cell references in the two preceding named formulas are absolute
references. By default, all cell and range references in named formulas use an
absolute reference, with the worksheet qualifier. But, as you can see in the next sec-
tion, overriding this default behavior by using a relative cell reference can result in
some very interesting named formulas!

Using Named Formulas with Relative References

As I noted previously, when you use the Define Name dialog box to create a named
formula that refers to cells or ranges, the Refers to field always uses absolute cell
references and the references include the sheet name qualifier. In this section, I
describe how to use relative cell and range references in named formulas.

USING A RELATIVE CELL REFERENCE
Let’s begin with a simple example. Follow these steps to create a named formula
that uses a relative reference:
1. Start with an empty worksheet.
Select cell A1 (this step is very important).

Select Insert >~ Name — Define to bring up the Define Name dialog box.

Enter CellToRight in the Names in workbook field.

g ks W N

Delete the contents of the Refers to field, and type the following formula
(don’t point to the cell in the sheet):

=Sheetl!Bl1
6. Click OK to close the Define Name dialog box.
7. Type something (anything) into cell B1.
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8. Enter this formula into cell A1:
=CellToRight

You'll find that the formula in A1 simply returns the contents of cell B1.

Next, copy the formula in cell A1 down a few rows. Then enter some values in col-
umn B. You'll find that the formula in column A returns the contents of the cell to the
right. In other words, the named formula (CellToRight) acts in a relative manner.

You can use the CellToRight name in any cell (not just cells in column A). For
example, if you enter =CellToRight into cell D12, it returns the contents of cell E12.

To demonstrate that the formula named CellToRight truly uses a relative cell ref-
erence, activate any cell other than cell A1 and display the Define Name dialog box
(see Figure 3-19). Select the CellToRight item in the list box and examine the Refers
to field. You'll see that the formula varies, depending on the active cell. For exam-
ple, if cell E5 is selected when the Define Name dialog box is displayed, the formula
for CellToRight appears as:

=Sheetl!F5
Define Name [ 7]
Mames in workbook:
ICellTunght oK I
- Close
Add
Delete
|
Refers ko:
[=sheet1iFs =l

Figure 3-19: The CellToRight named formula varies,
depending on the active cell.

If you use the CellToRight name on a different worksheet, you'll find that it con-
tinues to reference the cell to the right —but it’s the cell with the same address on
Sheet1. This happens because the named formula includes a sheet reference. To
modify the named formula so it works on any sheet, follow these steps:

1. Activate cell A1 on Sheetl.

2. Select Insert > Name — Define to bring up the Define Name dialog box.
3. In the Define Name dialog box, click the CellToRight item in the list box.
4. Delete the contents of the Refers to field, and type this formula:

=1B1

o

Click OK to close the Define Name dialog box.
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After making this change, you'll find that the CellToRight named formula works
correctly on any worksheet in the workbook.

The named formula does not work if you use it in a formula in column IV
because the formula attempts to reference a nonexistent cell (there is no

column to the right of column IV).

USING A RELATIVE RANGE REFERENCE
This example expands upon the previous example, and demonstrates how to create
a named formula that sums the values in 10 cells directly to the right of a particu-
lar cell. To create this named formula, follow these steps:

1. Activate cell Al.

Select Insert > Name —> Define to bring up the Define Name dialog box.

Enter Sum10Cells in the Names in workbook field.

L

Enter this formula in the Refers to field:

=SUM(!B1:!K1)

After creating this named formula, you can insert the following formula into
any cell in any sheet, and it will display the sum of the 10 cells directly to the right:

=Suml0Cells

For example, if you enter this formula into cell D12, it returns the sum of the
values in the 10-cell range E12:N12.

Note that, because cell A1 was the active cell when you defined the named for-
mula, the relative references used in the formula definition are relative to cell Al.
Also note that the sheet name was not used in the formula. Omitting the sheet name
(but including the exclamation point) causes the named formula to work in any
sheet.

If you select cell D12 and then bring up the Define Name dialog box, you'll see
that the Refers to field for the Sum10Cells name displays the following:

=SUM(!E12:IN12)

o

The Sum10Cells named formula does not work if you use it in a cell that
resides in a column beyond column IL.That's because the formula becomes

invalid as it tries to reference a nonexistent cell beyond column IV.
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USING A MIXED RANGE REFERENCE
As I discussed in Chapter 2, a cell reference can be absolute, relative, or mixed. A
mixed cell reference consists of either of the following:

¢ An absolute column reference and a relative row reference (for example,
$A1)

¢ A relative column reference and an absolute row reference (for example,
A$1)

As you might expect, a named formula can use mixed cell references. To demon-
strate, activate cell B1. Use the Define Name dialog box to create a formula named
FirstInRow, using this formula definition:

=1$A1

This formula uses an absolute column reference and a relative row reference.
Therefore, it always returns a value in column A. The row depends on the row in
which you use the formula. For example, if you enter the following formula into

cell F12, it displays the contents of cell A12:

=FirstInRow

ol

You cannot use the FirstinRow formula in column A because it generates a
circular reference — a formula that refers to itself.

Advanced Techniques
That Use Names

This section presents several examples of advanced techniques that use names. The
examples assume that you're familiar with the naming techniques described earlier
in this chapter.

Using the INDIRECT Function with a Named Range

Excel’s INDIRECT function lets you specify a cell address indirectly. For example, if
cell A1 contains the text C45, this formula returns the contents of cell C45:

=INDIRECT(AI)
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The INDIRECT function also works with named ranges. Figure 3-20 shows a
worksheet with 12 range names that correspond to the month names. For example,
January refers to the range B2:E2. Cell B16 contains the following formula:

=SUM(CINDIRECT(A16))

This formula essentially returns the sum of the named range entered as text in
cell Ale.

A B C D E F Epy|
| 1] North South West East [l
| 2 |January 48 313 353 251
| 3 |February 354 151 47 190
| 4 [March 138 287 254 a7
| 5 |April 244 110 303 378
| B [May 103 407 475 253
| 7 |June 24 222 45 256
| 8 |July =) 198 24 497
| 9 |August 286 121 431 125
| 10 |September 333 455 20 335
| 11 [October 81 a9 450 322
| 12 [Novernber 260 328 475 358
| 13 |December 446 105 165 366
| 14 |
| 15|
| 16 [March 7461 =
| 17 |
18 =
i 4 v W[5 Shest? }Sheet1 141 Ll]_dl

Figure 3-20: Using the INDIRECT function with a named range.

TIP In Excel 97 or later, you can use the Data — Validation command to insert a
$@% drop-down box in cell A16 (use the List option in the Data Validation dialog
—

box, and specify A2:A13 as the list source). This allows the user to select a

month name from a list; the total for the selected month then displays in B16.

You can also reference worksheet-level names with the INDIRECT function. For
example, suppose you have a number of worksheets named Region1, Region2, and
so on. Each sheet contains a worksheet-level name called TotalSales. This formula
retrieves the value from the appropriate sheet, using the sheet name typed in
cell Al:

=INDIRECT(Al&"!TotalSales")

Using the INDIRECT Function to Create
a Named Range with a Fixed Address

It’s possible to create a name that always refers to a specific cell or range, even if
you insert new rows or columns. For example, suppose you want a range named
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UpperLeft to always refer to the range Al. If you create the name using standard
procedures, you'll find that inserting a new row 1 causes the UpperLeft range to
change to A2. Or, inserting a new column causes the UpperLeft range to change to
B1. To create a named range that uses a fixed address that never changes, create a
named formula using the following Refers to definition:

=INDIRECT("$A$1")

After creating this named formula, UpperLeft will always refer to cell A1, even if
you insert new rows or columns. The INDIRECT function, in the preceding formula,
lets you specify a cell address indirectly by using a text argument. Because the
argument appears in quotation marks, it never changes.

o

Using Arrays in Named Formulas

An array is a collection of items. You can visualize an array as a single-column
vertical collection, a single-row horizontal collection, or a multirow and multi-
column collection.

Because this named formula uses a function, it does not appear in the Go
To dialog box or in the Name box.

Part IV of this book discusses arrays and array formulas, but this topic is also
relevant when discussing names.

You specify an array by using brackets. A comma or semicolon separates each
item in the array. Use a comma to separate items arranged horizontally and use a
semicolon to separate items arranged vertically.

Use the Define Name dialog box to create a formula named MonthNames that
consists of the following formula definition:

={"\Jan" ,"Feb","MaY‘" ’uApr,u’nMayu ,"JUH","JU] " ,"Aug","Sep" ,"OCt","NOV" ,
"DEC"}

This formula defines a 12-item array of text strings, arranged horizontally.
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W When you type this formula, make sure that you include the brackets.
E\\“ Entering a formula into the Define Name dialog box is different from enter-
=2\

After you define the MonthNames formula, you can use it in a formula.
However, your formula needs to specify which array item to use. The INDEX func-
tion is perfect for this. For example, the following formula returns Aug:

ing an array formula into a cell.

=INDEX(MonthNames,8)

You can also display the entire 12-item array, but it requires 12 adjacent cells to
do so. For example, to enter the 12 items of the array into A1:L1, follow these steps:

1. Use the Define Name dialog box to create the formula named
MonthNames.
2. Select the range A1:L1.
3. Type =MonthNames in the formula bar.
4. Press Ctrl+Shift+Enter.
Using Ctrl+Shift+Enter tells Excel to insert an array formula into the selected
cells. In this case, the single formula is entered into 12 adjacent cells in Figure 3-21.

Excel places brackets around an array formula to remind you that it’s a special type
of formula. If you examine any cell in A1:L1, you'll see its formula listed as:

{=MonthNames}

A B c D E F G H | J K L I\uj
| 1 [Jan Feb  Mar  Apr May  Jun Jul Aug  Sep  Oct Moy Dec |
2
E
| 4 |
5 -
4 4 r K] Sheetl / 141 | Elz

Figure 3-21: You can enter a named formula that contains a 12-item
array into 12 adjacent cells.

Creating a Dynamic Named Formula

A dynamic named formula is a named formula that refers to a range not fixed in
size. You may find this concept difficult to grasp, so a quick example is in order.

Examine the worksheet shown in Figure 3-22. This sheet contains a listing of
sales by month, through the month of May.
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i Book6 [_[OIx]
A B c ] E B
| 1 |January 1043 =
| 2 |February 1,123
| 3 |March 1,321
4 | April 2244
| & |May 1233
| B |June
[ 7 |uly
| 8 |August
| 9 |Septernber
10 |October
| 11 |Movember
[ 12 |December
| 13|
|<M¢ » [} Sheett / 1K | ﬂ]—dl

Figure 3-22: You can use a dynamic named formula to
represent the sales data in column B.

Suppose you want to create a name (SalesData) for the data in column B, and
you don’t want this name to refer to empty cells. In other words, the reference for
the SalesData range would change each month as you add a new sales figure. You
could, of course, use the Define Name dialog box to change the range name defin-
ition each month. Or, you could create a dynamic named formula that changes
automatically as you enter new data.

To create a dynamic named formula, start by recreating the worksheet shown in
Figure 3-22. Then follow these steps:

1. Bring up the Define Name dialog box.
2. Enter SalesData in the Names in workbook field.
3. Enter the following formula in the Refers to field:
=0FFSET(Sheet1!$B$1,0,0,COUNTA(Sheet1!$B:$B),1)
4. Click OK to close the Define Name dialog box.
The preceding steps created a named formula that uses Excel’s OFFSET and

COUNTA functions. To try out this formula, enter the following formula into any
cell not in column B:

=SUM(SalesData)

This formula returns the sum of the values in column B. Note that SalesData
does not display in the Name box and does not appear in the Go To dialog box. You
can, however, bring up the Go To dialog box and type SalesData to select the range.

At this point, you may be wondering about the value of this exercise. After all, a
simple formula such as the following does the same job, without the need to define
a formula:

=SUM(B:B)
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The value of using dynamic named formulas becomes apparent when creating a
chart. You can use this technique to create a chart with a data series that adjusts
automatically as you enter new data.

Refer to Chapter 17 for an example that uses this technique to create a
dynamic chart.

Summary

This chapter introduced the concept of names. I described how to create and mod-
ify names, and compared workbook-level names with worksheet-level names. The
chapter provided many examples of using names in your workbooks, and also
revealed the secret to understanding names—every name is actually a named
formula.

Chapter 4 presents an introduction and overview of Excel’s worksheet functions.
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Chapter 4

Introducing Worksheet
Functions

IN THIS CHAPTER

@ The advantages of using functions in your formulas
@ The various types of arguments used by functions
¢ How to enter a function into a formula

@ Excel’s function categories

A THOROUGH KNOWLEDGE OF EXCEL’S worksheet functions is essential for anyone
who wants to master the art of formulas. This chapter provides an overview of the
functions available for use in formulas.

What Is a Function?

A worksheet function is a built-in tool that you use in a formula. A typical function
(such as SUM) takes one or more arguments, and then returns a result. The SUM
function, for example, accepts a range argument and then returns the sum of the
values in that range.
You'll find functions useful because they:

¢ Simplify your formulas

¢ Permit formulas to perform otherwise impossible calculations

4 Speed up some editing tasks

¢ Allow “conditional” execution of formulas — giving them rudimentary

decision-making capability

The examples in the sections that follow demonstrate each of these points.

97
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Simplify Formulas

Using a built-in function can simplify a formula significantly. For example, you
might need to calculate the average of the values in 10 cells (A1:A10). Without the
help of any functions, you would need to construct a formula like this:

=(A1+A2+A3+A4+AS+A6+AT7+A8+AQ+AT0) /10

Not very pretty, is it? Even worse, you would need to edit this formula if you
expanded the range to be summed. You can replace this formula with a much sim-
pler one that uses one of Excel’s built-in worksheet functions. For example, the fol-
lowing formula uses Excel’s AVERAGE function:

=AVERAGE (A1:A10)

Perform Otherwise Impossible Calculations

Functions permit formulas to perform impossible calculations. Perhaps you need to
determine the largest value in a range. A formula can’t tell you the answer without
using a function. This simple formula uses Excel’s MAX function to return the
largest value in the range A1:D100:

=MAX(A1:D100)

Speed Up Editing Tasks

Functions can sometimes eliminate manual editing. Assume that you have a work-
sheet that contains 1,000 names in cells A1:A1000 and that all the names appear in
all-uppercase letters. Your boss sees the listing and informs you that you need to
mail merge the names with a form letter and that the use of all uppercase is not
acceptable. For example, JOHN F. CRANE must appear as John F. Crane. You could
spend the rest of the day reentering the list — or you could use a formula such as the
following, which uses Excel’s PROPER function to convert the text in cell Al to
proper case:

=PROPER(AL)

Enter this formula in cell B1 and then copy it down to the next 999 rows. Then
select B1:B1000 and use the Edit— Copy command to copy the range to the
Clipboard. Next, activate cell A1 and use the Edit > Paste Special command (with
the Values option) to convert the formulas to values. Delete column B, and you're
finished. With the help of a function, you just accomplished several hours of work
in less than a minute.
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Provide Decision-Making Capability

Functions can also give your formulas decision-making capability. Suppose you
have a worksheet that calculates sales commissions. If a salesperson sells more than
$100,000 of product, the commission rate reaches 7.5 percent; otherwise, the com-
mission rate remains at 5.0 percent. Without using a function, you would need to
create two different formulas and make sure that you use the correct formula for
each sales amount. Note this formula that uses the IF function to check the value in
cell A1 and make the appropriate commission calculation:

=IF(A1<100000,A1*5%,A1*7.5%)

More about Functions

All told, Excel includes more than 300 functions. And if that’s not enough, you can
purchase additional specialized functions from third-party suppliers, and even cre-
ate your own custom functions (using VBA).

If you're ready to create your own custom functions, check out Part IV of this
book.

The sheer number of available worksheet functions may overwhelm you, but
you’ll probably find that you use only a dozen or so of the functions on a regular
basis. And as you’'ll see, Excel’s Paste Function dialog box (described later in this
chapter) makes it easy to locate and insert a function, even if you use it only rarely.

Appendix B contains a complete listing of Excel’s worksheet functions, with
a brief description of each.

Function Argument Types

If you examine the preceding examples in this chapter, you’ll notice that all of the
functions used a set of parentheses. The information within the parentheses is
referred to as the function’s arguments. Functions vary in how they use arguments.
A function may use:

¢ No arguments

€ One argument
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¢ A fixed number of arguments
4 An indeterminate number of arguments
4 Optional arguments
For example, the RAND function, which returns a random number between 0

and 1, doesn’t use an argument. Even if a function doesn’t require an argument,
you must provide a set of empty parentheses, like this:

=RAND()

If a function uses more than one argument, then a comma separates the argu-
ments. For example, the LARGE function, which returns the “nth” largest value in a
range, uses two arguments. The first argument represents the range; the second
argument represents the value for n. The formula below returns the third largest
value in the range A1:A100:

=LARGE(A1:A100,3)

o

The character used to separate function arguments can be something other
than a comma — for example, a semicolon. This character is determined by
the List separator setting for your system, which is specified in the Regional

Settings dialog box, accessible via the Control Panel.

The examples at the beginning of the chapter used cell or range references for
arguments. Excel proves quite flexible when it comes to function arguments, how-
ever. The following sections demonstrate additional argument types for functions.

Names as Arguments

As you've seen, functions can use cell or range references for their arguments.
When Excel calculates the formula, it simply uses the current contents of the cell or
range to perform its calculations. The SUM function returns the sum of its argu-
ment(s). To calculate the sum of the values in A1:A20, you can use:

=SUM(A1:A20)

And, not surprisingly, if you've defined a name for A1:A20 (such as Sales), you
can use the name in place of the reference:

=SUM(Sales)
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Accommodating Former Lotus 1-2-3 Users

If you've ever used any of the 1-2-3 spreadsheets (or any version of Corel's Quattro
Pro), you might recall that these products require you to type an “at" sign (@) before
a function name. Excel is smart enough to distinguish functions without you having to
flag them with a symbol.

Because old habits die hard, however, Excel accepts @ symbols when you type
functions in your formulas, but it removes them as soon as you enter the formula.

These competing products also use two dots (..) as a range reference operator — for
example, A1..A10. Excel also enables you to use this notation when you type formulas,
but Excel replaces the notation with its own range reference operator, a colon (3).

This accommodation goes only so far, however. Excel still insists that you use the
standard Excel function names, and it doesn't recognize or translate the function
names used in other spreadsheets. For example, if you enter the 1-2-3 @AVG
function, Excel flags it as an error (Excel's name for this function is AVERAGE). For
more information about 1-2-3 compatibility, consult Appendix A.

For more information about defining and using names, refer to Chapter 3.

Full-Column or Full-Row as Arguments

In some cases, you may find it useful to use an entire column or row as an argu-

ment. For example, the following formula sums all values in column B:

=SUM(B:B)

Using full-column and full-row references is particularly useful if the range that
you're summing changes (if you continually add new sales figures, for instance). If
you do use an entire row or column, just make sure that the row or column doesn’t

contain extraneous information that you don’t want included in the sum.

You might think that using such a large range (a column consists of 65,536 cells)
might slow down calculation time. Not true. Excel keeps track of the last-used row
and last-used column, and will not use cells beyond them when computing a for-

mula result that references an entire column or row.
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Literal Values as Arguments

A literal argument refers to a value or text string that you enter directly. For exam-
ple, the SQRT function, which calculates the square root of a number, takes one
argument. In the following example, the formula uses a literal value for the func-
tion’s argument:

=SQRT(225)

Using a literal argument with a simple function like this one usually defeats the
purpose of using a formula. This formula always returns the same value, so you
could just as easily replace it with the value 15. You may want to make an excep-
tion to this rule in the interest of clarity. For example, you might want to make it
perfectly clear that you are computing the square root of 225.

Using literal arguments makes more sense with formulas that use more than one
argument. For example, the LEFT function (which takes two arguments) returns
characters from the beginning of its first argument; the second argument specifies
the number of characters. If cell A1 contains the text “Budget”, the following for-
mula returns the first letter, or “B”:

=LEFT(AL1,1)

Expressions as Arguments

Excel also enables you to use expressions as arguments. Think of an expression as
a formula within a formula. When Excel encounters an expression as a function’s
argument, it evaluates the expression and then uses the result as the argument’s
value. Here’s an example:

=SQRT((A1"2)+(A272))

This formula uses the SQRT function, and its single argument appears as the fol-
lowing expression:

(A1"2)+(A2"2)

When Excel evaluates the formula, it first evaluates the expression in the argu-
ment and then computes the square root of the result.

Other Functions as Arguments

Because Excel can evaluate expressions as arguments, it shouldn’t surprise you that
these expressions can include other functions. Writing formulas that have functions
within functions is sometimes known as nesting functions. Excel starts by evaluat-
ing the most deeply nested expression and works its way out. Note this example of
a nested function:
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=SIN(RADIANS(B9))

The RADIANS function converts degrees to radians, the unit used by all of
Excel’s trigonometric functions. If cell B9 contains an angle in degrees, the RADI-
ANS function converts it to radians, and then the SIN function computes the sine of
the angle.

A formula can contain up to seven levels of nested functions. If you exceed

this level, Excel pops up an error message. In the vast majority of cases, this

limit poses no problem. Users often exceed this limitation when attempting
to create complex formulas comprised of nested IF functions.

Arrays as Arguments

A function can also use an array as an argument. An array is a series of values sep-
arated by a comma and enclosed in brackets. The formula below uses the OR func-
tion with an array as an argument. The formula returns TRUE if cell A1 contains 1,
3, orb5.

=0R(A1={1,3,5})

See Part IV of this book for more information about working with arrays.

Often, using arrays can help you simplify your formula. The formula below, for
example, returns the same result, but uses nested IF functions instead of an array:

=IF(A1=1,TRUE,IF(A1=3,TRUE,IF(Al1=5,TRUE,FALSE)))

Ways to Enter a Function
into a Formula

You can enter a function into a formula by typing it manually, or by using the
Paste Function dialog box.
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Entering a Function Manually

If you're familiar with a particular function —you know how many arguments it
takes and the types of arguments — you may choose simply to type the function and
its arguments into your formula. Often, this method is the most efficient.

Excel 2002 provides some additional help by displaying a list of the argu-
g“ ment names in a small window (see Figure 4-1). If this window gets in your

way, you can drag it to a new position.

Ej Book1 [ [O] ]
A B c D E F G g
[ 1 |Loan Amount 18,500
| 2 |Interest Rate 8.25%
| 3 |Loan Term 4
| 4 |Monthly Payment  |=pmi{
1 5 | PMT(rate, nper, pw, [Fv], [type])
5
Z
|8
| 9 |
[ 10|
1 -
W 4 b »i[\Sheet1 1« Lljj

Figure 4-1: When you enter a function, Excel 2002 lists the
names of the function arguments.

If you omit the closing parenthesis for a function, Excel adds it for you auto-
matically. For example, if you type =SUM(A1:C12 and press Enter, Excel corrects
the formula by adding the right parenthesis.

TIP When you enter a function, Excel always converts the function’s name to
‘&% uppercase.Therefore, it's a good idea to use lowercase when you type func-
N\

tions. If Excel doesn’t convert your text to uppercase when you press Enter,

then your entry isn’t recognized as a function —which means that you
spelled it incorrectly or the function isn’t available (for example, it may be
defined in an add-in not currently installed).

Using the Insert Function Dialog Box
to Enter a Function

The Insert Function dialog box assists you by providing a way to enter a function
and its arguments in a semi-automated manner. Using the Insert Function dialog
box ensures that you spelled the function correctly and that it contains the proper
number of arguments in the correct order.
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In versions prior to Excel 2002, this dialog box is known as the Paste
Function dialog box.

o

To insert a function, select the function from the Insert Function dialog box,
shown in Figure 4-2. You can access this dialog box by using any of the following
three methods:

€ Choose the Insert > Function command from the menu.

@ C(lick the Insert Function button, located next to the formula bar. In ver-
sions prior to Excel 2002, this button is located on the Standard toolbar.

@ Press Shift+F3.

Insert Function [ 7]
Search for a Function:

Type a brief description of what you wart to do and then Go

click Go

Or select a cakegary: IF\nanclaI 'I

Select a function:

PMT{rate,nper,pv,fv,type)
Calculates the payment For a loan based on constankt payments and a
constant inkerest rate.

Help on this function Cancel

Figure 4-2: The Insert Function dialog box

When you select a category from the drop-down list, the list box displays the
functions in the selected category. The Most Recently Used category lists the func-
tions that you've used most recently. The All category lists all the functions avail-
able across all categories. Access this category if you know a function’s name, but
not its category.

A new feature in Excel 2002 enables you to search for a function. Use the
g“ field at the top of the Insert Function dialog box. Enter one or more key-

words and click Go. Excel will display a list of functions that match your

search criteria.
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When you select a function in the Select a function list box, notice that Excel
displays the function (and its argument names) in the dialog box, along with a brief
description of what the function does.

When you locate the function that you want to use, click OK. Excel’s Function
Arguments dialog box appears, as in Figure 4-3. Use the Function Arguments dia-
log box to specify the arguments for the function. You can easily specify a range
argument by clicking the Collapse Dialog button (the icon at the right edge of each
argument field). Excel temporarily collapses the Function Arguments dialog box to
a thin box, so that you can select a range in the worksheet.

[ [ 7] %]
MT
Rate | =
Nper I ==
Py I Sd=
Fy [ A=
Type I ==
Calculates the payment for a loan based on constant payments and a constant inkerest rate,
Rate is the interest rate per period for the loan. For example, use 6% For
quarterly payments at 6% APR,
Formula result =
Help on this Function Cancel

Figure 4-3: The Function Arguments dialog box

The Function Arguments dialog box is new to Excel 2002. Previous versions
“‘ display the Formula Palette (which is similar in look and functionality).

More Tips for Entering Functions

The following list contains some additional tips to keep in mind when you use the
Insert Function dialog box and the Formula Palette to enter functions:

¢ Click the Help on this function hyperlink (or press F1) at any time to get
help about the function that you selected (see Figure 4-4).
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Let Excel Insert Functions for You

Most of the time, you're on your own when it comes to inserting functions. However,
at least two situations can arise in which Excel will enter functions for you
automatically:

€ When you click the AutoSum button on the Standard toolbar, Excel does a
quick check of the selected cells and the surrounding cells. It then proposes a
formula that uses the SUM function. If Excel guessed your intentions, just
press Enter (or click the AutoSum button a second time) to accept the pro-
posed formula(s). In Excel 2002, the AutoSum button displays an arrow that,
when clicked, displays additional functions.

€ When you select the Data — Subtotals command, Excel displays a dialog box
that enables you to specify some options. Then it proceeds to insert rows and
enter some formulas automatically. These formulas use the SUBTOTAL
function.

a2

M <f & =

= Showe all |2
PMT
See Also
Calculates the payment For a loan based on constant payments and a constant interest rate,
Syntax
PMT(rate,nper,pv,f+,type)
Fat a more complete description of the arguments in PMT, see the PY function.
Rate is the interest rats For the loan,
Mper s the tatal number of payments Far the loan.

Pv is the present valug, or the total amount that & series of Future payments is warth now; also known as the
principal.

Fy is the Future value, or a cash bakance you want to attain after the last payment is made. 1F Fy is omitted, itis
assumed to be 0 {zera), that is, the Future value of 5 loan is 0.

Twpe is the number 0 {zera) or 1 and indicates when payments are due.

Set type equal to If payments are due

0or omitked At the end of the period

1 At the beginning of the period
Remarks

* The payment returned by PMT includes principal and interest but no taxes, reserve payments, or fees sometimes
associsted with loans,

& Make sure that you are consistent about the units you use for specifying rate and nper. IF you make manthly
payments on a Four-year loan at an annual interest rake of 12 percent, use 12%/12 for rate and 4*12 for nper. If
wou make annual payments on the same loan, use 12 percent For rate and 4 for nper.

I Tip j
Figure 4-4: Don't forget about Excel's online help. It's the most comprehensive
function reference source available.

& [f the active cell already contains a formula that uses a function, clicking
the Insert Function button displays the Function Arguments dialog box.
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4

You can use the Insert Function dialog box to insert a function into an
existing formula. Just edit the formula and move the insertion point to the
location where you want to insert the function. Then open the Insert
Function dialog box and select the function.

If you change your mind about entering a function, click the Cancel button.

The number of arguments used by the function that you selected deter-
mines the number of boxes you see in the Function Arguments dialog box.
If a function uses no arguments, you won't see any boxes. If the function
uses a variable number of arguments (as with the AVERAGE function),
Excel adds a new box every time you enter an optional argument.

On the right side of each box in the Function Arguments dialog box,
you'll see the current value for each argument.

A few functions, such as INDEX, have more than one form. If you choose
such a function, Excel displays another dialog box that enables you to
choose which form you want to use.

If you only need help remembering a function’s arguments, type an equal
sign and the function’s name, and then press Ctrl+Shift+A. Excel inserts

the function with descriptive placeholders for the arguments, as shown in
Figure 4-5. You need to replace these placeholders with actual arguments.

To locate a function quickly in the Function Name list that appears in the
Insert Function dialog box, open the list box, type the first letter of the
function name, and then scroll to the desired function. For example, if you
select the All category and want to insert the SIN function, click anywhere
on the Select a function list box and press S. Excel selects the first function
that begins with S. Keep pressing S until you reach the SIN function.

If the active cell contains a formula that uses one or more functions, the
Function Arguments dialog box enables you to edit each function. In the
formula bar, click the function that you want to edit, then click the Insert
Function button.

B Book1 [-[O] =]
A B © D E F G 3
Loan Amount 18 500
Interest Rate 8.26%
Loan Tern 48

Monthly Payment ,Eper‘pv‘fv,lype)

o

1

)

W 4 » M[,Sheetl / 1 L“;A‘

Figure 4-5: Press Ctrl+Shift+A to instruct Excel to display
descriptive placeholders for a function.
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Function Categories

I list and briefly describe Excel’s function categories below.

Refer to subsequent chapters for specific examples of using the functions.

Financial Functions

The financial functions enable you to perform common business calculations that
deal with money. For example, you can use the PMT function to calculate the
monthly payment for a car loan. (You need to provide the loan amount, interest
rate, and loan term as arguments.)

Date & Time Functions

The functions in this category enable you to analyze and work with date and time
values in formulas. For example, the TODAY function returns the current date (as
stored in the system clock).

Math & Trig Functions

This category contains a wide variety of functions that perform mathematical and
trigonometric calculations.

o

Statistical Functions

The functions in this category perform statistical analysis on ranges of data. For
example, you can calculate statistics such as mean, mode, standard deviation, and
variance.

The trigonometric functions all assume radians for angles (not degrees).
Use the RADIANS function to convert degrees to radians.

Some of the functions in this category require you to install the Analysis
ToolPak add-in.
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Lookup and Reference Functions

Functions in this category are used to find (look up) values in lists or tables. A com-
mon example is a tax table. You can use the VLOOKUP function to determine a tax
rate for a particular income level.

Database Functions

Functions in this category are useful when you need to summarize data in a list
(also known as a worksheet database) that meets specific criteria. For example,
assume you have a list that contains monthly sales information. You can use the
DCOUNT function to count the number of records that describe sales in the
Northern region with a value greater than 10,000.

Text Functions

The text functions enable you to manipulate text strings in formulas. For example,
you can use the MID function to extract any number of characters beginning at any
character position. Other functions enable you to change the case of text (convert
to uppercase, for example).

Logical Functions

This category consists of only six functions that enable you to test a condition (for
logical TRUE or FALSE). You will find the IF function very useful since it gives your
formulas simple decision-making capability.

Information Functions

The functions in this category help you determine the type of data stored within a
cell. For example, the ISTEXT function returns TRUE if a cell reference contains
text. Or, you can use the ISBLANK function to determine whether a cell is empty.
The CELL function returns lots of potentially useful information about a particular
cell.

Engineering Functions

The functions in this category can prove useful for engineering applications. They
enable you to work with complex numbers, and perform conversions between var-
ious numbering and measurement systems.

o

To use the functions in the Engineering category, you must install the
Analysis ToolPak add-in.
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User-Defined Functions

Functions that appear in this category are custom worksheet functions created
using VBA. These functions can operate just like Excel’s built-in functions. One dif-
ference, however, is that custom functions do not display a description of each
argument in the Paste Function dialog box and Formula Palette.

Other Function Categories

In addition to the function categories described above, Excel includes four other
categories that may not appear in the Paste Function dialog box: Commands,
Customizing, Macro Control, and DDE/External. These categories appear to be
holdovers from older versions of Excel. If you create a custom function, you can
assign it to one of these categories. In addition, you may see other function cate-
gories created by macros.

Refer to Chapter 23 for information about assigning your custom functions
to a function category.

Volatile Functions

Some Excel functions belong to a special class of functions called volatile. Excel
recalculates a volatile function whenever it recalculates the workbook — even if the
formula that contains the function is not involved in the recalculation.

The RAND function represents an example of a volatile function because it generates
a new random number every time Excel calculates the worksheet. Other volatile
functions include:

AREAS INDEX OFFSET
CELL INDIRECT ROWS
COLUMNS NOW TODAY

As a side effect of using these volatile functions, Excel will always prompt you to save
the workbook when you close it — even if you made no changes to it. For example, if
you open a workbook that contains any of these volatile functions, scroll around a bit
(but don't change anything), and then close the file, Excel will ask whether you want
to save the workbook.

You can circumvent this behavior by using the Manual Recalculation mode, with the
Recalculate before save option turned off.
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Analysis ToolPak Functions

When you feel comfortable with Excel’s worksheet functions, you can explore other
available functions when you load the Analysis ToolPak. This add-in provides you
with dozens of additional worksheet functions.

When you load this add-in, the Paste Function dialog box displays a new cate-
gory, Engineering. It also adds new functions to the following function categories:
Financial, Date & Time, Math & Trig, and Information.

Summary

This chapter provided an introduction to worksheet functions. Excel provides hun-
dreds of functions that you can use in your formulas. In addition, you can use
functions defined in add-ins. The remaining chapters in this book provide hundreds
of examples of using functions in your formulas. The next chapter demonstrates
many of the functions available in the Text category.



Chapter 5

Manipulating Text

IN THIS CHAPTER

€ How Excel handles text entered into cells
@ Excel’s worksheet functions that handle text
¢ Examples of advanced text formulas

4 Custom VBA text functions

EXCEL, OF COURSE, IS BEST KNOWN for its ability to crunch numbers. However, it is
also quite versatile when it comes to handling text. As you know, Excel enables you
to enter text for things such as row and column headings, customer names and
addresses, part numbers, and just about anything else. And, as you might expect,
you can use formulas to manipulate the text contained in cells.

This chapter contains many examples of formulas that use functions to manipu-
late text. Some of these formulas perform feats you may not have thought possible.

A Few Words about Text

When you enter data into a cell, Excel immediately goes to work and determines
whether you're entering a formula, a number (including a date or time), or anything
else. Anything else is considered text.

ol

You may hear the term string used instead of text. You can use these terms

interchangeably. Sometimes, they even appear together, as in text string.

How Many Characters in a Cell?

In Excel 5 and Excel 95, a single cell can hold up to 255 characters. Beginning with
Excel 97, however, Microsoft upped the ante significantly. A single cell in Excel 97
can hold up to 32,000 characters. To put things into perspective, this chapter contains

113



114

Part 11: Using Functions in Your Formulas

about 30,000 characters. I certainly don’t recommend using a cell in lieu of a word
processor, but if you use Excel 97 or later, you really don’t have to lose much sleep
worrying about filling up a cell with text.

Although a cell can hold up to 32,000 characters, there is a limit on the num-
ber of characters that can actually display. And, as | describe later, some func-

tions may not work properly for text strings greater than 255 characters.

Numbers as Text

As I mentioned, Excel distinguishes between numbers and text. If you want to
“force” a number to be considered as text, you can do one of the following;:

¢ Apply the Text number format to the cell. Use Format — Cells, click the
Number tab, and select Text from the category list. If you haven’t applied
other horizontal alignment formatting, the value will appear left aligned
in the cell (like normal text).

® Precede the number with an apostrophe. The apostrophe isn’t displayed,
but the cell entry will be treated as if it were text.

Even though a cell is formatted as Text (or uses an apostrophe), you can still per-
form some mathematical operations on the cell if the entry looks like a number. For
example, assume cell A1 contains a value preceded by an apostrophe. The formula
that follows will display the value in A1, incremented by 1:

=Al+1

The formula that follows, however, will treat the contents of cell A1 as 0:
=SUM(A1:A10)

If you're switching from Lotus 1-2-3, you'll find this to be a significant change.
Lotus 1-2-3 never treats text as values. In some cases, treating text as a number can

be useful. In other cases, it can cause problems. Bottom line? Just be aware of
Excel’s inconsistency in how it treats a number formatted as text.

Excel 2002 flags numbers preceded by an apostrophe with a Smart Tag.You
i can use this Smart Tag to convert the “text”to an actual value.
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When a Number Isn't Treated as a Number

If you import data into Excel, you may be aware of a common problem: Sometimes,
the imported values are treated as text. Here's a quick way to convert these non-
numbers to actual values. Activate any empty cell and enter the value 1. Choose
Edit — Copy to copy that value to the Clipboard. Then, select the range that contains
the values you need to fix. Choose Edit — Paste Special. In the Paste Special dialog
box, select the Multiply option, then click OK. This procedure forces Excel to treat the
non-numbers as actual values.

Text Functions

Excel has an excellent assortment of worksheet functions that can handle text. For
your convenience, Excel’s Insert Function dialog box places most of these functions
in the Text category. A few other functions that are relevant to text manipulation
appear in other function categories. For example, the ISTEXT function is in the
Information category in the Insert Function dialog box.

Refer to Appendix B for a listing of the functions in the Text category. Or
choose Insert > Function to access the Insert Function dialog box, and scroll

through the functions in the Text category.

Most of the text functions are not limited for use with text. In other words, these func-
tions can also operate with cells that contain values. Unlike other spreadsheets (such as
1-2-3), Excel is very accommodating when it comes to treating numbers as text and text
as numbers.

The examples discussed in this section demonstrate some common (and useful)
things you can do with text. You may need to adapt some of these examples for
your own use.

Determining Whether a Cell Contains Text

In some situations, you may need a formula that determines the type of data con-
tained in a particular cell. For example, you may use an IF function to return a
result only if a cell contains text. Excel provides three functions to help you deter-
mine if a particular cell contains text:

& [STEXT

¢ CELL

¢ TYPE
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As you'll see, however, these functions are not always reliable.

The companion CD-ROM includes a workbook that demonstrates these
functions (including their problems).

THE ISTEXT FUNCTION

The ISTEXT function takes a single argument, and returns TRUE if the argument
contains text, and FALSE if it doesn’t contain text. The formula that follows returns
TRUE if A1 contains a string:

=ISTEXT(AL)

The ISTEXT function, although useful, is certainly not perfect. In fact, it will
give you an incorrect result in some cases. Although Excel 97 and later can
store a huge amount of text in a cell (up to 32,000 characters), the ISTEXT

function doesn’t seem to realize this fact. The ISTEXT function returns FALSE
if its argument refers to a cell that contains more than 255 characters. Excel
2000 corrected this problem, so ISTEXT works as expected regardless of the
amount of text in the cell.

THE TYPE FUNCTION

The TYPE function takes a single argument and returns a value that indicates the
type of data in a cell. If cell A1 contains a text string, the formula that follows will
return 2 (the code number for text):

=TYPE(AL)

The TYPE function falls apart when a cell contains more than 255 characters:
It returns 16, the code number for an Error value.

THE CELL FUNCTION

Theoretically, the CELL function should help you determine whether a particular
cell uses the Text format, or has an apostrophe prefix. The first argument for the
CELL function can consist of any of 12 keywords, including format, prefix, or type.
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None of these options work as advertised when a number is formatted as Text.
For example, if you enter a number into cell A1 and then give it a number format
of Text, the following formula returns G, which means Excel considers it formatted
using the General format:

=CELL("format",Al)

Using prefix as the first argument for the CELL function returns an apostrophe if
a value is preceded by an apostrophe, but it returns nothing if the cell contains a
number and is formatted as Text. Using fype as the first argument in the CELL func-
tion also yields inconsistent results. For example, if the cell contains more than 255
characters, the function returns v (for value).

Working with Character Codes

Every character that you see on your screen has an associated code number. For
Windows systems, Excel uses the standard ANSI character set. The ANSI character
set consists of 255 characters, numbered from 1 to 255.

Figure 5-1 shows a portion of an Excel worksheet that displays all of the
255 characters. This example uses the Arial font (other fonts may have different
characters).
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5] C D E F G H | J K L Il il 8] o
Font: I Atial j Size: I 10 j
2
i 1 [u] 39 ! 7T M 1148 5 153 ™ 191 229 H
ill 2 0O 40 [ 7 N 116 t 154 § 192 A 230 =
5 3 [u] 41 ! 79 8] 117 u 185 3 183 A 231 [
B 4 0 42 - g0 P 118 v 156| @ 194 A 232 [l
T 5 0O 43 + a1 Q 119 w 157| 0O 185 A 233 g
8 4] [u] 44 82 R 120 X 158 H 196 A 234 é
3 i o 45 83 s 121 150] ¥ 197 A 23] &
10 g 0 46 g4 T 122 z 160 188 £ 236 1
11 o o a7 85| U 123] 161 | 198 © 237] 1
12 100 0O 48 0 a6 v 124 | 162 ¢ 00 E 238 7
13 11 [u] 49 1 87 W 124 1 163 £ 201 E 238 i
14 12| O 500 2 ] 126 ~ 164 = 0z E 240 8 b
15 13 0O 51 3 gal v 127 O 165 ¥ 03] E 241 i
16 14 [u] a2 4 a0 z 128 £ 166 | 204 | 242 i
17 15 0O 53] 5 £l [ 129 O 167 § 205 | 243 i
16 16| O 54 6 92 Y 130 168 i 206 | 244 i
19 17 [u] a4 7 a3 1 131 I 169 207 | 245 i
20 18 0O 56| 8 94 * 132 N 170 2 g B 248 [1}
21 19 [u] a7 ] a5 133 171 [ 209 N 247 +
22 200 O 58 98 134] t 172 — 20/ O 248 L]
23 21 u] 549 i ar a 136 173 - 21 9] 249 U
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Figure 5-1: The ANSI character set (for the Arial font)
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The companion CD-ROM includes a copy of this workbook. It has some sim-
ple macros that enable you to display the character set for any font installed

on your system.This workbook requires Excel 97 or later.

Two functions come into play when dealing with character codes: CODE and
CHAR. These functions aren’t very useful by themselves. However, they can prove
quite useful in conjunction with other functions. I discuss these functions in the
following sections.

o

THE CODE FUNCTION
Excel’s CODE function returns the character code for its argument. The formula that
follows returns 65, the character code for uppercase A:

The CODE and CHAR functions work only with ANSI strings. These functions
will not work with double-byte Unicode strings.

=CODE("A™)

If the argument for CODE consists of more than one character, the function uses
only the first character. Therefore, this formula also returns 65:

=CODE("Abbey Road")

THE CHAR FUNCTION

The CHAR function is essentially the opposite of the CODE function. Its argument
should be a value between 1 and 255, and the function should return the corre-
sponding character. The following formula, for example, returns the letter A:

=CHAR(65)

To demonstrate the opposing nature of the CODE and CHAR functions, try enter-
ing this formula:

=CHAR(CODE("A™))
This formula (illustrative rather than useful) returns the letter A. First, it converts

the character to its code value (65), and then it converts this code back to the cor-
responding character.
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How to Find Special Characters

If you use Excel 2002, don't overlook the handy Symbol dialog box (which appears
when you select Insert — Symbol). This dialog box makes it easy to insert special
characters (including Unicode characters) into cells. For example, you might (for some
strange reason) want to include a smiley face character in your spreadsheet. Access
Excel's Symbol dialog box and select the Wingdings font (see the accompanying
figure). Examine the characters, locate the smiley face, and click Insert. You'll also find
out that this character has a code of 74.

If you use an earlier version of Excel, you can get similar functionality with the
Windows Character Map program (charmap.exe).

Symbol
Symbos | special charscters |

Fort: [Wingdngs 7]
DBEE@EEE%@QEHH®5j
B EIRREI R © EE DRI
B | 0| |3 || T | 9| R |G Q|| B8R Y|
11|58 | 212 Yoz eriéd @ [O[m ][O,
Recently used symbols:
e[azelcl¥[o[@™z]#][=]z]+]x]~]
wingdings: 74 Character code: [74 from: [ymbol (dscimal) =]

EEN

Assume cell A1 contains the letter A (uppercase). The following formula returns
the letter a (lowercase):

=CHAR(CODE(A1)+32)

This formula takes advantage of the fact that the alphabetic characters all appear
in alphabetical order within the character set, and the lowercase letters follow the
uppercase letters (with a few other characters tossed in between). Each lowercase let-
ter lies exactly 32 character positions higher than its corresponding uppercase letter.

Determining Whether Two Strings Are ldentical

You can set up a simple logical formula to determine whether two cells contain the
same entry. For example, use this formula to determine whether cell A1 has the
same contents as cell A2:

=A1=A2
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Excel acts a bit lax in its comparisons when text is involved. Consider the case
in which A1 contains the word January (initial capitalization), and A2 contains
JANUARY (all uppercase). You'll find that the previous formula returns TRUE, even
though the contents of the two cells are not really the same. In other words, the
comparison is not case sensitive.

In many cases, you don’t need to worry about the case of the text. But if you
need to make an exact, case-sensitive comparison, you can use Excel’s EXACT
function. The formula that follows returns TRUE only if cells A1 and A2 contain
exactly the same entry:

=EXACT(A1,A2)

The following formula returns FALSE because the first string contains a trailing
space:

=EXACT("zero ","zero")

Joining Two or More Cells

Excel uses an ampersand as its concatenation operator. Concatenation is simply a
fancy term that describes what happens when you join the contents of two or more
cells. For example, if cell A1 contains the text San Diego, and cell A2 contains the
text California, the following formula will return San DiegoCalifornia:

=A1&A2

Notice that the two strings are joined together without an intervening space. To
add a space between the two entries (to get San Diego California), use a formula like
this one:
=A1&" "&A2

Or, even better, use a comma and a space to produce San Diego, California:
=A1&", "&A2

Another option is to eliminate the quote characters and use the CHAR function,
with an appropriate argument. Note this example of using the CHAR function to
represent a comma (44) and a space (32):
=A1&CHAR(44)&CHAR(32)&A2

If you'd like to force a “word wrap,” concatenate the strings using CHAR (10),

and make sure you apply the wrap text format to the cell. The following example
joins the text in cell A1 and the text in cell B1, with a line break in between:
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=A1&CHAR(10)&B1

Here’s another example of the CHAR function. The following formula returns the
string Stop by concatenating four characters returned by the CHAR function:

=CHAR(83)&CHAR(116)&CHAR(111)&CHAR(112)
Here’s a final example of using the & operator. In this case, the formula com-
bines text with the result of an expression that returns the maximum value in col-

umn C:

="The largest value in Column C is " &MAX(C:C)

Excel also has a CONCATENATE function, which takes up to 30 arguments.
This function simply combines the arguments into a single string. You can

use this function if you like, but using the & operator results in shorter
formulas.

Displaying Formatted Values as Text

Excel’s TEXT function enables you to display a value in a specific number format.
Although this function may appear to have dubious value, it does serve some use-
ful purposes, as the examples in this section demonstrate. Figure 5-2 shows a sim-
ple worksheet. The formula in cell D1 is:

="The net profit is " & B3

& Book1 [_[O] =]
A B c D E 3

| 1 |Gross $155509.84 The net profit is 104616.52

| 2 |Expenses $50993.32 J

| 3 [NET $104 516.52

EN

|5

| &

M 4% b} Sheet1 1] | iy

Figure 5-2: The formula in D1 doesn't display the formatted

number.

This formula essentially combines a text string with the contents of cell B3 and
displays the result. Note, however, that the contents of B3 are not formatted in any
way. You might want to display B3’s contents using a currency number format.
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Contrary to what you might expect, applying a number format to the cell
that contains the formula has no effect.This is because the formula returns a

o

Note this revised formula that uses the TEXT function to apply formatting to the
value in B3:

string, not a value.

="The net profit is " & TEXT(B3,"$#,#40.00")

This formula displays the text along with a nicely formatted value: The net profit
is $104,616.52.

The second argument for the TEXT function consists of a standard Excel number
format string. You can enter any valid number format string for this argument.

The preceding example uses a simple cell reference (B3). You can, of course, use
an expression instead. Here’s an example that combines text with a number result-
ing from a computation:

="Average Expenditure: "& TEXT(AVERAGE(A:A),"$#,4HF0.00")

This formula might return a string such as Average Expenditure: $7,794.57.

Here’s another example that uses the NOW function (which returns the current
date and time). The TEXT function displays the date and time, nicely formatted.
="Report printed on "&TEXT(NOWC),"mmmm d, yyyy at h:mm AM/PM")

The formula might display the following: Report printed on July 22, 2001 at
3:23 PM.

Refer to Appendix C for details on Excel number formats.

Displaying Formatted Currency Values as Text

Excel’s DOLLAR function converts a number to text using the currency format. It
takes two arguments: the number to convert, and the number of decimal places to
display. The DOLLAR function uses the regional currency symbol (for example, a $).
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You can sometimes use the DOLLAR function in place of the TEXT function. The
TEXT function, however, is much more flexible since it doesn’t limit you to a spe-
cific number format.

The following formula returns Total: $1,287.37. The second argument for the
DOLLAR function specifies the number of decimal places.

="Total: "&DOLLAR(1287.367, 2)

Repeating a Character or String

The REPT function repeats a text string (first argument) any number of times you
specify (second argument). For example, this formula returns HoHoHo:

=REPT("Ho",3)

You can also use this function to create crude vertical dividers between cells.
This example displays a squiggly line, 20 characters in length:

=REPT("~",20)

Creating a Text Histogram

A clever use for the REPT function is to create a simple histogram directly in a
worksheet (chart not required). Figure 5-3 shows an example of such a histogram.
You'll find this type of graphical display especially useful when you need to visu-
ally summarize many values. In such a case, a standard chart may be unwieldy.

A B [ D E F €] —
1 =
Z Budget Actual Pct. Diff Under Budget Exceeded Budget
| 3 [Jan o 3 37%
|4 Feb 300 298 07% u [
|5 [Mar | 3000 305 17% Mar [CL]
B |Apr 360 31 0.3% Apr
| 7 |May 3600 4020 14.8% L\[) NS EEEEEEEEEE
| 8 [Jun 350 409 16.59% Jun EELDELELEL LT L]
| 9 [Jul 500 421 -156%| eeEEEEEEEEEEEEss W
| 10 |Aug s00 454 -9.2% LTI Tl Aug
| 11 |Sep 500 474 -52% LLTTL N sep |
12| Oct 5000 &1 4.2% oct IEEEE
| 13 | Mo 200 476)  -4.8% LLLLLN Hov
| 14 |Dec 500 487 -26% [ LN nec
15 -
4 4 » Wy Sheetl JEN] | L”—dl
Figure 5-3: Using the REPT function to create a histogram in a worksheet
range

The formulas in columns E and G graphically depict monthly budget variances
by displaying a series of characters in the Wingdings font. This example uses the
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character n, which displays as a small square in the Wingdings font. A formula
using the REPT function determines the number of characters displayed. Key for-
mulas include:

E3: =IF(D3<0,REPT("n",-ROUND(D3*100,0)),"")
F3: =A3
G3: =IF(D3>0,REPT("n",ROUND(D3*100,0)),"")

Assign the Wingdings font to cells E3 and G3, and then copy the formulas down
the columns to accommodate all the data. Right-align the text in column E and
adjust any other formatting. Depending on the numerical range of your data, you
may need to change the scaling. Experiment by replacing the 100 value in the for-
mulas. You can substitute any character you like for the n in the formulas to pro-
duce a different character in the chart.

The workbook shown in Figure 5-3 also appears on the companion CD-ROM.

Padding a Number

You're probably familiar with a common security measure (frequently used on
printed checks) in which numbers are padded with asterisks on the right. The fol-
lowing formula displays the value in cell A1, along with enough asterisks to make
24 characters total:

=(Al & REPT("*",24-LEN(AL)))

Or, if you'd prefer to pad the number with asterisks on the left, use this formula:
=REPT("*",24-LEN(AL))&AL

The following formula displays asterisk padding on both sides of the number. It
will return 24 characters when the number in cell A1 contains an even number of
characters; otherwise, it returns 23 characters.
=REPT("*",12-LEN(CA1)/2)&AT&REPT("*" ,12-LEN(AL)/2)

The preceding formulas are a bit deficient since they don’t show any number

formatting. Note this revised version that displays the value in A1l (formatted),
along with the asterisk padding on the right:
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=(TEXTC(AL,"$#,40.00" )&REPT("*", 24-LEN(TEXT (AL, "$#,4H0.00"))))

Figure 5-4 shows this formula in action.

El Book1

A B T DL
| 1| 14355 §143. 5EF &
| 2| a7 $9.89 J
| 3 | 1933.43 $1,933 g
| 4 | 80332 -pE0g, Faree
|5 |
| 6 |

7 -
4 4 b HPySheet1 0 | Llj_J

Figure 5-4: Using a formula to pad a number
with asterisks

You can also pad a number by using a custom number format. To repeat the next
character in the format to fill the column width, include an asterisk (*) in the cus-
tom number format code. For example, use this number format to pad the number
with dashes:

$4F,#HF0 . 00* -

To pad the number with asterisks, use two asterisks, like this:

$4F,#HF0 . 00**

Refer to Appendix C for more information about custom number formats,
including additional examples using the asterisk format code.

Removing Excess Spaces and
Nonprinting Characters
Often, data imported into an Excel worksheet contains excess spaces or strange

(often unprintable) characters. Excel provides you with two functions to help whip
your data into shape: TRIM and CLEAN.

4 TRIM: Removes all leading and trailing spaces, and replaces internal
strings of multiple spaces by a single space.

¢ CLEAN: Removes all nonprinting characters from a string. These
“garbage” characters often appear when you import certain types of data.
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Of the 255 ANSI character codes, 39 of them comprise nonprinting char-
acters. Specifically, the nonprinting character codes include 1-31,
128-129, 141-144, and 157-158.

This example uses the TRIM function. The formula returns Fourth Quarter
Earnings (with no excess spaces):

=TRIM(" Fourth Quarter Earnings ")

Counting Characters in a String

Excel’s LEN function takes one argument and returns the number of characters in
the cell. For example, assume the string September Sales is contained in cell Al.
The following formula will return 15:

=LEN(AL)
Notice that space characters are included in the character count.
The following formula returns the total number of characters in the range

A1:A3:

=SUM(CLENCAL),LENCAZ2),LENCA3))

You will see example formulas that demonstrate how to count the number
of specific characters within a string later in this chapter. Also, you may find

relevant material in Chapter 7 on counting techniques and Chapter 15 on
performing magic with array formulas.

Changing the Case of Text

Excel provides three handy functions to change the case of text:

¢ UPPER: Converts the text to ALL UPPERCASE

¢ LOWER: Converts the text to all lowercase

4 PROPER: Converts the text to “proper” case (The First Letter In Each Word
Is Capitalized)

These functions are quite straightforward. The formula that follows, for example,
converts the text in cell A1 to proper case. If cell Al contained the text MR. JOHN
Q. PUBLIC, the formula would return Mr. John Q. Public.
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=PROPER(AI)

These functions operate only on alphabetic characters; they simply ignore all
other characters and return them unchanged.

Extracting Characters from a String

Excel users often need to extract characters from a string. For example, you may
have a list of employee names (first and last names) and need to extract the
last name from each cell. Excel provides several useful functions for extracting
characters:

@ LEFT: Returns a specified number of characters from the beginning of a
string

¢ RIGHT: Returns a specified number of characters from the end of a string

4 MID: Returns a specified number of characters beginning at any position

within a string

The formula that follows returns the last 10 characters from cell Al. If A1 con-
tains fewer than 10 characters, the formula returns all of the text in the cell.

=RIGHT(A1,10)

This next formula uses the MID function to return five characters from cell Al,
beginning at character position 2. In other words, it returns characters 2-6.

=MID(A1,2,5)

The following example returns the text in cell A1, with only the first letter in
uppercase. It uses the LEFT function to extract the first character and convert it to
uppercase. This then concatenates to another string that uses the RIGHT function to
extract all but the first character (converted to lowercase).

=UPPER(CLEFT(AL))&RIGHT(LOWER(AL),LENCAL)-1)

If cell A1 contained the text FIRST QUARTER, the formula would return First
quarter.

Replacing Text with Other Text

In some situations, you may need to replace a part of a text string with some other
text. For example, you may import data that contains asterisks, and you need to
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convert the asterisks to some other character. You could use Excel’s Edit > Replace
command to make the replacement. If you prefer a formula-based solution, you can
take advantage of either of two functions:

& SUBSTITUTE: Replaces specific text in a string. Use this function when
you know the character(s) to be replaced, but not the position.

¢ REPLACE: Replaces text that occurs in a specific location within a string.
Use this function when you know the position of the text to be replaced,
but not the actual text.

The following formula uses the SUBSTITUTE function to replace 2001 with 2002
in the string 2001 Budget. The formula returns 2002 Budget.

=SUBSTITUTE("2001 Budget","2001","2002")

The following formula uses the SUBSTITUTE function to remove all spaces from
a string. In other words, it replaces all space characters with an empty string. The
formula returns the title of an excellent Liz Phair CD: Whitechocolatespaceegg.

=SUBSTITUTE("White chocolate space egg"," ","")

The following formula uses the REPLACE function to replace one character
beginning at position 5 with nothing. In other words, it removes the fifth character
(a hyphen) and returns Part544.

=REPLACE("Part-544",5,1,"")

You can, of course, nest these functions to perform multiple replacements in a
single formula. The formula that follows demonstrates the power of nested SUBSTI-
TUTE functions. The formula essentially strips out any of the following seven char-
acters in cell A1l: space, hyphen, colon, asterisk, underscore, left parenthesis, and
right parenthesis.

=SUBSTITUTE(SUBSTITUTE(SUBSTITUTE(
SUBSTITUTE(SUBSTITUTE(SUBSTITUTE(SUBSTITUTE(
AL, ™ MUY momommywmwmowmymw o mw)wowowwy o wn wey oy

Therefore, if cell A1 contains the string Part-2A - Z(4M1)_A* the formula
returns Part2AZ4MI1A.

Finding and Searching within a String

Excel’s FIND and SEARCH functions enable you to locate the starting position of a
particular substring within a string:



Chapter 5: Manipulating Text

129

¢ FIND: Finds a substring within another text string and returns the starting
position of the substring. You can specify the character position at which
to begin searching. Use this function for case-insensitive text compar-
isons. Wildcard comparisons are not supported.

¢ SEARCH: Finds a substring within another text string and returns the
starting position of the substring. You can specify the character position
at which to begin searching. Use this function for non-case-sensitive text,
or when you need to use wildcard characters.

The following formula uses the FIND function and returns 7, the position of the
first m in the string. Notice that this formula is case sensitive.

=FIND("m","Big Mamma Thornton",1)

The formula that follows, which uses the SEARCH function, returns 5, the posi-
tion of the first m (either uppercase or lowercase):

=SEARCH("m","Big Mamma Thornton",1)

You can use the following wildcard characters within the first argument for the
SEARCH function:

¢ Question mark (?): Matches any single character

® Asterisk (*): Matches any sequence of characters

T"’t If you want to find an actual question mark or asterisk character, type a tilde
$@ (~) before the question mark or asterisk.
\
J

The next formula examines the text in cell A1 and returns the position of the
first three-character sequence that has a hyphen in the middle of it. In other words,
it looks for any character followed by a hyphen and any other character. If cell A1
contains the text Part-A90, the formula returns 4.

=SEARCH("?-?",A1,1)

Searching and Replacing within a String

You can use the REPLACE function in conjunction with the SEARCH function to
replace part of a text string with another string. In effect, you use the SEARCH
function to find the starting location used by the REPLACE function.
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For example, assume cell Al contains the text “Annual Profit Figures.” The fol-
lowing formula searches for the word “Profit,” and replaces it with the word “Loss”:

=REPLACE(AL,SEARCH("Profit",Al),6,"Loss™")

This next formula uses the SUBSTITUTE function to accomplish the same effect
in a more efficient manner:

=SUBSTITUTE(AL,"Profit","Loss")

Advanced Text Formulas

The examples in this section appear more complex than the examples in the previous
section. But, as you'll see, they can perform some very useful text manipulations.

You can access all of the examples in this section on the companion
CD-ROM.

Counting Specific Characters in a Cell

This formula counts the number of Bs (uppercase only) in the string in cell A1:
=LENCA1)-LEN(CSUBSTITUTE(AL,"B",""))

This formula works by using the SUBSTITUTE function to create a new string (in
memory) that has all of the Bs removed. Then the length of this string is subtracted
from the length of the original string. The result reveals the number of Bs in the
original string.

The following formula is a bit more versatile. It counts the number of Bs (both
upper- and lowercase) in the string in cell Al.

=LEN(AL)-LEN(SUBSTITUTE(SUBSTITUTE(AL,"B",""),"b",""))

Counting the Occurrences of a Substring in a Cell

The formulas in the preceding section count the number of occurrences of a partic-
ular character in a string. The following formula works with more than one charac-
ter. It returns the number of occurrences of a particular substring (contained in
cell B1) within a string (contained in cell A1). The substring can consist of any
number of characters.
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=(LENCA1)-LENCSUBSTITUTEC(CAL1,B1,"")))/LEN(BI)

For example, if cell A1 contains the text Blonde On Blonde and B1 contains the
text Blonde, the formula returns 2.

The comparison is case sensitive, so if B1 contains the text blonde, the formula
returns 0. The following formula is a modified version that performs a case-insen-
sitive comparison:

=(LENCA1)-LEN(SUBSTITUTE(CUPPER(AL) ,UPPER(B1),"")))/LEN(BI)

Expressing a Number as an Ordinal

You may need to express a value as an ordinal number. For example, Today is the
21st day of the month. In this case, the number 21 converts to an ordinal number
by appending the characters st to the number.

The characters appended to a number depend on the number. There is no clear
pattern, making the construction of a formula more difficult. Most numbers will use
the th suffix. Exceptions occur for numbers that end with 1, 2, or 3 — except if the
preceding number is a 1 (numbers that end with 11, 12, or 13). These may seem like
fairly complex rules, but you can translate them into an Excel formula.

The formula that follows converts the number in cell A1 (assumed to be an inte-
ger) to an ordinal number:

=AT&IF(OR(VALUE(RIGHT(AL1,2))={11,12,13}),"th", IF(OR(VALUE(RIGHT(A1))
={1,2,3}),CHOOSE(RIGHT(AL),"st","nd","rd"),"th"))

This is a rather complicated formula, so it may help to examine its components.
Basically, the formula works as follows:
1. If the last two digits of the number consist of 11, 12, or 13, then use th.

2. If Rule #1 does not apply, then check the last digit. If the last digit is 1,
use st. If the last digit is 2, use nd. If the last digit is 3, use rd.

3. If neither Rule #1 nor Rule #2 apply, use th.

The formula uses two arrays, specified by brackets. Refer to Chapter 14 for
more information about using arrays in formulas.
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Figure 5-5 shows the formula in use.

i ordinal sls [_[O]

T A [ B ¢ o
[ 1| Mumber Ordinal —
| 2| 1 1st

13 | 4 4th

| 4 | 7 7th

| 5 | 10 10th

| 6 | 13 13th

[ 7 | 16 16th

| 6 | 12 19th

|9 | 22 Znd

[ 10| 26 26th

| 11 28 28th

[12] kil Fst

[13] 34 Jdth

| 14| 37 IFth

[ 15| 40 40th

| 16 | 43 43rd

| 17 | 46 46th

[ 18| 49 49th

|19 | 52 52nd e
20 X
4 » d[}Sheetl / LN ﬂJJA

Figure 5-5: Using a formula to express
a number as an ordinal

Determining a Column Letter for
a Column Number

This next formula returns a worksheet column letter (ranging from A to IV) for the
value contained in cell Al. For example, if A1 contains 29, the formula returns AC.

=IF(A1>26,CHAR(64+INT((A1-1)/26)),"")&CHAR(65+MOD(AL-1,26))

Note that the formula doesn’t check for a valid column number. In other words,
if A1 contains a value less than 1 or greater than 256, the formula will still give an
answer — albeit a meaningless one. The following modified version includes an IF
function to ensure a valid column:

=IF(AND(AI>0,A1<257),IF(A1>26,CHAR(64+INT((AL1-1)/26)),"")
&CHAR(65+MOD(AI-1,26)),"")

Extracting a Filename from a Path Specification

The following formula returns the filename from a full path specification. For
example, if cell A1 contains c:\windows\desktop\myfile.xls, the formula returns
myfile.xls.

=MIDCAL,FIND(C"*" ,SUBSTITUTE(CAL,"\","*" LEN(AL)-
LENCSUBSTITUTECAL,"\",""))))+1,LEN(AL))
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This formula assumes that the system path separator consists of a backslash (\).
It essentially returns all of the text following the last backslash character. If cell A1
doesn’t contain a backslash character, the formula returns an error.

Extracting the First Word of a String

To extract the first word of a string, a formula must locate the position of the first
space character, and then use this information as an argument for the LEFT func-
tion. The following formula does just that:

=LEFT(AL,FINDC" ",AL1)-1)

This formula returns all of the text prior to the first space in cell A1. However,
the formula has a slight problem: It returns an error if cell A1 consists of a single
word. A slightly more complex formula that checks for the error with an IF func-
tion solves that problem:

=IFCISERRCFIND(" ",A1)),ALl,LEFT(AL,FIND(" ",A1)-1))

Extracting the Last Word of a String

Extracting the last word of a string is more complicated, since the FIND function
only works from left to right. Therefore, the problem rests with locating the last
space character. The formula that follows, however, solves this problem. It returns
the last word of a string (all of the text following the last space character):

=RIGHT (A1, LENCAL)-FIND("*" ,SUBSTITUTECAL," ","*",LEN(AL)-
LENCSUBSTITUTECAL,"™ ","")))))

This formula, however, has the same problem as the first formula in the preced-
ing section: It fails if the string does not contain at least one space character. The
following modified formula uses an IF function to count the number of spaces in
cell Al. If it contains no spaces, the entire contents of cell A1 are returned.
Otherwise, the previous formula kicks in.

=IF(LENCAL)-LEN(SUBSTITUTE(CAL," ",""))=0,A1,RIGHT(AL,LEN(CAL)-

FIND("*",SUBSTITUTE(CAL," ","*" LEN(CA1)-LEN(SUBSTITUTEC(AL,"
"L""0))

Extracting All but the First Word of a String

The following formula returns the contents of cell A1, except for the first word:
=RIGHT(AL1,LENCAL)-FINDC" ",A1,1))

If cell A1 contains 2002 Operating Budget, the formula returns Operating Budget.
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Extracting First Names, Middle Names,
and Last Names

Suppose you have a list consisting of people’s names in a single column. You have
to separate these names into three columns: one for the first name, one for the mid-
dle name or initial, and one for the last name. This task is more complicated than
you may think, since not every name has a middle initial. However, you can still
do it.

W‘ The task becomes a lot more complicated if the list contains names with
N \\& titles (such as Mr. or Dr.) or names followed by additional details (such as Jr.
==\«

or ). In fact, the following formulas will not handle these complex cases.

However, they still give you a significant head start if you're willing to do a
bit of manual editing to handle the special cases.

The formulas that follow all assume that the name appears in cell Al.
You can easily construct a formula to return the first name:

=LEFT(AL,FIND(" ",A1)-1)

Returning the middle name or initial is much more complicated since not all
names have a middle initial. This formula returns the middle name (if it exists).
Otherwise, it returns nothing.

=IF(ISERR(MID(CAL,FIND(" ",A1)+1,IF(ISERRCFIND(
"",ALLFINDC" ",AL)+1)),FINDC" ",AL),FIND(" ",ALl,FIND(
"L AL+D))-FINDCT "L,AL)-1))," " ,MID(AL,FIND(C" ",A1)+1,
IFCISERRCFIND(C" ",AL,FINDC" ",A1)+1)),FIND(" ",ALl),
FINDC" ",AL,FIND(C" ",A1)+1))-FIND(" ",A1)-1))

Finally, this formula returns the last name:

=RIGHT(AL,LENCAL)-FIND("*" ,SUBSTITUTECAL," ","*" LEN(CAL)-
LENCSUBSTITUTECAL,™ ","")))))

The formula that follows is a much shorter way to extract the middle name. This
formula is useful if you use the other formulas to extract the first name and the last

name. It assumes that the first name is in B1 and the last name is in D1.

=IF(LEN(BI1&D1)+2>=LEN(AL),"" ,MID(AL,LEN(B1)+2,LENCAL)-LEN(B1&D1)-2)
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As you can see in Figure 5-6, the formulas work fairly well. There are a few
problems, however — notably names that contain four “words.” But, as I mentioned
earlier, you can clean these cases up manually.

If you want to know how | created these complex formulas, refer to Chapter
20 for a discussion of megaformulas.

2§ Book2 [_ O[]
A B c D E 3

| 1 |Full Hame First Middle Last

| 2 [John Q. Public John Q Fublic

| 3 |Lisa Smith Lisa Smith

| 4 |J. R. Robins J. R. Rohbins

| 6 |AF Adans AP Adans

| B |Roger Smith Rager Smith

| 7 [Mr James Olson hr James Olzon

g
% 2
i 4 » H]ySheet1 1« wir;

Figure 5-6: This worksheet uses formulas to extract
the first name, middle name (or initial), and last
name from a list of names in column A.

Removing Titles from Names

You can use the formula that follows to remove three common titles (Mr., Ms., and
Mrs.) from a name. For example, if cell A1 contains Mr. Fred Munster, the formula
would return Fred Munster.

=IF(ORCLEFT(AL,2)="Mr",LEFT(A1,3)="Mrs",LEFT(AL1,2)="Ms") ,RIGHT (AL, LE
N(CAL) -FINDC" ",A1)),Al)

Counting the Number of Words in a Cell

The following formula returns the number of words in cell A1l:
=LEN(TRIM(CAL))-LENCSUBSTITUTE(TRIM(AL)," ",""))+1

The formula uses the TRIM function to remove excess spaces. It then uses the
SUBSTITUTE function to create a new string (in memory) that has all the space
characters removed. The length of this string is subtracted from the length of the
original (trimmed) string to get the number of spaces. This value is then incre-
mented by 1 to get the number of words.
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Splitting Text Strings without Using Formulas

In many cases, you can eliminate the use of formulas and use Excel's Data —> Text to
Columns command to parse strings into their component parts. Selecting this
command displays Excel's Convert Text to Columns Wizard, which consists of a series
of dialog boxes that walk you through the steps to convert a single column of data
into multiple columns. Generally, you'll want to select the Delimited option (in Step 1)
and use Space as the delimiter (in Step 2).

Convert Text to Columns Wizard - Step 2 of 3 [ 2] x]
This screen lets you set the delimiters your data conkains. ¥ou can see
hows wour text is affected in the preview below,
elinitet [V Treat consecutive delimiters as one
¥ Tab I Semicalon I~ Comma
¥ Epace; [ Other: Text qualfier: | ]'
ata previ
Hohn 1. Public ﬂ
Lisa Pwith
a. . fobins
_D. fudans
Roger Emith ~|
] B
Cancel < Back | [iext = I Einish I

Note that this formula will return 1 if the cell is empty. The following modifica-
tion solves that problem:

=IF(LEN(AL1)=0,0,LENCTRIM(CAL))-LENCSUBSTITUTE(TRIM(AL)," ",""))+1)

Custom VBA Text Functions

Excel has many functions that work with text, but likely you’ll run into a situation
in which the appropriate function just doesn’t exist. In such a case, you can often
create your own worksheet function using VBA.

Chapter 25 contains several additional text functions, written in VBA.
| briefly describe these functions here.
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¢ REVERSETEXT: Returns the text in a cell backwards. For example, using
Evian as the argument returns naivE.

¢ ACRONYM: Returns the first letter of each word in its argument. For
example, using Power Utility Pak as the argument returns PUP.

¢ SPELLDOLLARS: Returns a number “spelled out” in text — as on a check.
For example, using 123.45 as the argument returns One hundred twenty-
three and 45/100 dollars.

¢ SCRAMBLE: Returns the contents of its argument randomized. For exam-
ple, using Microsoft as the argument may return oficMorts — or some other
random permutation.

@ [SLIKE: Returns TRUE if a string matches a pattern composed of text and
wildcard characters.

¢ CELLHASTEXT: Returns TRUE if the cell argument contains text, or a
value formatted as Text. This function overcomes the problems described
at the beginning of this chapter (see “Determining Whether a Cell
Contains Text").

¢ EXTRACTELEMENT: Extracts an element from a string based on a speci-
fied separator character (such as a hyphen).

Summary

This chapter provided some background on how Excel deals with text entered
into cells. It also presented many useful examples that incorporate Excel’s text
functions.

The next chapter presents formulas that enable you to calculate dates, times, and
other time-period values.






Chapter 6

Working with Dates
and Times

IN THIS CHAPTER

€ An overview of using dates and times in Excel
@ Excel’s date-related functions

& Excel’s time-related functions

BEGINNERS OFTEN FIND THAT working with dates and times in Excel can be frustrat-
ing. To eliminate this frustration, you’ll need a good understanding of how Excel
handles time-based information. This chapter provides the information you need to
create powerful formulas that manipulate dates and times.

The dates in this chapter correspond to the United States English date
format: month/day/year. For example, the date 3/1/1952 refers to March 1,

1952, not January 3,1952.1 realize that this is very illogical, but that’s the way
we Americans have been trained. | trust that the non-American readers of
this book can make the adjustment.

How Excel Handles Dates and Times

This section presents a quick overview of how Excel deals with dates and times. It
includes coverage of Excel’s date and time serial number system, and offers tips for
entering and formatting dates and times.

Other chapters in this book contain additional date-related information. For
example, refer to Chapter 7 for counting examples that use dates.Chapter 25
contains some VBA functions that work with dates.
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Understanding Date Serial Numbers

To Excel, a date is simply a number. More precisely, a date is a “serial number” that
represents the number of days since January 0, 1900. A serial number of 1 corre-
sponds to January 1, 1900; a serial number of 2 corresponds to January 2, 1900,
and so on. This system makes it possible to deal with dates in formulas. For exam-
ple, you can create a formula to calculate the number of days between two dates.

You may wonder about January 0, 1900. This “non-date” (which corresponds to
date serial number 0) is actually used to represent times that are not associated with
a particular day. This will become clear later in this chapter.

To view a date serial number as a date, you must format the cell as a date. Use
the Format Cells dialog box (Number tab) to apply a date format.

it

Excel 97 and later versions support dates from January 1, 1900 through
December 31, 9999 (serial number = 2,958,465). Previous versions of Excel
support a much smaller range of dates: from January 1, 1900 through
December 31,2078 (serial number = 65,380).

Choose Your Date System: 1900 or 1904

Excel actually supports two date systems: the 1900 date system and the 1904 date
system. Which system you use in a workbook determines what date serves as the basis
for dates. The 1900 date system uses January 1, 1900 as the day assigned to date
serial number 1. The 1904 date system uses January 1, 1904 as the base date. By
default, Excel for Windows uses the 1900 date system, and Excel for Macintosh uses
the 1904 date system. Excel for Windows supports the 1904 date system for
compatibility with Macintosh files. You can choose the date system from the Options
dialog box (select Tools — Options and select the Calculation tab). You cannot change
the date system if you use Excel for Macintosh.

Generally, you should use the default 1900-date system. And you should exercise
caution if you use two different date systems in workbooks that are linked together.
For example, assume Book1 uses the 1904 date system and contains the date
1/15/1999 in cell A1. Assume Book2 uses the 1900 date system and contains a link to
cell A1 in Book1. Book2 will display the date as 1/14/1995. Both workbooks will use
the same date serial number (34713), but they will be interpreted differently.

One advantage to using the 1904 date system is that it enables you to display
negative time values. With the 1900 date system, a calculation that results in a
negative time (for example, 4:00 PM - 5:30 PM) cannot be displayed. When using the
1904 date system, the negative time displays as -1:30 (that is, a difference of one
hour and 30 minutes).
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Entering Dates

You can enter a date directly as a serial number (if you know it), but more often
you'll enter a date using any of several recognized date formats. Excel automati-
cally converts your entry into the corresponding date serial number (which it uses
for calculations), and also applies the default date format to the cell so it displays as
an actual date rather than a cryptic serial number.

For example, if you need to enter June 1, 2002, you can simply enter the date by
typing June 1, 2002 (or use any of several different date formats). Excel interprets
your entry and stores the value 37408, the date serial number for that date. It also
applies the default date format, so the cell contents may not appear exactly as you
typed them.

o

When you activate a cell that contains a date, the formula bar shows the cell
contents formatted using the default date format — which corresponds to your sys-
tem’s short date style. The formula bar does not display the date’s serial number. If
you need to find out the serial number for a particular date, format the cell using a
non-date number format.

Depending on your regional settings, entering a date in a format such as
June 1,2002 may be interpreted as a text string. In such a case, you would
need to enter the date in a format such as 1 June, 2002.

TIP To change the default date format, you need to change a system-wide set-
$M ting. Access the Windows Control Panel, and select Regional Settings. In the
I Regional Settings dialog box, select the Date tab. The selected item for the

Short date style determines the default date format used by Excel.

Table 6-1 shows a sampling of the date formats that Excel recognizes (using the
U.S. settings). Results will vary if you use a different regional setting.

TasLe 6-1 DATE ENTRY FORMATS RECOGNIZED BY EXCEL

Entry Excel's Interpretation (U.S. Settings)
6-1-01 June 1, 2001
6-1-2001 June 1, 2001

Continued
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TasLe 6-1 DATE ENTRY FORMATS RECOGNIZED BY EXCEL (Continued)

Entry Excel's Interpretation (U.S. Settings)
6/1/01 June 1, 2001

6/1/2001 June 1, 2001

6-1/01 June 1, 2001

June 1, 2001 June 1, 2001

Jun 1 June 1 of the current year
June 1 June 1 of the current year
6/1 June 1 of the current year
6-1 June 1 of the current year
1-Jun-2001 June 1, 2001

2001/6/1 June 1, 2001

As you can see in Table 6-1, Excel is rather intelligent when it comes to recog-
nizing dates entered into a cell. It’s not perfect, however. For example, Excel does
not recognize any of the following entries as dates:

€ June 1 2001
¢ Jun-1 2001
¢ Jun-1/2001

Rather, it interprets these entries as text. If you plan to use dates in formulas,
make sure that Excel can recognize the date you enter as a date; otherwise, the for-
mulas that refer to these dates will produce incorrect results.

If you attempt to enter a date that lies outside of the supported date range, Excel
interprets it as text. If you attempt to format a serial number that lies outside of the
supported range as a date, the value displays as a series of hash marks
(HH#H#H#H#H#).

Understanding Time Serial Numbers

When you need to work with time values, you simply extend Excel’s date serial
number system to include decimals. In other words, Excel works with times by
using fractional days. For example, the date serial number for June 1, 2001, is
37043. Noon (halfway through the day) is represented internally as 37043.5.
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Searching for Dates

If your worksheet uses many dates, you may need to search for a particular date by
using Excel's Find dialog box (which you can access with the Edit — Find command, or
Ctrl+F). You'll find that Excel is rather picky when it comes to finding dates. You must
enter a full four-digit date into the Find what field in the Find dialog box. The format
must correspond to your system's short date format (this is the format that displays in
the formula bar).

The serial number equivalent of one minute is approximately 0.00069444. The
formula that follows calculates this number by multiplying 24 hours by 60 minutes,
and dividing the result into 1. The denominator consists of the number of minutes
in a day (1,440).

=1/(24*%60)

Similarly, the serial number equivalent of one second is approximately
0.00001157, obtained by the following formula (1 divided by 24 hours times 60
minutes times 60 seconds). In this case, the denominator represents the number of
seconds in a day (86,400).
=1/(24*60%60)

In Excel, the smallest unit of time is one one-thousandth of a second. The time
serial number shown here represents 23:59:59.999, or one one-thousandth of a sec-
ond before midnight:

0.99999999

Table 6-2 shows various times of day, along with each associated time serial
number.

TasLe 6-2 TIMES OF DAY AND THEIR CORRESPONDING SERIAL NUMBERS

Time of Day Time Serial Number
12:00:00 AM (midnight) 0.00000000
1:30:00 AM 0.06250000

Continued
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TasLe 6-2 TIMES OF DAY AND THEIR CORRESPONDING
SERIAL NUMBERS (Continued)

Time of Day Time Serial Number
3:00:00 AM 0.12500000
4:30:00 AM 0.18750000
6:00:00 AM 0.25000000
7:30:00 AM 0.31250000
9:00:00 AM 0.37500000
10:30:00 AM 0.43750000
12:00:00 PM (noon) 0.50000000
1:30:00 PM 0.56250000
3:00:00 PM 0.62500000
4:30:00 PM 0.68750000
6:00:00 PM 0.75000000
7:30:00 PM 0.81250000
9:00:00 PM 0.87500000
10:30:00 PM 0.93750000

Entering Times

As with entering dates, you normally don’t have to worry about the actual time ser-
ial numbers. Just enter the time into a cell using a recognized format. Table 6-3
shows some examples of time formats that Excel recognizes:

TasLE 6-3 TIME ENTRY FORMATS RECOGNIZED BY EXCEL

Entry Excel's Interpretation
11:30:00 am 11:30 AM
11:30:00 AM 11:30 AM

11:30 pm 11:30 PM
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Entry Excel's Interpretation
11:30 11:30 AM
13:30 1:30 PM

Because the preceding samples don’t have a specific day associated with them,
Excel (by default) uses a date serial number of 0, which corresponds to the non-day
January 0, 1900. Often, you’ll want to combine a date and time. Do so by using a
recognized date entry format, followed by a space, and then a recognized time-
entry format. For example, if you enter the text that follows in a cell, Excel inter-
prets it as 11:30 a.m. on June 1, 2001. Its date/time serial number is
37043.4791666667.

6/1/2001 11:30

When you enter a time that exceeds 24 hours, the associated date for the time
increments accordingly. For example, if you enter the following time into a cell, it
is interpreted as 1:00 AM on January 1, 1900. The day part of the entry increments
because the time exceeds 24 hours.

25:00:00

Similarly, if you enter a date and a time (and the time exceeds 24 hours), the date
that you entered is adjusted. The following entry, for example, is interpreted as
9/2/1999 1:00:00 AM.

9/1/1999 25:00:00

If you enter a time only (without an associated date), you'll find that the maxi-
mum time that you can enter into a cell is 9999:59:59 (just under 10,000 hours).
Excel adds the appropriate number of days. In this case, 9999:59:59 is interpreted
as 3:59:59 PM on 02/19/1901. If you enter a time that exceeds 10,000 hours, the
time appears as a text string.

Formatting Dates and Times

You have a great deal of flexibility in formatting cells that contain dates and times.
For example, you can format the cell to display the date part only, the time part
only, or both the date and time parts.

You format dates and times by selecting the cells, and then using the Number tab
of the Format Cells dialog box, shown in Figure 6-1. The Date category shows
built-in date formats, and the Time category shows built-in time formats. Some of
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the formats include both date and time displays. Just select the desired format from
the Type list and click OK.

Format Cells HE
mumber | algrment | Fent | Border | Pattems | protection |
Category: ’—Sampl |

*3i 142001 =
*Wednesday, March 14, 2001

Locale (lacation):
IEngI\sh (United States) j

Date Formats display date and time serial numbers as date values, Except for
items that have an asterisk (*), applied Formats da not switch date orders
with the operating system,

Cence

Figure 6-1: Use the Number tab in the Format Cells dialog
box to change the appearance of dates and times.

TIP When you create a formula that refers to a cell containing a date or a time,
" ) Excel automatically formats the formula cell as a date or a time. Sometimes,
I this is very helpful; other times, it's completely inappropriate and downright

annoying.Unfortunately, you cannot turn off this automatic date formatting.
You can, however, use a shortcut key combination to remove all number for-
matting from the cell and return to the default “General” format. Just select
the cell and press Ctrl+Shift+~.

If none of the built-in formats meet your needs, you can create a custom num-
ber format. Select the Custom category, and then type the custom format codes into
the Type box. (See Appendix C for information on creating custom number
formats.)

TIP A particularly useful custom number format for displaying times is:
P Z

] [h]l:mm:ss
\

Do

Using square brackets around the hour part of the format string causes
Excel to display hours beyond 24 hours.You will find this useful when adding
times that exceed 24 hours. For an example, see “Summing Times That
Exceed 24 Hours,” later in this chapter.
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Problems with Dates

Excel has some problems when it comes to dates. Many of these problems stem
from the fact that Excel was designed many years ago, before the acronym Y2K
became a household term. And, as I describe, the Excel designers basically emulated
Lotus 1-2-3’s limited date and time features, which contain a nasty bug duplicated
intentionally in Excel. In addition, versions of Excel show inconsistency in how
they interpret a cell entry that has a two-digit year. And finally, how Excel inter-
prets a date entry depends on your regional date settings.

If Excel were being designed from scratch today, 'm sure it would be much more
versatile in dealing with dates. Unfortunately, we're currently stuck with a product
that leaves much to be desired in the area of dates.

EXCEL’S LEAP YEAR BUG

A leap year, which occurs every four years, contains an additional day (February
29). Although the year 1900 was not a leap year, Excel treats it as such. In other
words, when you type the following into a cell, Excel does not complain. It inter-
prets this as a valid date and assigns a serial number of 60:

2/29/1900

If you type the following invalid date, Excel correctly interprets it as a mistake
and doesn’t convert it to a date. Rather, it simply makes the cell entry a text string:

2/29/1901

How can a product used daily by millions of people contain such an obvious
bug? The answer is historical. The original version of Lotus 1-2-3 contained a bug
that caused it to consider 1900 as a leap year. When Excel was released some time
later, the designers knew of this bug, and chose to reproduce it in Excel to maintain
compatibility with Lotus worksheet files.

Why does this bug still exist in later versions of Excel? Microsoft asserts that the
disadvantages of correcting this bug outweigh the advantages. If the bug were
eliminated, it would mess up hundreds of thousands of existing workbooks. In
addition, correcting this problem would affect compatibility between Excel and
other programs that use dates. As it stands, this bug really causes very few prob-
lems because most users do not use dates before March 1, 1900.

PRE-1900 DATES

The world, of course, didn’t begin on January 1, 1900. People who work with his-
torical information using Excel often need to work with dates before January 1,
1900. Unfortunately, the only way to work with pre-1900 dates is to enter the date
into a cell as text. For example, you can enter the following into a cell and Excel
won’t complain:

July 4, 1776
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You can’t, however, perform any manipulation on dates recognized as text. For
example, you can’t change its numeric formatting, you can’t determine which day
of the week this date occurred on, and you can’t calculate the date that occurs
seven days later.

The companion CD-ROM contains an add-in that | developed called
Extended Date Functions.When you install this add-in, you'll have access to

eight new worksheet functions that enable you to work with any date in the
years 0100 through 9999. Figure 6-2 shows a worksheet that uses these
functions in column D to perform calculations that involve pre-1900 dates.

Bl presidents. xls M= E

A =] c D E
1 |President | Born | Died | Age |

[ 2 |William McKinley 1/29/1843 9/14/1501 58

| 3 |Franklin D. Roosevelt 1430418082 411241845 63

| 4 |william Henry Harrison 2081773 4/471841 65

| 5 |Abraham Lincoln 21121809 41541865 56

| B |Tachary Tayler 37291790 7/9/1850 60

[ 7 |WWarren 3. Harding 11/2/1865 821923 a7

| 8 |James A Garfield 1MA2183 9/194153 49

|<q 4 » d[\Sheetl /

Figure 6-2: The Extended Date Functions add-in enables
you to work with pre-1900 dates.

INCONSISTENT DATE ENTRIES

You need to exercise caution when entering dates by using two digits for the year.
When you do so, Excel has some rules that kick in to determine which century to
use. And those rules vary depending on the version of Excel that you use.

For Excel 97, two-digit years between 00 and 29 are interpreted as 21st century
dates, and two-digit years between 30 and 99 are interpreted as 20th century dates.
For example, if you enter 12/5/28, Excel interprets your entry as December 5, 2028.
But if you enter 12/5/30, Excel sees it as December 5, 1930. If you use Excel 2000
or later (running on Windows 98 or later), you can use the default boundary year of
2029, or change it using the Windows Control Panel (use the Date tab of the
Regional Settings Properties dialog box).

For previous versions of Excel (Excel 3 through Excel 95), two-digit years
between 00 and 19 are interpreted as 21st century dates, and two-digit years
between 20 and 99 are interpreted as 20th century dates. For example, if you enter
12/5/19, Excel interprets your entry as December 5, 2019. But if you enter 12/5/20,
Excel sees it as December 5, 1920.

If, for some unknown reason, you still use Excel 2, when you enter a two-digit
date, it is always interpreted as a 20th century date. Table 6-4 summarizes these
differences for various versions of Excel.
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TasLe 6-4 HOW TWO-DIGIT YEARS ARE INTERPRETED
IN VARIOUS EXCEL VERSIONS

Excel Version 20th Century Years 21st Century Years
2 00-99 N/A
3,4,5,7(95) 20-99 00-19
8 (97), 9 (2000), 10 (2002) 30-99 00-29
To avoid any surprises, you should simply enter all years using all four digits for
the year.

Date-Related Functions

Excel has quite a few functions that work with dates. When you use the Insert
Function dialog box, these functions appear in the Date & Time function category.

Table 6-5 summarizes the date-related functions available in Excel. Some of
Excel’s date functions require that you install the Analysis ToolPak.

TasLe 6-5 DATE-RELATED FUNCTIONS

Function

DATE
DATEDIF
DATEVALUE
DAY
DAYS360

EDATE*

EOMONTH*

Description

Returns the serial number of a particular date

Calculates the number of days, months, or years between two dates
Converts a date in the form of text to a serial number

Converts a serial number to a day of the month

Calculates the number of days between two dates based on a 360-
day year

Returns the serial number of the date that represents the indicated
number of months before or after the start date

Returns the serial number of the last day of the month before or
after a specified number of months

Continued
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TaBLE 6-5 DATE-RELATED FUNCTIONS (Continued)

Function

MONTH
NETWORKDAYS*
NOW

TODAY
WEEKDAY
WEEKNUM*
WORKDAY*

YEAR
YEARFRAC*

Description

Converts a serial number to a month

Returns the number of whole workdays between two dates
Returns the serial number of the current date and time
Returns the serial number of today's date

Converts a serial number to a day of the week

Returns the week number in the year

Returns the serial number of the date before or after a specified
number of workdays

Converts a serial number to a year

Returns the year fraction representing the number of whole days
between start_date and end_date

*Function is available only when the Analysis ToolPak add-in is installed.

Displaying the Current Date

The following function displays the current date in a cell:

=TODAY ()

You can also display the date, combined with text. The formula that follows, for

example, displays text such as Today is Monday, April 9, 2001.

="Today is "&TEXT(TODAY(),"dddd, mmmm d, yyyy")

It’s important to understand that the TODAY function is updated whenever the
worksheet is calculated. For example, if you enter either of the preceding formulas
into a worksheet, they will display the current date. But when you open the work-
book tomorrow, they will display the current date (not the date when you entered

the formula).
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-"p’( 2 To enter a “date stamp” into a cell, press Ctrl+; (semicolon). This enters the
$@ date directly into the cell and does not use a formula.Therefore, the date will
N\
)

not change.

Displaying Any Date

As explained earlier in this chapter, you can easily enter a date into a cell by sim-
ply typing it, using any of the date formats that Excel recognizes. You can also cre-
ate a date by using the DATE function, which takes three arguments: the year, the
month, and the day. The following formula, for example, returns a date comprised
of the year in cell A1, the month in cell B1, and the day in cell C1:

=DATE(A1,B1,C1)

ol

The DATE function accepts invalid arguments, and adjusts the result accord-
ingly. For example, this next formula uses 13 as the month argument, and

returns January 1,2002.The month argument is automatically translated as

month 1 of the following year.
=DATE(2001,13,1)

Often, you’ll use the DATE function with other functions as arguments. For
example, the formula that follows uses the YEAR and TODAY functions to return
the date for Independence Day (July 4th) of the current year:

=DATE(YEAR(CTODAY()),7,4)

The DATEVALUE function converts a text string that looks like a date into a date
serial number. The following formula returns 37490, the date serial number for
August 22, 2002:

=DATEVALUE("8/22/2002")

To view the result of this formula as a date, you need to apply a date number
format to the cell.
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Be careful when using the DATEVALUE function. A text string that “looks like
a date”in your country, may not look like a date in another country.The pre-

ceding example works fine if your system is set for U.S. date formats, but it
returns an error for other regional date formats because Excel is looking for
the eighth day of the 22nd month!

Generating a Series of Dates

Often, you’ll want to insert a series of dates into a worksheet. For example, in
tracking weekly sales, you may want to enter a series of dates, each separated by
seven days. These dates will serve to identify the sales figures.

The most efficient way to enter a series of dates doesn’t require any formulas.
Use Excel’s AutoFill feature to insert a series of dates. Enter the first date, and drag
the cell’s fill handle while pressing the right mouse button. Release the mouse but-
ton and select an option from the shortcut menu (see Figure 6-3).

il Book3 M=
A B c 8] E F G H=Z
1§ 142001
|2
=R
4
5 Copy Cells
| 6 | Fill Series
7
? Fill Eormatting Only
9 Fill Withaut Formatting
10
" Fill Days
12 Fill Weekdays
13 Fill Months
| Fill ¥
15 ill Years
16 Linear Trend
i Growth Trend
18
13| Series... o
20
ok sl
4« b »i[\Sheetl / 4] | HJJA

Figure 6-3: Using Excel's AutoFill feature to create a series of dates

The advantage of using formulas to create a series of dates is that you can
change the first date and the others will update automatically. You need to enter the
starting date into a cell, and then use formulas (copied down the column) to gener-
ate the additional dates.

The following examples assume that you entered the first date of the series into
cell A1, and the formula into cell A2. You can then copy this formula down the col-
umn as many times as needed.
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To generate a series of dates separated by seven days, use this formula:
=A1+7

To generate a series of dates separated by one month, use this formula:
=DATE(YEARCAL) ,MONTH(A1)+1,DAY (A1))

To generate a series of dates separated by one year, use this formula:
=DATE(YEARCAL)+1,MONTH(AL),DAY (AL))

To generate a series of weekdays only (no Saturdays or Sundays), use the for-
mula that follows. This formula assumes that the date in cell A1 is not a weekend.

=IF(WEEKDAY (A1)=6,A1+3,A1+1)

Converting a Non-Date String to a Date

You may import data that contains dates coded as text strings. For example, the
following text represents August 21, 2001 (a four-digit year followed by a two-digit
month, followed by a two-digit day):

20010821

To convert this string to an actual date, you can use a formula such as this one
(it assumes the coded data is in cell A1):

=DATE(LEFT(AL,4),MID(AL1,5,2),RIGHT(AL,2))

This formula uses text functions (LEFT, MID, and RIGHT) to extract the digits,
and then uses these extracted digits as arguments for the DATE function.

Refer to Chapter 5 for more information about using formulas to manipulate
text.

Calculating the Number of Days
between Two Dates

A common type of date calculation determines the number of days between two
dates. For example, you may have a financial worksheet that calculates interest
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earned on a deposit account. The interest earned depends on the number of days
the account is open. If your sheet contains the open date and the close date for the
account, you can calculate the number of days the account was open.

Because dates store as consecutive serial numbers, you can use simple subtrac-
tion to calculate the number of days between two dates. For example, if cells A1l
and B1 both contain a date, the following formula returns the number of days
between these dates:

=A1-B1

Excel will automatically format this formula cell as a date, rather than a numeric
value. Therefore, you will need to change the number format so the result is dis-
played as a non-date. If cell B1 contains a more recent date than the date in cell A1,
the result will be negative.

o

Sometimes, calculating the difference between two days is more difficult. To
demonstrate, consider the common “fence-post” analogy. If somebody asks you
how many units make up a fence, you can respond with either of two answers: the
number of fence posts, or the number of gaps between the fence posts. The number
of fence posts is always one more than the number of gaps between the posts.

To bring this analogy into the realm of dates, suppose you start a sales promo-
tion on February 1, and end the promotion on February 9. How many days was the
promotion in effect? Subtracting February 1 from February 9 produces an answer
of eight days. Actually, the promotion lasted nine days. In this case, the correct
answer involves counting the fence posts, not the gaps. The formula to calculate
the length of the promotion (assuming you have appropriately named cells) appears
like this:

If this formula does not display the correct value, make sure that A1 and B1
both contain actual dates — not text that looks like a date.

=EndDay-StartDay+1

Calculating the Number of Work Days
between Two Dates

When calculating the difference between two dates, you may want to exclude
weekends and holidays. For example, you may need to know how many business
days fall in the month of November. This calculation should exclude Saturdays,
Sundays, and holidays. The NETWORKDAYS function can help out. (You can access
this function only when you install the Analysis ToolPak.)
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The NETWORKDAYS function has a very misleading name. This function has
nothing to do with networks or networking. Rather, it calculates the net

o

The NETWORKDAYS function calculates the difference between two dates,
excluding weekend days (Saturdays and Sundays). As an option, you can specify a
range of cells that contain the dates of holidays, which are also excluded. Excel has
absolutely no way of determining which days are holidays, so you must provide
this information in a range.

Figure 6-4 shows a worksheet that calculates the workdays between two dates.
The range A2:A11 contains a list of holiday dates. The formulas in column C calcu-
late the workdays between the dates in column A and column B. For example, the
formula in cell C15 is:

workdays between two dates.

=NETWORKDAYS(A15,B15,A2:A11)

Bl work days.xls [_ O] %]
A B C Lo
1 Date Holiday I—
2 14172002 Mew Vear's Day
3 142142002 Matin Luther King Jr. Day
4 218/2002 Presidents' Day
5 5£27/2002 Memorial Day
5] 7442002 Independence Day
7 9£2/2002 Labor Day
g 111172002 “eterans Day
9 10A14/2002 Columbus Day
10 11/28/2002 Thanksgiving Day
11 12/26/2002 Christrnas Day
|12
13
14 First Day Last Day Working Days |l |
15| Tuesday 1/1/2002 Monday 1/7/2002 4
16| Tuesday 1/1/2002 Tuesday 12/31/2002 251
17 Z
i 4 » H[ySheet1 14l ﬂj;‘

Figure 6-4: Using the NETWORKDAYS function to calculate
the number of working days between two dates

This formula returns 4, which means that the seven-day period beginning with
January 1 contains four workdays. In other words, the calculation excludes one
holiday, one Saturday, and one Sunday. The formula in cell C16 calculates the total
number of work days in the year.

This workbook is available on the companion CD-ROM.
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Offsetting a Date Using Only Work Days

The WORKDAY function, which is available only when you install the Analysis
ToolPak, is the opposite of the NETWORKDAYS function. For example, if you start
a project on January 4, and the project requires 10 working days to complete, the
WORKDAY function can calculate the date you will finish the project.

The following formula uses the WORKDAY function to determine the date 10
working days from January 4, 2001. A working day consists of a weekday (Monday
through Friday).

=WORKDAY("1/4/2001",10)

The formula returns January 18, 2001 (four weekend dates fall between January
4 and January 18).

The preceding formula may return a different result, depending on your
regional date setting (the hard-coded date may be interpreted as April 1,
2001). A better formula is:

=WORKDAY (DATE(2001,1,4),10)

The second argument for the WORKDAY function can be negative. And, as with
the NETWORKDAYS function, the WORKDAY function accepts an optional third
argument (a reference to a range that contains a list of holiday dates).

Calculating the Number of Years
between Two Dates

The following formula calculates the number of years between two dates. This for-
mula assumes that cells A1 and B1 both contain dates:

=YEAR(A1)-YEAR(B1)

This formula uses the YEAR function to extract the year from each date, and
then subtracts one year from the other. If cell B1 contains a more recent date than
the date in cell A1, the result will be negative.

Note that this function doesn’t calculate full years. For example, if cell A1 con-
tains 12/31/2001 and cell B1 contains 01/01/2002, the formula returns a difference
of one year, even though the dates differ by only one day.

Calculating a Person’s Age

A person’s age indicates the number of full years that the person has been alive.
The formula in the previous section (for calculating the number of years between
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two dates) won’t calculate this value correctly. You can use two other formulas,
however, to calculate a person’s age.

The following formula returns the age of the person whose date of birth you
enter into cell Al. This formula uses the YEARFRAC function, which is available
only when you install the Analysis ToolPak add-in.

=INT(YEARFRAC(TODAY (),A1,1))

The following formula, which doesn’t rely on an Analysis ToolPak function, uses
the DATEDIF function to calculate an age (see the sidebar, “Where’s the DATEDIF
Function?”):

=DATEDIF(AL,TODAY(),"Y")

If you're a stickler for detail, use the following formula to calculate the exact age
in years, months, and days.

=DATEDIFCAL,NOW(C),"y") & " years, " & DATEDIF(CAL,NOW(),"ym") &
" months, " & DATEDIF(A1,NOW(),"md") & " days"

This formula will return a text string such as 49 years, 3 months, 29 days.

Determining the Day of the Year

January 1 is the first day of the year, and December 31 is the last day. But what
about all of those days in between? The following formula returns the day of the
year for a date stored in cell Al:

=A1-DATE(YEAR(AL),1,0)

The day of the year is sometimes referred to as a Julian date.
The following formula returns the number of days remaining in the year from a
particular date (assumed to be in cell A1):

=DATE(YEAR(AL),12,31)-Al

When you enter either of these formulas, Excel applies date formatting to the
cell. You need to apply a non-date number format to view the result as a number.

To convert a particular day of the year (for example, the 90th day of the year) to
an actual date in a specified year, use the formula that follows. This formula
assumes the year is stored in cell A1, and the day of the year is stored in cell B1.

=DATE(A1,1,B1)
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Where's the DATEDIF Function?

In several places throughout this chapter, | refer to the DATEDIF function. You may
notice that this function does not appear in the Paste Function dialog box. Therefore,
when you use this function, you must always enter it manually.

The DATEDIF function has its origins in Lotus 1-2-3, and apparently Excel provides it
for compatibility purposes. For some reason, Microsoft wants to keep this function a
secret. Versions prior to Excel 2000 failed to even mention the DATEDIF function in
the online help. Interestingly, references to this function were removed from the
online help for Excel 2002 (although the function is still available).

DATEDIF is a handy function that calculates the number of days, months, or years
between two dates. The function takes three arguments: start_date, end_date, and a
code that represents the time unit of interest. The following table displays valid codes
for the third argument (you must enclose the codes in quotation marks).

Unit Code Returns

"y" The number of complete years in the period.

"m" The number of complete months in the period.

"d" The number of days in the period.

"md" The difference between the days in start_date and end_date. The

months and years of the dates are ignored.

ym" The difference between the months in start_date and end_date.
The days and years of the dates are ignored.
"yd" The difference between the days of start_date and end_date. The

years of the dates are ignored.

The start_date argument must be earlier than the end_date argument, or the function
returns an error.

Determining the Day of the Week

The WEEKDAY function accepts a date argument, and returns an integer between 1
and 7 that corresponds to the day of the week. The following formula, for example,
returns 3 because the first day of the year 2002 falls on a Tuesday:

=WEEKDAY (DATE(2002,1,1))
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Power Utility Pak Date Utilities

My Power Utility Pak add-in (available on the companion CD-ROM) includes several
utilities that work with dates:

@ Perpetual Calendar: Displays a calendar for any month, creates a graphic cal-
endar image, and creates calendars in worksheets.

@ |Insert-A-Date: Simplifies date entries. You can insert a date into a cell by
clicking a calendar and choosing from a list of common date formats.

® Reminder Alarm: Displays a reminder (with sound) at a specified time of day,
or after a specified period of time has elapsed.

@ Time Tracker: Tracks the amount of time spent working on up to six different
projects.

@ Date Report: Creates a useful report that describes all dates in a workbook.
This utility is useful for spotting potential Y2K problems.

Insert-A-Date B

:;I April 2001 i‘
S™M T W T F §
12 3 45 & 7
B9 10 11 12 13 14
15|16 17 19 19 20 21
22 23 24 25 26 27 2B
29 30

Date format:
mmm d,
mjd

mfdiyy
mfdiyyyy
mrnm d

T Yy
-y
M-y |

Apr 15, 2001

The WEEKDAY function uses an optional second argument that specifies the day
numbering system for the result. If you specify 2 as the second argument, the func-
tion returns 1 for Monday, 2 for Tuesday, and so on. If you specify 3 as the second
argument, the function returns 0 for Monday, 1 for Tuesday, and so on.

TIP You can also determine the day of the week for a cell that contains a date by
$@% applying a custom number format. A cell that uses the following custom
I number format displays the day of the week, spelled out:

dddd
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Determining the Date of the Most Recent Sunday
You can use the following formula to return the date for the previous Sunday. If the
current day is a Sunday, the formula returns the current date:

=TODAY () -MOD(TODAY()-1,7)

To modify this formula to find the date of a day other than Sunday, change the
1 to a different number between 2 (for Monday) and 7 (for Saturday).

Determining the First Day
of the Week after a Date

This next formula returns the specified day of the week that occurs after a particu-
lar date. For example, use this formula to determine the date of the first Monday
after June 1, 2001. The formula assumes that cell A1 contains a date, and cell A2
contains a number between 1 and 7 (1 for Sunday, 2 for Monday, and so on).

=A1+AZ2-WEEKDAY (A1)+(AZ2<WEEKDAY (A1))*7

If cell A1 contains June 1, 2001 and cell A2 contains 2 (for Monday), the formula
returns June 4, 2001. This is the first Monday after June 1, 2001 (which is a Friday).

Determining the nth Occurrence of a Day
of the Week in a Month

You may need a formula to determine the date for a particular occurrence of a
weekday. For example, suppose your company payday falls on the second Friday of
each month, and you need to determine the paydays for each month of the year.
The following formula will make this type of calculation:

=DATE(AL1,A2,1)+A3-WEEKDAY (DATE(AL,A2,1))+
(A4-(A3>=WEEKDAY (DATE(AL,AZ2,1))))*7

The formula in this section assumes:

Cell A1 contains a year
Cell A2 contains a month

Cell A3 contains a day number (1 for Sunday, 2 for Monday, etc.)

® & o o

Cell A4 contains the occurrence number (for example, 2 to select the sec-
ond occurrence of the weekday specified in cell A3)

If you use this formula to determine the date of the first Friday in June 2002, it
returns June 7, 2002.
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If the value in cell A4 exceeds the number of the specified day in the month,

the formula returns a date from a subsequent month. For example, if you

o

attempt to determine the date of the fifth Friday in June 2002 (there is no

such date), the formula returns the first Friday in July.

Counting the Occurrences of a Day of the Week

You can use the following formula to count the number of occurrences of a partic-
ular day of the week for a specified month. It assumes that cell A1 contains a date,
and cell B1 contains a day number (1 for Sunday, 2 for Monday, etc.). The formula
is an array formula, so you must enter it using Ctrl+Shift+Enter.

{=SUM((WEEKDAY (DATE(YEAR(AL) ,MONTH(AL),ROWCINDIRECT("1:"&
DAY (DATE(YEAR(AL) ,MONTH(A1)+1,0))))))=B1)*1)}

If cell A1 contains the date January 5, 2002, and cell B1 contains the value 3 (for
Tuesday), the formula returns 5, which reveals that January 2002 contains five
Tuesdays.

The preceding array formula calculates the year and month by using the YEAR
and MONTH functions. You can simplify the formula a bit if you store the year and
month in separate cells. The following formula (also an array formula) assumes that
the year appears in cell A1, the month in cell A2, and the day number in cell B1:

{=SUMC(WEEKDAY (DATE(AL,AZ2,ROWCINDIRECT("1:"&
DAY (DATE(AL,A2+1,0))))))=B1)*1)}

Figure 6-5 shows this formula used in a worksheet. In this case, the formula uses
mixed cell references so you can copy it. For example, the formula in cell C3 is:

{=SUM((WEEKDAY (DATE($B$2, $A3,ROWCINDIRECT("1:"&
DAY (DATE($B$2,$A3+1,0))))))=C$1)*1)}

Additional formulas use the SUM function to calculate the number of days per
month (column J) and the number of each weekday in the year (row 15).

The workbook shown in Figure 6-5 is available on the companion CD-ROM.
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B day of the week count.xls [_[O]x]
A B C D E F G H | J 3

1] 1 2 3 4 5 6 7 =

|2 lvear > B Sun [ Mon | Tue [ Wed | Thu Fri Sat | Month

| 3| 1 January 4 4 5 5 5 4 4 3

| 4] 2 Fehruary 4 4 4 4 4 4 4 23

| 5| 3 March ] 4 4 4 4 ] ] H

| B | 4 April 4 5 5 4 4 4 4 30

| 7 | 5 May 4 4 4 ] ] ] 4 3

[ 8| G June ] 4 4 4 4 4 ] 30

1 9 | 7 July 4 5 5 5 4 4 4 31

[ 10 | 3 August 4 4 4 4 ] ] ] 3

11 9 Seg | 5 5 4 4 4 4 4 30

[12] 10 October 4 4 ] ] ] 4 4 3

(13| 17 November 4 4 4 4 4 5 5 30

[14] 12 December 5 5 5 4 4 4 4 Ell

[ 15| Total Days: 52 52 53 52 52 52 52 365

16 =

4 4 ¥ il Sheetl K1 | Lljj

Figure 6-5: Calculating the number of each weekday in each month of a year

Expressing a Date as an Ordinal Number

You may want to express the day portion of a date as an ordinal number. For
example, you can display 4/6/2000 as April 6th, 2000. The following formula
expresses the date in cell A1 as an ordinal date:

=TEXT(AL, "mmmm ")&DAY (A1)&IF(INT(MOD(DAY(A1),100)/10)=1,
"th",IF(MOD(DAY(A1),10)=1,
"st",IF(MOD(DAY(A1),10)=2,"nd",IF(MOD(DAY(A1),10)=3,
"rd","th"))))&TEXT(AL,", yyyy")

The result of this formula is text, not an actual date.

The following formula shows a variation that expresses the date in cell Al in
day-month-year format. For example, 4/6/2000 would appear as 4th April, 2000.
Again, the result of this formula represents text, not an actual date.

=DAY(AL)&IF(INT(MOD(DAY(A1),100)/10)=1, "th", IF(MOD(DAY(A1),10)=1,
"st",IF(MOD(DAY(A1),10)=2,"nd", IF(MOD(DAY(A1),10)=3, "rd","th"))))&
"" &TEXT (AL, "mmmm, yyyy")

The companion CD-ROM contains a workbook that demonstrates the for-
mulas for expressing dates as ordinal numbers.
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Calculating Dates of Holidays

Determining the date for a particular holiday can be tricky. Some, such as New
Year’s Day and U.S. Independence Day, are no-brainers, because they always occur
on the same date. For these kinds of holidays, you can simply use the DATE
function, which I covered earlier in this chapter. To enter New Year's Day (which
always falls on January 1) for a specific year in cell A1, you can enter this function:

=DATE(AL,1,1)

Other holidays are defined in terms of a particular occurrence of a particular
weekday in a particular month. For example, Labor Day falls on the first Monday in
September.

Figure 6-6 shows a workbook with formulas to calculate the date for 10 U.S. hol-
idays. The formulas reference the year in cell Al. Notice that because New Year’s
Day, Independence Day, Veterans Day, and Christmas Day all fall on the same days
of the year, the DATE function calculates their dates.

ooyt @EEE|
A B c D E =
1 | 2002 < Enter the year | |
2
| 3 | Holiday Calculations
]
| 5 | Holiday Description Date Weekday
| 6 | WNews Year's Day 1st Day in January January 1, 2002 Tuesday
| 7 Martin Luther King Jr. Day |3rd Monday in January January 21, 2002 Monday
| & | Presidents' Day 3rd Monday in February February 18, 2002 Monday
| 9 | Memorial Day Last Monday in May May 27, 2002 Monday
| 10| Independence Day 4th Day of July July 4, 2002 Thursday
11 Labor Day 1st Monday in September September 2, 2002 Monday
| 12 | “Weterans Day 11th Day of November MWovember 11, 2002 Monday
| 13 | Columbus Day 2nd Monday in October October 14, 2002 Monday e
| 14 | Thanksgiving Day 4hThursday in Novermber MNovember 28, 2002 Thursday
| 15| Christmas Day 25th Day of December Decernber 25, 2002 Wednesday
16 =
4 ¥ FilSheet1 K | P

Figure 6-6: Using formulas to determine the date for various holidays

The workbook shown in Figure 6-6 also appears on the companion CD-ROM.

MARTIN LUTHER KING JR. DAY

This holiday occurs on the third Monday in January. This formula calculates Martin
Luther King Jr. Day for the year in cell A1l:

=DATE(AL,1,1)+IF(2<WEEKDAY(DATE(AL,1,1)),7-WEEKDAY
(DATE(AL,1,1))+2,2-WEEKDAY (DATE(AL,1,1)))+((3-1)*7)
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PRESIDENTS’ DAY

Presidents’ Day occurs on the third Monday in February. This formula calculates
Presidents’ Day for the year in cell Al:

=DATE(AL1,2,1)+IF(2<WEEKDAY(DATE(A1,2,1)),7-WEEKDAY
(DATE(AL,2,1))+2,2-WEEKDAY (DATE(AL,2,1)))+((3-1)*7)

MEMORIAL DAY

The last Monday in May is Memorial Day. This formula calculates Memorial Day for
the year in cell Al:

=DATE(AL1,6,1)+IF(2<WEEKDAY(DATE(A1,6,1)),7-WEEKDAY
(DATE(AL,6,1))+2,2-WEEKDAY (DATE(AL,6,1)))+((1-1)*7)-7

Notice that this formula actually calculates the first Monday in June, and then
subtracts 7 from the result to return the last Monday in May.

LABOR DAY
Labor Day occurs on the first Monday in September. This formula calculates Labor
Day for the year in cell Al:

=DATE(AL1,9,1)+IF(2<WEEKDAY(DATE(A1,9,1)),7-WEEKDAY
(DATE(AL,9,1))+2,2-WEEKDAY (DATE(AL,9,1)))+((1-1)*7)

COLUMBUS DAY
This holiday occurs on the second Monday in October. This formula calculates
Columbus Day for the year in cell Al:

=DATE(A1,10,1)+IF(2<WEEKDAY(DATE(A1,10,1)),7-WEEKDAY
(DATE(A1,10,1))+2,2-WEEKDAY (DATE(AL1,10,1)))+((2-1)*7)

THANKSGIVING DAY
Thanksgiving Day is celebrated on the fourth Thursday in November. This formula
calculates Thanksgiving Day for the year in cell Al:

=DATE(A1,11,1)+IF(5<WEEKDAY(DATE(AL,11,1)),7-WEEKDAY
(DATE(AL,11,1))+5,5-WEEKDAY (DATE(AL,11,1)))+((4-1)*7)
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Calculating Easter

You'll notice that | omitted Easter from the previous section. Easter is an unusual
holiday because its date is determined based on the phase of the moon and not by the
calendar. Because of this, determining when Easter occurs proves a bit of a challenge.

Hans Herber, an Excel master in Germany, once sponsored an Easter formula contest
at his Web site. The goal was to create the shortest formula possible that correctly
determined the date of Easter for the years 1900 through 2078.

Twenty formulas were submitted, ranging in length from 44 characters up to 154
characters. Some of these formulas, however, work only with European date settings.
The following formula, submitted by Thomas Jansen, is the shortest formula that
works with any date setting. This formula returns the date for Easter, and assumes the
year is stored in cell A1:

=DOLLARC("4/"&A1)/7+MOD(19*MOD(AL,19)-7,30)*14%,)*7-6

Please don't ask me to explain this formula. | haven't a clue!

Determining the Last Day of a Month

To determine the date that corresponds to the last day of a month, you can use the
DATE function. However, you need to increment the month by 1, and use a day
value of 0. In other words, the “Oth” day of the next month is the last day of the
current month.

The following formula assumes that a date is stored in cell Al. The formula
returns the date that corresponds to the last day of the month.

=DATE(YEAR(AL) ,MONTH(ALI)+1,0)

You can use a variation of this formula to determine how many days comprise a
specified month. The formula that follows returns an integer that corresponds to
the number of days in the month for the date in cell Al:

=DAY (DATE(YEAR(AL) ,MONTH(A1)+1,0))

Determining Whether a Year 1Is a Leap Year

To determine whether a particular year is a leap year, you can write a formula that
determines whether the 29th day of February occurs in February or March. You can
take advantage of the fact that Excel’s DATE function adjusts the result when you
supply an invalid argument — for example, a day of 29 when February contains
only 28 days.
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The following formula returns TRUE if the year of the date in cell A1l is a leap
year. Otherwise, it returns FALSE.

=IF(MONTH(DATE(YEAR(AL1),2,29))=2,TRUE, FALSE)

This function returns the wrong result (TRUE) if the year is 1900. See “Excel’s
Leap Year Bug,”earlier in this chapter.

Determining a Date’s Quarter

For financial reports, you might find it useful to present information in terms of
quarters. The following formula returns an integer between 1 and 4 that corre-
sponds to the calendar quarter for the date in cell Al:

=ROUNDUP (MONTH(A1)/3,0)

This formula divides the month number by 3, and then rounds up the result.

Converting a Year to Roman Numerals

Fans of old movies will like this one. The following formula converts the year 1945
to Roman numerals. It returns MCMXLV.

=ROMAN(1945)

You can access the ROMAN function once you install the Analysis ToolPak. This
function returns a text string, so you can’t perform any calculations using the
result! Unfortunately, Excel doesn’t provide a function to convert Roman numerals
back to normal numbers.

Creating a Calendar in a Range

The example calendar you see in Figure 6-7 uses a single formula (an array formula)
to display a calendar in a range of cells. The scroll bars are linked to cells that con-
tain the month and year. The month is stored in cell B2 (named m) and the year is
stored in cell D2 (named y). Enter the following array formula into the range B6:H11:

{=IF(MONTH(DATE(Cy,m,1))<>MONTH(DATE(y,m,1)- (WEEKDAY
(DATE(y,m,1))-1)+{0;1;2;3;4;5}*7+{1,2,3,4,5,6,7}-1),
""", DATE(y,m,1)-(WEEKDAY(DATE(y,m,1))-1)+{0;1;2;3;4;5}
*7+{1,2,3,4,5,6,7}-1)}



Chapter 6: Working with Dates and Times 167

!Mnmh Year B
T T T -0 Curentiorth | 5
Sun Mon Tue Wed Thu Fri Sat
1 7 3 4 5 3
7 8 ] 10 " 12 13
14 15 16 17 18 19 20
21 72 73 24 75 76 77
28 29 30
I~ Protect worksheet =
I 4 » M Mates 3 Calendar | 4] | I

Figure 6-7: You can generate this calendar by using a single array formula,
entered into 42 cells.

ONTHE ¢d) You can access the workbook shown in Figure 6-7 on the companion
‘ ‘l CD-ROM.

Time-Related Functions

Excel, as you might expect, also includes a number of functions that enable you to
work with time values in your formulas. This section contains examples that
demonstrate the use of these functions.

Table 6-6 summarizes the time-related functions available in Excel. When you
use the Paste Function dialog box, these functions appear in the Date & Time func-
tion category.
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TasLE 6-6 TIME-RELATED FUNCTIONS

Function Description

HOUR Converts a serial number to an hour

MINUTE Converts a serial number to a minute

MONTH Converts a serial number to a month

NOW Returns the serial number of the current date and time
SECOND Converts a serial number to a second

TIME Returns the serial number of a particular time
TIMEVALUE Converts a time in the form of text to a serial number

Displaying the Current Time

This formula displays the current time as a time serial number (or, a serial number
without an associated date):

=NOW()-TODAY ()

TIP To enter a time stamp into a cell, press Ctrl+Shift+: (colon).
P 7

You need to format the cell with a time format to view the result as a recogniz-
able time. For example, you can apply the following number format:

hh:mm AM/PM

You can also display the time, combined with text. The formula that follows dis-
plays the text, “The current time is 6:28 PM".

="The current time is "&TEXT(NOW(),"h:mm AM/PM")
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These formulas are updated only when the worksheet is calculated.

o

Displaying Any Time

Earlier in this chapter, I described how to enter a time value into a cell: Just type it
into a cell, making sure that you include at least one colon (:). You can also create
a time by using the TIME function. For example, the following formula returns a
time comprised of the hour in cell A1, the minute in cell B1, and the second in
cell C1:

=TIME(AL,B1,C1)

Like the DATE function, the TIME function accepts invalid arguments and
adjusts the result accordingly. For example, the following formula uses 80 as the
minute argument, and returns 10:20:15 AM. The 80 minutes are simply added to
the hour, with 20 minutes remaining.

=TIME(9,80,15)

If you enter a value greater than 24 as the first argument for the TIME func-
tion, the result may not be what you expect. Logically, a formula such as the

one that follows should produce a date/time serial number of 1.041667 (that
is,one day and one hour).

=TIME(25,0,0)

In fact, this formula is equivalent to the following:

=TIME(1,0,0)

You can also use the DATE function along with the TIME function in a single
cell. The formula that follows generates 37229.7708333333, the serial number that
represents 6:30 PM on December 4, 2001:

=DATE(2001,12,4)+TIME(18,30,0)
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The TIMEVALUE function converts a text string that looks like a time into a
time serial number. This formula returns 0.2395833333, the time serial number for
5:45 AM:

=TIMEVALUE("5:45 am")

To view the result of this formula as a time, you need to apply number format-
ting to the cell. The TIMEVALUE function doesn’t recognize all common time for-
mats. For example, the following formula returns an error because Excel doesn’t
like the periods in “a.m.”

=TIMEVALUE("5:45 a.m.")

Summing Times That Exceed 24 Hours

Many people are surprised to discover that, when you sum a series of times that
exceed 24 hours, Excel doesn’t display the correct total. Figure 6-8 shows an exam-
ple. The range B2:B8 contains times that represent the hours and minutes worked
each day. The formula in cell B9 is:

=SUM(B2:B8)

As you can see, the formula returns a seemingly incorrect total (18 hours, 30
minutes). The total should read 42 hours, 30 minutes. The problem is that the for-
mula is really displaying a date/time serial number of 1.770833, but the cell for-
matting is not displaying the “date” part of the date/time.

i Book3 [_[o]x]
A B c o] 3‘
| 1 |Day Hours Worked
[ 2 |Sunday 1]
| 3 |Monday 8:30
| 4 |Tuesday 8:00
| & |Wednesday 9:00
| B |Thursday 9:30
| 7 |Friday 4:30
& |Saturday 3:.00
| 9 |Total for Week: 18:30
|10
il .
|<ﬂ¢ v ri\Sheetl / 4] | ﬂJJA

Figure 6-8: Using the SUM function to add a series of times. The
answer is incorrect because cell B9 has the wrong number format.

To view a time that exceeds 24 hours, you need to change the number format for
the cell so square brackets surround the hour part of the format string. Applying the
number format here to cell B9 displays the sum correctly:

[h]l:mm
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Figure 6-9 shows another example of a worksheet that manipulates times. This
worksheet keeps track of hours worked during a week (regular hours and overtime
hours).

& lime sheel.xls M=l
A B © D E F G H | =

1 I Pratect sheet 7
a Employee Time Sheet

| 3 | Employee Name: |Gina Davison

| 4 | Department: |Tech Support

| 6 | Start Day: |3/4/2002
B

| Start Time Out Time In End Total Weekhy

| 7 | Weekday Date Work {Lunch} {Lunch) Work Hours Hours

| 8 | Monday 3472002 | 8:00AM | 1200PM | T00PM | EO0FPM 9:00 9:00

ER Tuesday 3/5/2002 | 10:00 AM | 2:00 PM 230PM | 7:00 PM 8:30 17:30

| 10| [ Wednesday | 3/6/2002 | S00AM | 1200FPM | 1:00PM | 6:30 PM 8:30 26:00

| 11 Thursday 372002 | 730AM | 1130 AM | 1200 PM | 600 PM 10:00 36:00

| 12 | Friday G002 | 930 AM | 200 P 3:30PM | 500 P 6:00 42:00

| 13 | Saturday 3/9/2002 0:00 42:00

| 14 | Sunday 31072002 0:00 42:00

| 15 |

i s

| 17 | Total hours: 42:00

| 16 | Regqular hours: 40:00

119 | Overtime hours: 2:00 Clear | Help |

| 20|

21 -

W 4 » wTimeSheet / 1= L”J/

Figure 6-9: An employee timesheet workbook

The week’s starting date appears in cell D5, and the formulas in column B fill in
the dates for the days of the week. Times appear in the range D8:G14, and formu-
las in column H calculate the number of hours worked each day. For example, the
formula in cell H8 is:

=IF(E8<D8,E8+1-D8,E8-D8)+IF(G8<F8,G8+1-G8,G8-F8)

The first part of this formula subtracts the time in column D from the time in
column E to get the total hours worked before lunch. The second part subtracts the
time in column F from the time in column G to get the total hours worked after
lunch. T use IF functions to accommodate graveyard shift cases that span
midnight — for example, an employee may start work at 10:00 PM and begin lunch
at 2:00 AM. Without the IF function, the formula returns a negative result.

The following formula in cell H17 calculates the weekly total by summing the
daily totals in column H:

=SUM(H8:H14)



172

Part 11: Using Functions in Your Formulas

This worksheet assumes that hours that exceed 40 hours in a week are consid-
ered overtime hours. The worksheet contains a cell named Overtime (not shown in
Figure 6-9). This cell contains the following formula:

=1+TIME(16,0,0)
This formula returns 40:00 (that is, 24 hours plus 16 hours). If your standard
workweek consists of something other than 40 hours, you can change this formula.
The following formula (in cell H18) calculates regular (non-overtime) hours.

This formula returns the smaller of two values: the total hours, or the overtime
hours.

=MIN(E17,0vertime)

The final formula, in cell H19, simply subtracts the regular hours from the total
hours to yield the overtime hours.

=E17-E18

The times in H17:H19 may display time values that exceed 24 hours, so these
cells use a custom number format:

[hl:mm

The workbook shown in Figure 6-9 also appears on the companion CD-ROM.

Calculating the Difference between Two Times

Because times are represented as serial numbers, you can subtract the earlier time
from the later time to get the difference. For example, if cell A2 contains 5:30:00
and cell B2 contains 14:00:00, the following formula returns 08:30:00 (a difference
of eight hours and 30 minutes):

=B2-A2

If the subtraction results in a negative value, however, it becomes an invalid
time; Excel displays a series of hash marks (#######) because a time without a
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date has a date serial number of 0. A negative time results in a negative serial num-
ber, which is not permitted.

If the direction of the time difference doesn’t matter, you can use the ABS func-
tion to return the absolute value of the difference:

=ABS(B2-A2)

This “negative time” problem often occurs when calculating an elapsed time —
for example, calculating the number of hours worked given a start time and an end
time. This presents no problem if the two times fall in the same day. But if the work
shift spans midnight, the result is an invalid negative time. For example, you may
start work at 10:00 PM and end work at 6:00 AM the next day. Figure 6-10 shows
a worksheet that calculates the hours worked. As you can see, the shift that spans
midnight presents a problem.

Bl Book3

A B C o] 3
1 |Start Shift End Shift Hours Worked
| 2| 8:00 A 5:30 PM 2:30 J
| 3 | 10:00 P G000 AM | SRR
| 4|
5
| 6 |
4 4 » k}Sheetl / |« | L”JA

Figure 6-10: Calculating the number of hours worked
returns an error if the shift spans midnight.

Using the ABS function (to calculate the absolute value) isn’t an option in this
case because it returns the wrong result (16 hours). The following formula, how-
ever, does work:
=(B2+(B2<A2)-A2)

Another, simpler, formula can do the job:

=MOD(B2-A2,1)

TIP Negative times are permitted if the workbook uses the 1904 date system.To
$M switch to the 1904 date system, select Tools — Options, and click the
\
y/

Calculation tab. Place a check mark next to the 1904 date system option. But

beware! When changing the workbook’s date system, if the workbook uses
dates, the dates will be off by four years.
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Converting from Military Time

Military time is expressed as a four-digit number from 0000 to 2359. For example,
1:00 AM is expressed as 0100 hours, and 3:30 PM is expressed as 1530 hours. The
following formula converts such a number (assumed to appear in cell A1) to a stan-
dard time:

=TIMEVALUE(LEFT(AL,2)&":"&RIGHT(AL,2))

The formula returns an incorrect result if the contents of cell A1 do not contain
four digits. The following formula corrects the problem, and returns a valid time for
any military time value from 0 to 2359:

=TIMEVALUE(LEFT(TEXT(AL,"0000"),2)&" : "&RIGHT(A1,2))

Following is a simpler formula that uses the TEXT function to return a formatted
string, and then uses the TIMEVALUE function to express the result in terms of a
time:

=TIMEVALUE(TEXT(AL,"00\:00"))

Converting Decimal Hours, Minutes,
or Seconds to a Time
To convert decimal hours to a time, divide the decimal hours by 24. For example, if

cell A1 contains 9.25 (representing hours), this formula returns 09:15:00 (nine
hours, 15 minutes):

=A1/24

To convert decimal minutes to a time, divide the decimal hours by 1,440 (the
number of minutes in a day). For example, if cell A1 contains 500 (representing
minutes), the following formula returns 08:20:00 (eight hours, 20 minutes):
=A1/1440

To convert decimal seconds to a time, divide the decimal hours by 86,400 (the
number of seconds in a day). For example, if cell A1 contains 65,000 (representing
seconds), the following formula returns 18:03:20 (18 hours, three minutes, and 20

seconds):

=A1/86400
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Adding Hours, Minutes, or Seconds to a Time

You can use the TIME function to add any number of hours, minutes, or seconds to
a time. For example, assume cell Al contains a time. The following formula adds
two hours and 30 minutes to that time and displays the result:

=A1+TIME(2,30,0)

You can use the TIME function to fill a range of cells with incremental times.
Figure 6-11 shows a worksheet with a series of times in 10-minute increments. Cell
A1 contains a time that was entered directly. Cell A2 contains the following for-

mula, which copied down the column:

=A1+TIME(0,10,0)

A B C 8] =

[ 1] &o0am I
(2| swmaw
3|  a;am
4|  s3am
5|  sa0AM
|6 |  as0am
7| somam
(8| a10aM
(9|  92mam
10| 930 Aw

[11]  9:40am =
[12]  sg0am
| 13 | 10:00 At
[14] 10010 AM

15 i

W 4 v nySheet1 / |«] | ﬂ]—dl

Figure 6-11: Using a formula to create a series
of incremental times

Converting between Time Zones

You may receive a worksheet that contains dates and times in Greenwich Mean
Time (GMT, sometimes referred to as Zulu time), and you need to convert these val-
ues to local time. To convert dates and times into local times, you need to deter-
mine the difference in hours between the two time zones. For example, to convert
GMT times to U.S. Central Standard Time, the hour conversion factor is -6.

You can’t use the TIME function with a negative argument, so you need to take
a different approach. One hour equals 1/24 of a day, so you can divide the time
conversion factor by 24, and then add it to the time.

Figure 6-12 shows a worksheet set up to convert dates and times (expressed in
GMT) to local times. Cell B1 contains the hour conversion factor (-5 hours for U.S.
Eastern Standard Time). The formula in B4, which copies down the column, is:

=A4+($B$1/24)
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Bl gmt conversion. xls =]

A B c =

Conversion Factor: 4 hours |
GMT Local Time

01/05/2002 01:00 Ah 01/04/2002 08:00 Ph
01/06/2002 03:30 An 01/04/2002 10:30 P
01/05/2002 06:00 AN 01/05/2002 01:00 Al
01/06/2002 08:30 An 01/05/2002 03:30 At
01/05/2002 11:00 AN 01/05/2002 05:00 At
01/05/2002 01:30 PW 01/05/2002 08:30 Ak
01/06/2002 04:00 Ph| 01/05/2002 11:00 At
01/05/2002 06:30 Pn - 01/05/2002 01:30 PM
01/05/2002 09:00 P 01/05/2002 04:00 Ph
01/06/2002 11:30 Ph 01/05/2002 06:30 P
01/06/2002 02:00 AN 01/05/2002 09:00 P
01/06/2002 04:30 An 01052002 11:30 P
01/06/2002 07:00 AN 01/068/2002 02:00 A
01/06/2002 09:30 AW 01/08/2002 04:30 Ak
01/06/2002 12:00 Ph| 01/06/2002 07:00 At

=1
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=
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Figure 6-12: This worksheet converts dates and times
between time zones.

This formula effectively adds x hours to the date and time in column A. If cell B1
contains a negative hour value, the value subtracts from the date and time in col-
umn A. Note that, in some cases, this also affects the date.

Rounding Time Values

You may need to create a formula that rounds a time to a particular value. For
example, you may need to enter your company’s time records rounded to the near-
est 15 minutes. This section presents examples of various ways to round a time
value.

The following formula rounds the time in cell A1 to the nearest minute:

=ROUND(A1*1440,0)/1440

The formula works by multiplying the time by 1440 (to get total minutes). This
value is passed to the ROUND function, and the result is divided by 1440. For
example, if cell A1 contains 11:52:34, the formula returns 11:53:00.

The following formula resembles this example, except that it rounds the time in
cell Al to the nearest hour:

=ROUND(A1*24,0)/24

If cell A1 contains 5:21:31, the formula returns 5:00:00.
The following formula rounds the time in cell A1 to the nearest 15 minutes:

=ROUND(A1*24/0.25,0)*(0.25/24)
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In this formula, 0.25 represents the fractional hour. To round a time to the near-
est 30 minutes, change 0.25 to 0.5, as in the following formula:

=ROUND(A1*24/0.5,0)*(0.5/24)

Working with Non-Time-of-Day Values

Sometimes, you may want to work with time values that don’t represent an actual
time of day. For example, you might want to create a list of the finish times for a
race, or record the time you spend jogging each day. Such times don’t represent a
time of day. Rather, a value represents the time for an event (in hours, minutes, and
seconds). The time to complete a test, for instance, might take 35 minutes and 40
seconds. You can enter that value into a cell as:

00:35:45

Excel interprets such an entry as 12:35:45 AM, which works fine (just make sure
that you format the cell so it appears as you like). When you enter such times that
do not have an hour component, you must include at least one zero for the hour. If
you omit a leading zero for a missing hour, Excel interprets your entry as 35 hours
and 45 minutes.

Figure 6-13 shows an example of a worksheet set up to keep track of someone’s
jogging activity. Column A contains simple dates. Column B contains the distance,
in miles. Column C contains the time it took to run the distance. Column D contains
formulas to calculate the speed, in miles per hour. For example, the formula in cell
D2 is:

=B2/(C2*24)

IW

E

A B c 8] E F G 3
Speed Pace YTD |Cumulative
1 Date Distance Time {mph) (min/mile) | Distance Time
| 2 | 11/2002 150 0O0:18:45 4.60 12.50 1.50 00:18:45
| 3 | 17272002 150 00:17:40 5.09 11.78 3.00 00:36:25
| 4 | 1/3/2002 200 00:21:30 5.58 10.75 5.00 00:57:55
| 5 | 1/4/2002 150 00:15:20 5.87 10.22 B.50 01:13:15
| 6 | 1/5/2002 240 002505 574 10.45 .90 01:38:20
| 7 | 142002 300 00:31:06 579 10,37 11.90 (02:0%:26
| 8 | 1772002 380 0041:06 5.55 10.52 15.70 02:50:32
| 9 | 1/8/2002 5.00  01:09:00 4.35 13.80 2070 03:58:32
| 10| 1/9/2002 400 00:45:10 5.31 11.29 24.70 04:44:42
| 11| 171072002 300 00:29:06 6.19 9.70 & 05:13:48
| 12 171142002 550 01:08:30 4.82 12.45 33.20 05:22:18
13
\: )‘1 » k5 Sheetl / JEN| | L“—A‘

Figure 6-13: This worksheet uses times not associated with
a time of day.
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Column E contains formulas to calculate the pace, in minutes per mile. For
example, the formula in cell E2 is:

=(C2*60*24)/8B2

Columns F and G contain formulas that calculate the year-to-date distance
(using column B), and the cumulative time (using column C). The cells in column G
are formatted using the following number format (which permits time displays that

exceed 24 hours):

[hh]:mm:ss

You can also access the workbook shown in Figure 6-13 on the companion
CD-ROM.

Summary

This chapter explored the date- and time-related features of Excel. I provided an
overview of Excel’s serial number date and time system, and I described how to
enter dates and times into cells. The chapter also listed many examples of formulas
that use dates and times.

The next chapter presents various techniques to count data in a spreadsheet.



Chapter 7

Counting and Summing
Techniques

IN THIS CHAPTER

*

Information on counting and summing cells

*

Information on counting and summing records in databases and pivot
tables

Basic counting formulas

Advanced counting formulas

Formulas for performing common summing tasks
Conditional summing formulas using a single criterion

Conditional summing formulas using multiple criteria

® & 6 6 o o

The use of VBA to perform counting and summing tasks

MANY OF THE MOST FREQUENTLY ASKED spreadsheet questions involve counting and
summing values and other worksheet elements. It seems that people are always
looking for formulas to count or sum various items in a worksheet. If I've done my
job, this chapter will answer the vast majority of such questions.

Counting and Summing
Worksheet Cells

Generally, a counting formula returns the number of cells in a specified range that
meet certain criteria. A summing formula returns the sum of the values of the cells
in a range that meet certain criteria. The range you want counted or summed may
or may not consist of a worksheet database.

Table 7-1 lists Excel’s worksheet functions that come into play when creating
counting and summing formulas. If none of the functions in Table 7-1 can solve
your problem, it’s likely that an array formula can come to the rescue.

179



180

Part 11: Using Functions in Your Formulas

See Part V for detailed information and examples of array formulas used for
counting and summing.

TasLe 7-1 EXCEL'S COUNTING AND SUMMING FUNCTIONS

Function

COUNT
COUNTA
COUNTBLANK
COUNTIF
DCOUNT

DCOUNTA

DEVSQ

DSUM

FREQUENCY

SUBTOTAL

SUM
SUMIF
SUMPRODUCT

SUMSQ

Description

Returns the number of cells in a range that contain a numeric value
Returns the number of nonblank cells in a range

Returns the number of blank cells in a range

Returns the number of cells in a range that meet a specified criterion

Counts the number of records in a worksheet database that meet
specified criteria

Counts the number of nonblank records in a worksheet database that
meet specified criteria

Returns the sum of squares of deviations of data points from the
sample mean; used primarily in statistical formulas

Returns the sum of a column of values in a worksheet database that
meet specified criteria

Calculates how often values occur within a range of values, and
returns a vertical array of numbers; used only in a multicell array
formula

When used with a first argument of 2 or 3, returns a count of cells
that comprise a subtotal; when used with a first argument of 9,
returns the sum of cells that comprise a subtotal

Returns the sum of its arguments
Returns the sum of cells in a range that meet a specified criterion

Multiplies corresponding cells in two or more ranges, and returns the
sum of those products

Returns the sum of the squares of its arguments; used primarily in
statistical formulas
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Function Description

SUMX2PY2 Returns the sum of the sum of squares of corresponding values in
two ranges; used primarily in statistical formulas

SUMXMY2 Returns the sum of squares of the differences of corresponding
values in two ranges; used primarily in statistical formulas

SUMX2MY2 Returns the sum of the differences of squares of corresponding
values in two ranges; used primarily in statistical formulas

Counting or Summing Records in
Databases and Pivot Tables

Special database functions and pivot tables provide additional ways to achieve
counting and summing. Excel’s DCOUNT and DSUM functions are database func-
tions. They work in conjunction with a worksheet database, and require a special
criterion range that holds the counting or summing criteria.

Chapter 9 covers the database functions and provides information about
counting and summing using a worksheet database.

Creating a pivot table is a great way to get a count or sum of items without
using formulas. Like the database function, using a pivot table is appropriate when
your data appears in the form of a database.

Refer to Chapter 18 for information about pivot tables.
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Getting a Quick Count or Sum

In Excel 97, Microsoft introduced a feature known as AutoCalculate. This feature
displays, in the status bar, information about the selected range. Normally, the status
bar displays the sum of the values in the selected range. You can, however, right-click
the AutoCalculate display to bring up a menu with some other options.

E2 Microsoft Excel - Book1 [_ (Ol =]
; File Edit “iew Insert Formsk  Tools Data  Window  Help Type aquestion for help &0 @ X
NeHomSRY (22 F|o- o (@ =4 3|l éow -0
£ arial w0 BIUSS=E %%, W8 == h AL
Al ~ e 24
A [ 8 [ ¢ [ D [ E F [ 6 [ H T [ 5
| 1] 24 21 42 40 o4
| 2 | B1 78 27 a8 K]
| 3 | 95 26 E] E] 42
EN 15 B2 78 25 A4
| 5 | a7 74 15 34 ey
| B | 92 34 fals} 1 15
| 7 | 48 43 96 B0 29
8 63 o7 75 10 54 tone
i fverage
10
11 | Caunt
12| Count Nums
|13
| 141
W 47 Hl\Sheet1 LU—‘
Ready I

If you select Count, the status bar displays the number of nonempty cells in the
selected range. If you select Count Nums, the status bar displays the number of
numeric cells in the selected range.

Basic Counting Formulas

The basic counting formulas presented here are all straightforward and relatively
simple. They demonstrate the ability of Excel’s counting functions to count the
number of cells in a range that meet specific criteria. Figure 7-1 shows a worksheet
that uses formulas (in column E) to summarize the contents of range A1:B10—a
20-cell range named Data.

ONTHE ¢) You can access the workbook shown in Figure 7-1 on the companion

‘ 1 corom.
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]
A El C ] E F =
Jan Feb Total cells: 20 |

525 718 Blank cells: 5]
Nonblank cells: 14

3 MNurmeric values: 7
552 911 Mon-text cells: 1
250 98 Text cells:

7

3

Logical values: 2

TRUE FALSE Error values: 2
#DPAl #lA errars: 0

Total #HIAME? #ULL! errors: 1]
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1
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#DIVI errors:
#vALUE! errors:
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w
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#IAME? errars:
#UMI errors:

=

m
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Figure 7-1: Formulas provide various counts of the
data in A1:B10.

Counting the Total Number of Cells

To get a count of the total number of cells in a range, use the following formula.
This formula returns the number of cells in a range named Data. It simply multi-
plies the number of rows (returned by the ROWS function) by the number of
columns (returned by the COLUMNS function).

=ROWS(Data)*COLUMNS(Data)

Counting Blank Cells

The following formula returns the number of blank (empty) cells in a range named
Data:

=COUNTBLANK(Data)

About This Chapter's Examples

Many of the examples in this chapter consist of array formulas. An array formula, as
explained in Chapter 14, is a special type of formula. You can spot an array formula
because it is enclosed in brackets when it is displayed in the formula bar. For example:

{=Data*2}

When you enter an array formula, press Ctrl+Shift+Enter (not just Enter). And don't
type the brackets (Excel inserts the brackets for you).
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The COUNTBLANK function also counts cells containing a formula that returns
an empty string. For example, the formula that follows returns an empty string if
the value in cell A1l is greater than 5. If the cell meets this condition, then the
COUNTBLANK function counts that cell.

=IF(A1>5,"" ,Al)

o

You can use the COUNTBLANK function with an argument that consists of entire
rows or columns. For example, this next formula returns the number of blank cells
in column A:

The COUNTBLANK function does not count cells that contain a zero value,
even if you uncheck the Zero values option in the Options dialog box (select
Tools — Options, then click the View tab).

=COUNTBLANK(A:A)

The following formula returns the number of empty cells on the entire worksheet
named Sheetl. You must enter this formula on a sheet other than Sheet1, or it will
create a circular reference.

=COUNTBLANK(Sheet1!1:65536)

Counting Nonblank Cells

The following formula uses the COUNTA function to return the number of non-
blank cells in a range named Data:

=COUNTA(Data)

The COUNTA function counts cells that contain values, text, or logical values
(TRUE or FALSE).

o

If a cell contains a formula that returns an empty string, that cell is included
in the count returned by COUNTA, even though the cell appears to be
blank.
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Counting Numeric Cells

To count only the numeric cells in a range, use the following formula (which
assumes the range is named Data):

=COUNT(Data)

Cells that contain a date or a time are considered to be numeric cells. Cells that
contain a logical value (TRUE or FALSE) are not considered to be numeric cells.

Counting Nontext Cells

The following array formula uses Excel’s ISNONTEXT function, which returns TRUE
if its argument refers to any nontext cell (including a blank cell). This formula
returns the count of the number of cells not containing text (including blank cells):

{=SUMCIFCISNONTEXT(Data),1))!}

Counting Text Cells

To count the number of text cells in a range, you need to use an array formula. The
array formula that follows returns the number of text cells in a range named Data:

{=SUM(IF(ISTEXT(Data),1))!}

Counting Logical Values
The following array formula returns the number of logical values (TRUE or FALSE)
in a range named Data:

{=SUM(IF(ISLOGICAL(Data),1))!}

Error Values in a Range
Excel has three functions that help you determine whether a cell contains an error
value:
€ [SERROR: Returns TRUE if the cell contains any error value (#N/A,
#VALUE!, #REF!, #DIV/0!, #NUM!, #NAME?, or #NULL!)
¢ ISERR: Returns TRUE if the cell contains any error value except #N/A
@ [SNA: Returns TRUE if the cell contains the #N/A error value
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You can use these functions in an array formula to count the number of error
values in a range. The following array formula, for example, returns the total num-
ber of error values in a range named Data:

{=SUM(IF(ISERROR(data),1))}

Depending on your needs, you can use the ISERR or ISNA function in place of
ISERROR.

If you would like to count specific types of errors, you can use the COUNTIF
function. The following formula, for example, returns the number of #DIV/0! error
values in the range named Data:

=COUNTIF(Data,"#DIV/0!")

Advanced Counting Formulas

Most of the basic examples I presented previously use functions or formulas that
perform conditional counting. The advanced counting formulas that I present here
represent more complex examples for counting worksheet cells, based on various
types of criteria.

Counting Cells Using the COUNTIF Function

Excel’s COUNTIF function is useful for single-criterion counting formulas. The
COUNTIF function takes two arguments:

@ range: The range that contains the values that determine whether to
include a particular cell in the count.
@ criteria: The logical criteria that determine whether to include a particular

cell in the count.

Listed here are several examples of formulas that use the COUNTIF function.
These formulas all work with a range named Data. As you can see, the criteria
argument proves quite flexible. You can use constants, expressions, functions, cell
references, and even wildcard characters (* and ?).

The following formula returns the number of cells containing the value 12:

=COUNTIF(Data,12)
The following formula returns the number of cells containing a negative value:

=COUNTIF(Data,"<0")
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The following formula returns the number of cells not equal to 0:
=COUNTIF(Data,"<>0")

The following formula returns the number of cells greater than 5:
=COUNTIF(Data,">5")

The following formula returns the number of cells equal to the contents of cell Al:
=COUNTIF(Data,Al)

The following formula returns the number of cells greater than the value in
cell Al:

=COUNTIF(Data,">"&Al)
The following formula returns the number of cells containing text:
=COUNTIF(Data,"*")

The following formula returns the number of text cells containing exactly three
characters:

=COUNTIF(Data,"??2?2")

The following formula returns the number of cells containing the single word
budget (not case sensitive):

=COUNTIF(Data, "budget")

The following formula returns the number cells containing the text budget any-
where within the text:

=COUNTIF(Data,"*budget*")

The following formula returns the number of cells containing text that begins
with the letter A (not case sensitive):

=COUNTIF(Data,"A*")
The following formula returns the number of cells containing the current date:

=COUNTIF(Data,TODAY())
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The following formula returns the number of cells with a value greater than the
average:

=COUNTIF(Data,">"&AVERAGE(Data))

The following formula returns the number of values exceeding three standard
deviations above the mean:

=COUNTIF(Data,">"&AVERAGE(Data)+STDEV(Data)*3)

The following formula returns the number of cells containing the value 3 or -3:
=COUNTIF(Data,3)+COUNTIF(Data,-3)

The following formula returns the number of cells containing logical TRUE:
=COUNTIF(Data, TRUE)

The following formula returns the number of cells containing a logical value
(TRUE or FALSE):

=COUNTIF(Data, TRUE)+COUNTIF(Data, FALSE)

The following formula returns the number of cells containing the #N/A error
value:

=COUNTIF(Data, "#N/A")

Counting Cells Using Multiple Criteria

In many cases, your counting formula will need to count cells only if two or more
criteria are met. These criteria can be based on the cells that are being counted, or
based on a range of corresponding cells.

Figure 7-2 shows a simple worksheet that I use for the examples in this section.
This sheet shows sales data categorized by Month, SalesRep, and Type. The work-
sheet contains named ranges that correspond to the labels in row 1.

This workbook is available on the companion CD-ROM.
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Bl multiple criteria counting.xls [_ O] %]

A B © D —

1 |Month |SalesRep  [Type |Amount | —
| 2 |January Albert Mew 85
| 3 |January Albert Mew 675
| 4 |[January Brooks Mewy 130
| & |January Cook Mew 1350
| B |January Cook Existing B35
| 7 |[January Brooks Mew 1350
| & |January Cook Mew 475
| 9 [January Brooks Mew 1208
| 10 |February Brooks Euxisting 450
| 11 |February Albert Mew 495
| 12 |February Cook Mewy 210
| 13 |February Cook Existing 1050
| 14 |February Albert Mew 140
| 16 |February Brooks Mew 900
| 16 [February Brooks Mew 900
| 17 [February Cook Mew 95
| 16 [February Cook Mew 780
| 19 |March Erooks Mew 900
| 20 [March Albert Existing a7s
| 21 [March Brooks Mew a0
| 22 |March Braoks Mew 875
| 23 [March Cook Existing 225
| 24 [March Cook Mew 178
| 25 [March Brooks Existing 400

| 26 |March Albert New G40 =
| 27 |March Cook Mew 132

\? 4+ [\ Sheet1 141 >l

Figure 7-2: This worksheet demonstrates
various counting techniques that use
multiple criteria.

USING AND CRITERIA

An And criterion counts cells if all specified conditions are met. A common exam-
ple is a formula that counts the number of values that fall within a numerical
range. For example, you may want to count cells that contain a value greater than
0 and less than or equal to 12. Any cell that has a positive value less than or equal
to 12 will be included in the count. For this example, the COUNTIF function will do
the job:

=COUNTIF(Data,">0")-COUNTIF(Data,">12")

This formula counts the number of values that are greater than 0 and then sub-
tracts the number of values that are greater than 12. The result is the number of
cells that contain a value greater than 0 and less than or equal to 12.

Creating this type of formula can be confusing, because the formula refers to a
condition “>12” even though the goal is to count values that are less than or equal
to 12. An alternate technique is to use an array formula, such as the one that fol-
lows. You may find creating this type of formula easier.

{=SUM((Data>0)*(Data<=12))}
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Sometimes, the counting criteria will be based on cells other than the cells being
counted. You may, for example, want to count the number of sales that meet the
following criteria:

¢ Month is January, and
¢ SalesRep is Brooks, and
¢ Amount is greater than 1000

The following array formula returns the number of items that meet all three
criteria:

{=SUM((Month="January")*(SalesRep="Brooks")*(Amount>1000))}

USING OR CRITERIA
To count cells using an Or criterion, you can sometimes use multiple COUNTIF
functions. The following formula, for example, counts the number of 1s, 3s, and 5s
in the range named Data:

=COUNTIF(Data,1)+COUNTIF(Data,3)+COUNTIF(Data,5)

You can also use the COUNTIF function in an array formula. The following array
formula, for example, returns the same result as the previous formula:

{=SUM(COUNTIF(Data,{1,3,5}))!}

But if you base your Or criteria on cells other than the cells being counted, the
COUNTIF function won’t work. Refer back to Figure 7-2. Suppose you want to
count the number of sales that meet the following criteria:

¢ Month is January, or
¢ SalesRep is Brooks, or
¢ Amount is greater than 1000

The following array formula returns the correct count:
{=SUM(IF((Month="January")+(SalesRep="Brooks")+(Amount>1000),1))}

COMBINING AND AND OR CRITERIA
You can combine And and Or criteria when counting. For example, perhaps you
want to count sales that meet the following criteria:

¢ Month is January, and
# SalesRep is Brooks, or SalesRep is Cook
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This array formula returns the number of sales that meet the criteria:

{=SUM((Month="January")*IF((SalesRep="Brooks" )+
(SalesRep="Cook"),1))}

Counting the Most Frequently Occurring Entry

Excel’s MODE function returns the most frequently occurring value in a range.
Figure 7-3 shows a worksheet with values in range A1:A10 (named Data). The for-
mula that follows returns 10 because that value appears most frequently in the Data
range:

~MODE (Data)
£l Book2 [_ (O] <]
A B C D E F [
1 1 10) =-- Mode =
2 4 3| =-- Frequency of the Made
3 7
4 10
5 10
5] 10
7 12
g 14
9 16
10 g
11
[y 5
W 4 ¥ #}Sheetl Il Il

Figure 7-3: The MODE function returns the most
frequently occurring value in a range.

To count the number of times the most frequently occurring value appears in the
range (in other words, the frequency of the mode), use the following formula:

=COUNTIF(Data,MODE(Data))

This formula returns 3, because the modal value (10) appears three times in the
Data range.

The MODE function works only for numeric values. It simply ignores cells that
contain text. To find the most frequently occurring text entry in a range, you need
to use an array formula.

To count the number of times the most frequently occurring item (text or values)
appears in a range named Data, use the following array formula:

{=MAX(COUNTIF(Data,Data))}

This next array formula operates like the MODE function, except that it works
with both text and values:

{=INDEX(Data,MATCH(MAX(COUNTIF(Data,Data)),COUNTIF(Data,Data),0))}
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Counting the Occurrences of Specific Text

The examples in this section demonstrate various ways to count the occurrences of
a character or text string in a range of cells. Figure 7-4 shows a worksheet used for
these examples. Various text appears in the range A1:A10 (named Data); cell B1 is
named Text.

A B c o] E F G
aa Alpha =
Alpha
ABA
aaa
Beta
=]

BEB

Alpha Beta
AB

alpha

=1

a

2 Entire cell (not case-sensitive)
1 Entire cell [case-sensitive)

@

=

m

3 Part of cell (hot case-sensitive)
2 Part of cell (case-sensitive)

[&7]

=

@

3 Total occurrences in range (not case-sensitive)
2 Total occurrences in range (case-sensitive) =

o

]
=]

I\Sheet1 / J T ﬂJjA

-
wn
-
]
n
3

Figure 7-4: This worksheet demonstrates various ways to count characters in a range.

ONTHE )} The companion CD-ROM contains a workbook that demonstrates the

\ ‘ formulas in this section.

ENTIRE CELL CONTENTS
To count the number of cells containing the contents of the Text cell (and nothing
else), you can use the COUNTIF function. The following formula demonstrates:

=COUNTIF(Data,Text)

For example, if the Text cell contains the string “Alpha”, the formula returns 2
because two cells in the Data range contain this text. This formula is not case sen-
sitive, so it counts both “Alpha” (cell A2) and “alpha” (cell A10). Note, however, that
it does not count the cell that contains “Alpha Beta” (cell A8).
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The following array formula is similar to the preceding formula, but this one is
case sensitive:

{=SUM(IF(EXACT(Data,Text),1))}

PARTIAL CELL CONTENTS
To count the number of cells that contain a string that includes the contents of the
Text cell, use this formula:

=COUNTIF(Data,"*"&Text&"*")

For example, if the Text cell contains the text “Alpha”, the formula returns 3,
because three cells in the Data range contain the text “alpha” (cells A2, A8, and
A10). Note that the comparison is not case sensitive.

If you need a case-sensitive count, you can use the following array formula:

{=SUM(IF(LEN(Data)-LENCSUBSTITUTE(Data,Text,""))>0,1))!}

If the Text cells contain the text “Alpha”, the preceding formula returns 2
because the string appears in two cells (A2 and A8).

TOTAL OCCURRENCES IN A RANGE
To count the total number of occurrences of a string within a range of cells, use the
following array formula:

{=(SUM(LEN(Data))-SUM(CLEN(SUBSTITUTE(Data,Text,""))))/
LEN(Text)}

If the Text cell contains the character “B,” the formula returns 7 because the
range contains seven instances of the string. This formula is case sensitive.
The following array formula is a modified version that is not case sensitive:

{=(SUMCLEN(Data))-SUMCLEN(SUBSTITUTECUPPER(Data),
UPPER(Text),""))))/LEN(Text))

Counting the Number of Unique Values

The following array formula returns the number of unique values in a range named
Data:

{=SUM(1/COUNTIF(Data,Data))}
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To understand how this formula works, you need a basic understanding of array
formulas. (See Chapter 14 for an introduction to this topic.) In Figure 7-5, range
A1:A12 is named Data. Range C1:C12 contains the following array formula
(entered into all 12 cells in the range):

{=COUNTIF(Data,Data)}

Ej count unique.xls [ O] x]
A =] [ 8] E F G 3
1 100 3 0.333333
2 100 3 0.333333
3 100 3 0.333333
4 200 2 0.5
=) 200 2 0.5
G 300 1 1
7 400 2 0.8
g 400 2 05
9 500 4 0.25
10 500 4 0.25
il 500 4 025
12 500 4 0.25
| 13 4 < Unigue itermns in Colurnn A
W TR Sheett <] LU—J

Figure 7-5: Using an array formula to count the
number of unique values in a range

You can access the workbook shown in Figure 7-5 on the companion
CD-ROM.

The array in range C1:C12 consists of the count of each value in Data. For
example, the number 100 appears three times, so each array element that corre-
sponds to a value of 100 in the Data range has a value of 3.

Range D1:D12 contains the following array formula:

{=1/C1:C12}

This array consists of each value in the array in range C1:C12, divided into 1.
For example, each cell in the original Data range that contains a 200 has a value of
0.5 in the corresponding cell in D1:D12.

Summing the range D1:D12 gives the number of unique items in Data. The array
formula presented at the beginning of this section essentially creates the array that
occupies D1:D12, and sums the values.

This formula has a serious limitation: If the range contains any blank cells, it
returns an error. The following array formula solves this problem:

{=SUM(IF(COUNTIF(Data,Data)=0,"",1/COUNTIF(Data,Data)))}
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To create an array formula that returns a list of unique items in a range, refer

to Chapter 15.

Creating a Frequency Distribution

A frequency distribution basically comprises a summary table that shows the fre-
quency of each value in a range. For example, an instructor may create a frequency
distribution of test scores. The table would show the count of As, Bs, Cs, and so on.
Excel provides a number of ways to create frequency distributions. You can:

¢ Use the FREQUENCY function
@ (reate your own formulas

@ Use the Analysis ToolPak add-in

ON THE ¢D A workbook that demonstrates these three techniques appears on the
| companion CD-ROM.

%

If your data is in the form of a database, you can also use a pivot table to

create a frequency distribution.

THE FREQUENCY FUNCTION

Using Excel’s FREQUENCY function presents the easiest way to create a frequency
distribution. This function always returns an array, so you must use it in an array
formula entered into a multicell range.

Figure 7-6 shows some data in range A1:E20 (named Data). These values range
from 1 to 500. The range G2:G11 contains the bins used for the frequency distribu-
tion. Each cell in this bin range contains the upper limit for the bin. In this case, the
bins consist of 1-50, 51-100, 101-150, and so on. See the sidebar, “Creating Bins
for a Frequency Distribution” to discover an easy way to create a bin range.
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A B (5] D E F G H =
[ 1] 55 316 223 185 124 Bins I—
| 2| 124 93 163 213 314 50
| 3 | 21 Ll eyl 2n 212 100
[ 4] 118 113 400 205 254 150
| 5 | 2652 1 201 172 101 200
| B | 167 479 205 337 118 250
[ 7| 489 15 89 362 148 300
[ 8| 179 245 125 197 177 350
1 9| 455 153 265 42 127 400
[ 10| 289 500 198 37 300 450
[ 11| 126 114 303 314 27 500
[12] 151 2m 347 314 170
[13] 250 175 93 209 &1
[ 14 | 166 113 356 124 242
[ 16| 152 364 167 233 99
| 16 | 27 195 436 B 240
17 147 an 173 211 244

@

366 a3 330 400 141
332 173 128 323 188
336 263 444 a4 220 S

» v\ FREQUET]| < | | Lljj

Figure 7-6: Creating a frequency distribution for
the data in A1:E20

©

]
=]

fi)

To create the frequency distribution, select a range of cells that correspond to the
number of cells in the bin range. Then enter the following array formula:

{=FREQUENCY(Data,G2:G11)!}

The array formula enters the count of values in the Data range that fall into each
bin. To create a frequency distribution that consists of percentages, use the follow-
ing array formula:

{=FREQUENCY (Data,G2:G10)/COUNT(Data)}

Figure 7-7 shows two frequency distributions — one in terms of counts, and one
in terms of percentages. The figure also shows a chart (histogram) created from the
frequency distribution.

USING FORMULAS TO CREATE A FREQUENCY DISTRIBUTION

Figure 7-8 shows a worksheet that contains test scores for 50 students in column B
(the range is named Grades). Formulas in columns G and H calculate a frequency
distribution for letter grades. The minimum and maximum values for each letter
grade appear in columns D and E. For example, a test score between 80 and 89
(inclusive) qualifies for a B.
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D F H |
| 1| 55 316 223 185 124 Bins | Freq | Percent
| 2 | 124 93 163 213 314 50 5 5.0%
| 3 | 211 41 23 241 212 100 g 9.0%
| 4 | 118 113 400 205 264 150 16 16.0%
| 6 | 252 1 201 172 101 200 19 19.0%
| 6 | 167 479 205 337 g 250 18 18.0%
| 7 | 489 15 i) 362 148 300 l 9.0%
| & | 179 248 125 197 177 380 12 12.0%
| 9 | 456 153 it 49 127 400 8 5.0%
| 10| 269 500 196 317 300 450 2 2.0%
|11 126 114 303 314 270 500 4 4.0%
| 12 | 151 278 47 314 170
| 13 | 250 175 93 209 61 0%
| 14 | 166 3 356 124 242
| 15 | 152 364 157 233 99 18%
| 16 | 27 195 436 B 240 16
| 17 | 147 a0 173 21 244
| 16 | 366 93 330 400 141 14% 1
(18] 332 173 12 33 188 12 |
| 20 | i} 263 444 G4 220
21 10% 1
|22 &%
23
|24 | 6%
E 4%
26
571 %
| 26| 0%
|29 | 50100 150 200 250 300 350 400 450 500 -
30 <
14 4 ¥ Il FREQUENCY Func |4 | oy

Figure 7-7: Frequency distributions created using the FREQUENCY function

c E F G |

1 |Student |Grades | Min | Max| Grade | Frequency Pct.
| 2 |Student 1 62 a0 | 100 A il 220%
| 3 |Student 2 a2 &0 | &8 B 10 20.0%
| 4 |Student 3 52 s | 78 C 19 3B.0%
| 5 [Student 4 60 41 | s0 D B 12.0%
| 6 |Student 5 81 a 40 F 4 8.0%
| 7 |Student& 66
| 6 [Student 7 63
| 9 |Student & 100 Grade Distribution
| 10| Student 9 46 20
| 11 [Student 10 a7 18
| 12 |Student 11 93
| 15 [Student 12 B4 8 |
| 14 |Student 13 44 14
| 15 |Student 14 71 12
| 16 [Student 15 100 10
| 17 |Student 16 40
| 18 [Student 17 35 E
| 19 Student 16 73 B
| 20 |Student 19 99 4
| 21 [Student 20 a3 2
| 22 |Student 21 a0
| 25 [Student 22 50 0
| 24 |Student 23 44
| 26 |Student 24 74

2B | Student 25 46 -
44 » wi[\ FREQUENCY Func f ATP 3, Formuli[ <] | oy

Figure 7-8: Creating a frequency distribution of test scores
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Creating Bins for a Frequency Distribution

When creating a frequency distribution, you must first enter the values into the bin
range. The number of bins determines the number of categories in the distribution.
Most of the time, each of these bins will represent an equal range of values.

To create 10 evenly spaced bins for values in a range named Data, enter the following
array formula into a range of 10 cells in a column:

{=MIN(Data)+(ROWCINDIRECT("1:10"))*
(MAX(Data)-MIN(Data)+1)/10)-1}

This formula creates 10 bins, based on the values in the Data range. The upper bin will
always equal the maximum value in the range.

To create more or fewer bins, use a value other than 10 and enter the array formula
into a range that contains the same number of cells. For example, to create five bins,
enter the following array formula into a five-cell vertical range:

{=MIN(Data)+(ROWCINDIRECT("1:5"))*(MAX(Data)-MIN(Data)+1)/5)-1}

The formula in cell G2 that follows is an array formula that counts the number
of scores that qualify for an A:

{=SUM((Grades>=D2)*(Grades<=E2))}

You may recognize this formula from a previous section in this chapter (see
“Counting Cells Using Multiple Criteria”). This formula was copied to the four cells
below G2.

The formulas in column H calculate the percentage of scores for each letter
grade. The formula in H2, which was copied to the four cells below H2, is:

=G2/SUM($G$2:$G$6)

USING THE ANALYSIS TOOLPAK TO CREATE

A FREQUENCY DISTRIBUTION

Once you install the Analysis ToolPak add-in, you can use the Histogram option
to create a frequency distribution. Start by entering your bin values in a range.
Then select Tools > Data Analysis to display the Data Analysis dialog box. Next,
select Histogram and click OK. You should see the Histogram dialog box shown in
Figure 7-9.
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gram

Input

£ Mew Workhook

I Pareto (sorked histogram)
F Cumulative Percentage:
¥ Chart Output

Input Range: $A51i$ES20 H‘:]
Bin Range: G2 6G1 L g5
[ Labels

~Oukput opkion:
& Output Range: $H§1 7 |
 Mew Workshest Ply:

oK

:

Cancel I
Help I

Figure 7-9: The Analysis ToolPak's Histogram dialog box

Specify the ranges for your data (Input Range), bins (Bin Range), and results
(Output Range), and then select any options. Figure 7-10 shows a frequency distri-
bution (and chart) created with the Histogram option.

Ej frequency distiibution. xls [_ O] %]
A B c D E G H | J K L —
| 1| 55 316 223 185 124 Bins Bin _ Frequency Cumuwiative % I—
| 2 | 124 93 163 213 314 a0 a0 ] 5.00%
| 3 | 21 4 23 241 212 100 100 9 14.00%
| 4 | 118 113 400 205 254 150 150 16 30.00%
| 5 | 262 1 201 172 1m 200 200 19 49.00%
| 6 | 167 479 205 337 118 250 250 18 67.00%
| 7 | 489 15 89 362 148 300 300 9 76.00%
| 8 | 179 248 125 197 177 350 350 12 88.00%
| 9 | 456 153 268 49 127 400 400 5] 94.00%
| 10 | 289 500 198 317 300 450 450 2 96.00%
| 11 | 126 114 303 314 270 500 500 4 100.00%
|12 151 278 347 314 170 flore 1] 100.00%
| 13 | 280 175 93 209 61
4] 86 113 3B 12 242 Histogram
| 15| 152 384 157 233 93 20 120.00%
| 16 | 277 195 436 5] 240 8 M
17| 147 @ 173 211 244 . Jra—
| 18 | 386 93 330 400 14
18] 3@ 73 123 33 e 14 0.00%
| 20| 338 263 444 84 220 g 12
|21 T B0.00%
22 g
| 22| Z s I
| 23| s 40.00%
|24
|25 | 4 H H 20.00%
26 2
| 27 | il [l 0%
ﬁ S0 100 150 200 250 300 350 400 450 500 More
£l -
30 —#— Cumulative ¥
El &
W 4 v WDLATP ¢ Formulas =] | ol

Figure 7-10: A frequency distribution and chart generated by the Analysis ToolPak's

Histogram option

Histogram procedure to update the results.

Note that the frequency distribution consists of values, not formulas.
Therefore, if you make any changes to your input data, you need to rerun the
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USING ADJUSTABLE BINS TO CREATE A HISTOGRAM

Figure 7-11 shows a worksheet with student grades listed in column B (67 students
total). Columns D and E contain formulas that calculate the upper and lower limits
for bins, based on the entry in cell E1 (named BinSize). For example, if BinSize is
10 (as in the figure), then each bin contains 10 scores (1-10, 11-20, and so on).

ﬂadiuslahle bins_xls [_ O] %]
A B C o] E F G H | J K L b j
L1 Bin Size:[__10_1
2
| 3 |Student _ Grades' Lower  Upper Freq
4 | Student 1 J<ic] 1 10 3
5 |Student 2 g2 11 20 B
B | Student 3 11 21 il 3
7 | Student 4 78 il 40 3
8 | Student & 61 4 a0 4
9 | Student 6 B3 51 <] 9
10 | Student 7 58 81 70 13
11 | Student 8 a3 71 a0 12
12 | Student 3 B5 81 90 1
13 | Student 10 53 Ell 100 3
14 | Student 11 77 101 110 0
15 | Student 12 77 11 120 0
16 | Student 13 ila] 121 130 0
17 | Student 14 a7 131 140 0
18 |Student 15 81 141 150 0 10 20 30 40 a0 B0 70 80 30 100
18 | Student 16 73 151 160 0
20 |Student 17 a3 161 170 0 MNote: The chart uses named formulas (Categories and Frequencies)
21 |Student 18 18 171 180 0 in its SERIES formula
22 |Student 19 58 181 190 0
23 |Student 20 70 191 200 0
24 | Student 21 a0 201 210 0
25 |Student 22 <ix] 211 220 0 hd
4 4 b b[\Sheet1 1] I Eli

Figure 7-11: The chart displays a histogram; the contents of cell E1 determine the number
of categories.

[oNTHE®] The workbook shown in Figure 7-11 also appears on the companion
‘l CD-ROM.

The chart uses two dynamic names in its SERIES formula. You can define the
name Categories with the following formula:

=0FFSET(Sheet1!$E$4,0,0,ROUNDUP(100/BinSize,0))
You can define the name Frequencies with this formula:
=0FFSET(Sheet1!$F$4,0,0,ROUNDUP(100/BinSize,0))

The net effect is that the chart adjusts automatically when you change the
BinSize cell.
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See Chapter 17 for more about creating a chart that uses dynamic names in
its SERIES formula.

Summing Formulas

The examples in this section demonstrate how to perform common summing tasks
using formulas. The formulas range from very simple to relatively complex array
formulas that compute sums using multiple criteria.

Summing All Cells in a Range

It doesn’t get much simpler than this. The following formula returns the sum of all
values in a range named Data:

=SUM(Data)

The SUM function can take up to 32 arguments. The following formula, for
example, returns the sum of the values in five noncontiguous ranges:

=SUM(A1:A9,C1:C9,E1:E9,G1:G9,I1:19)
You can use complete rows or columns as an argument for the SUM function.

The formula that follows, for example, returns the sum of all values in column A. If
this formula appears in a cell in column A, it generates a circular reference error.

=SUM(A:A)

The following formula returns the sum of all values on Sheet1. To avoid a circu-
lar reference error, this formula must appear on a sheet other than Sheet1.

=SUM(Sheet1!1:65536)

The SUM function is very versatile. The arguments can be numerical values,
cells, ranges, text representations of numbers (which are interpreted as values),
logical values, and even embedded functions. For example, consider the following

formula:

=SUM(B1,5,"6",,SQRT(4),A1:A5,TRUE)
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This formula, which is a perfectly valid formula, contains all of the following
types of arguments, listed here in the order of their presentation:

*
*
*
*
*
*
*

A single cell reference

A literal value

A string that looks like a value

A missing argument

An expression that uses another function
A range reference

A logical TRUE value

The SUM function is versatile, but it's also inconsistent when you use logical
values (TRUE or FALSE). Logical values stored in cells are always treated as 0.
But logical TRUE, when used as an argument in the SUM function, is treated

as 1.

Computing a Cumulative Sum

You may want to display a cumulative sum of values in a range —sometimes
known as a “running total.” Figure 7-12 illustrates a cumulative sum. Column B
shows the monthly amounts, and column C displays the cumulative (year-to-date)
totals.

A B c Lo
1 |Manth Arnount Yearto-Date —
| 2 |January 850 850
| 3 |February Q0o 1,760
| 4 |March 750 2500
[ 5 |April 1,100 3B00
| B |May 600 4,200
| 7 |June 500 4,700
[ 8 |July 1,200 5500
[ 9 |August 5500
| 10 |September 5,500
[ 11 |October 5,800 |
[ 12 |Movermber 5,500
13 |December 5,500
[ 14 |TOTAL 5900
15 £
Moy »i[\,Sheet1 ¢/ Sheetz /|4 ﬂj}‘

Figure 7-12: Simple formulas in column C display a
cumulative sum of the values in column B.
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The formula in cell C2 is:
=SUM(B$2:B2)

Notice that this formula uses a mixed reference. The first cell in the range refer-
ence always refers to row 2. When this formula is copied down the column, the
range argument adjusts such that the sum always starts with row 2 and ends with
the current row. For example, after copying this formula down column C, the for-
mula in cell C8 is:

=SUM(B$2:B8)

You can use an IF function to hide the cumulative sums for rows in which data
hasn’t been entered. The following formula, entered in cell C2 and copied down the
column, is:

=IF(B2<>"",SUM(B$2:B2),"")

Figure 7-13 shows this formula at work.

o m]
A B C =
1 |Manth Amount Yearto-Date [l
| 2 |[January 850 850
| 3 |February 9